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Why LapLink Gold?

LapLink Gold Corporate gives you the freedom to leave the office without giving up access to your 
office computer and network resources. Whether you’re traveling on business or working from home, you 
can still read your e-mail, share the latest files with coworkers, access network programs and databases, 
browse the Internet and collaborate with colleagues. Things you once could do only in the office you can 
now do remotely.

Suppose you work at home
Instead of joining the morning rush-hour traffic, you sit down 
at your home computer, connect to your office, and begin 
your workday as usual, by tackling your e-mail.
While finishing your orange juice, you read your messages, 
write new ones, send replies—in other words, you operate 
much as you would in the office. You’re using LapLink Gold. 
In particular, you’re using Remote Control, one of the 
LapLink Gold services, to operate your office computer from 
home.
On your home monitor you see what you would have seen 
had you commuted to work, and you operate your e-mail 
program as you would have from the office. You can even 
set up LapLink Gold to print to your home printer for those 
messages you’ll review later.
Forget to get the latest copy of a file before leaving the 
office? Use File Transfer, another LapLink Gold service, and 
drag the file from the folder on the office network to its loca-
tion on your hard drive at home. Since you’re updating a file 
already on your home computer, the file is transferred 
almost before you know it. (In fact, LapLink Gold merely 
updates the file, transferring only the parts that have 
changed.)
Use Remote Control to start a network application and 
access the company’s huge product database. Just as you 
thought, customers ordered more blue widgets last month 

than during the previous two months combined! More grist 
for the quarterly report you’re working on.
A final check of your e-mail confirms your suspicions. It’s off 
to Chicago tomorrow for a two-day business trip.

Suppose you’re on a business trip
Settling into your hotel room, you notice the card on the 
desk offering internet connectivity. That’s all you need to 
know; all you have to do now is use the hotel’s internet con-
nection to connect to the internet, then open a LapLink Gold 
connection to get access to your desktop, or to others. 
It’s been a busy day. You rush through your e-mail, finishing 
in time to connect to a coworker’s computer. Her e-mail 
sounded desperate: if you’re free before 7 o’clock this 
evening, could you help with the cover art for the annual 
report?
Now you’re looking at her monitor and talking to her at the 
same time, using another LapLink Gold service, Voice Chat. 
After some discussion, the two of you agree: make the logo 
larger and reverse the colors. She’ll have a finished draft 
waiting for you on the network in an hour. And then you can 
download it using LapLink Gold’s File Transfer service later.

Suppose you manage IT support
Imagine that your phone rings at 11:30 at night. Your CEO is 
calling, requesting that you help her get her laptop up and 
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 . . . Why LapLink Gold?

running. Now. With LapLink Gold, you can connect to her 
computer from your home or hotel internet connection, and 
using Remote Control, troubleshoot the problem yourself. 
LapLink Gold can also help spread the workload and share 
information. Let’s say the hotel’s internet connection is down 
when the CEO calls. Using the powerful new Address Book 
features, all the connection information can be stored cen-

trally. This allows you to share saved connections with your 
IT team, so that your team has all the connection informa-
tion that you have at their fingertips. Sharing the Address 
Book provides your team access, allowing them to trouble-
shoot first, and call you last. So you might actually get some 
sleep.
7



Staying in touch with the office

Whether you’re in a hotel on the road, at home on a Saturday, or with you laptop practically anywhere, 
LapLink Gold Corporate lets you use whatever connection you have to get access to everything you 
need. LapLink Gold Corporate supports connecting via modem, a network, a network server, the Internet 
and more. You determine how to connect by considering your office setup and what you want to 
accomplish when you are connected, and LapLink Gold helps you to get it done.

Connecting to the office requires that your home computer 
be able to connect to other computers, and LapLink Gold 
supports a variety of connection methods. It must also be 
running LapLink.
Depending on the type of office netwrok and its firewall pro-
tection, you can then make any or all of these kinds of con-
nections:
• To your office computer directly via modem.
• To your office computer through the office network 

VPN, via the internet. 
• To your office computer through the Internet.

Connecting directly to your office computer
If your home computer is equipped with a modem or other 
internet connection, you can connect to the office computer 
directly.
Leave LapLink Gold running when you leave the office, and 
make sure you are connected , either by modem or other 
method. Then connect from home, and run programs and 
transfer files as you would normally.
If your office computer is attached to a network, you can 
read your e-mail and access the customary network 
resources, though you cannot connect to other computers 
on the network.

Connecting to the office network
If your office has a network, you can connect to the network 
via a VPN or other methods, and then to any computer run-
ning LapLink Gold on the network, including your own. 
Using the Remote Control service, you can access any net-
work resources normally available to you from the office.
To connect to the office network, simply dial in to a dedi-
cated network dial-up server using Dial-up Networking, use 
VPN or other connection methods. 

Connecting over the Internet
You can also use LapLink Gold to connect to another 
LapLink Gold computer using a LapLink Everywhere con-
nection. LapLink Everywhere is a subscription service, 
allowing you to connect in many ways. But your LapLink 
Everywhere account also serves as a connnection service 
between LapLink Gold computers. This type of connection 
gives you the full range of LapLink Gold features from any 
internet connection. To learn more about about LapLink 
Everywhere, go to See “Connecting Over the Internet Using 
Laplink Everywhere” on page 31.
Most workstations now have direct Internet access over 
dedicated, high-speed connections. If your office computer 
is one of these—and you have Internet access from your 
home computer or your laptop—you can connect to the 
office using Connect over Internet. If this connection 
8



 . . . Staying in touch with the office

requires you connect through a firewall, see ”Making an 
Internet connection to a computer behind a firewall” for more 
information. 
Before connecting over the Internet, set up your office com-
puter for Internet access by publishing its address through 
the LapLink ILS server. Then be sure to leave LapLink Gold 
running.

Connecting without running LapLink Gold
There may be times when you need to connect to your 
office computer running LapLink Gold from another com-
puter that doesn’t have LapLink Gold installed. You can 
transfer files between these two computers using Laplink 
Everywhere.

To learn more about the capabilities of this option, go to 
”Connecting Over the Internet Using Laplink Everywhere.
9



Connecting at the office

With greater resources at hand, you can make faster connections—and connect in more ways—while 
working in the office. Connect over a corporate network, for example, for the fastest file transfers. Use a 
LapLink Gold cable to synchronize your desktop and laptop before and after you travel. And take 
advantage of your organization’s direct connection to the Internet for cheap connections to distant 
locations.

Connect to other computers on your network
If your office is equipped with a local network (LAN), you 
can connect directly to any other computer on the network 
running LapLink Gold, using Connect Over LAN (Network). 
Because LapLink Gold connections over networks are fast, 
they are ideal for sending large amounts of data in a short 
time.
Suppose it’s your job to distribute files to several computers 
every Tuesday. To automate the operation, create an 
Xchange Agent file by showing LapLink Gold which files to 
copy and where to copy them. When Tuesday arrives, run 
the Xchange Agent yourself or schedule it to run unat-
tended, at a time when the computers are usually idle. 
LapLink Gold automatically connects to the computers, 
transfers files to the designated folders, and disconnects, all 
without assistance.
It may also be your job to maintain those computers. With-
out leaving your desk, you can use Remote Control to trou-
bleshoot problems on other computers, chatting with their 
users, if necessary.

NOTE A LapLink Gold license, either a single-user license 
or a special volume license, must be purchased by each 
person using LaLink in order to use LapLink Gold soft-
ware. Visit www.laplink.com to learn more about licensing 
rules and opportunities.

Connect your laptop to your desktop
If you take your laptop—and your work—with you when you 
leave the office, you know the routine: update files on your 
laptop before you leave; update files on your desktop when 
you return.
To update files on either computer, attach a LapLink Gold 
cable and run LapLink Gold on both computers. A connec-
tion opens automatically.
Instead of manually moving files and folders from one com-
puter to another, you can create an Xchange Agent to syn-
chronize your files and folders, so that both computers have 
the latest versions of each file. You can even set the Agent 
to synchronize automatically.

Connect to computers over the Internet
Does your office have a direct line to the Internet? By com-
bining LapLink Gold and the Internet, you can connect to 
computers anywhere in the world.
Use LapLink Gold from the office or the road to connect to 
other computers. You can connect from your desktop, lap-
top, even from an internet cafe on the road, using the capa-
bilities of your LapLink Everywhere account. To learn more 
about the capabilities of LapLink Everywhere, go to ”Con-
necting Over the Internet Using Laplink Everywhere.
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 . . . Connecting at the office

If your office has a persistent connection to the internet, use 
the ‘Connect Over ILS’ option, and simply supply the pub-
lished name or address of the host computer
Before you use Connect over Internet, other LapLink Gold 
users will set up LapLink Gold as a host on their computers 

so that their e-mail addresses, or other unique identifiers, 
are “published” through an Internet directory . They then 
must notify you of their new addresses in order to allow you 
to connect.
11
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How can I connect to other computers?

Determine how to connect to another computer from the resources available to the two computers. For 
example, are both logged on to the same office network? Then connect over the network. Do both have 
Internet access? Then connect over the Internet. Use the tables in this section to help decide how to 
connect. No matter how you connect, you can always use File Transfer, Remote Control, and other 
LapLink services.

Connecting to the Officet

LapLink provides sev-
eral ways to connect to 
other computers.
Which method you use 
depends on the 
resources available to 
the computers.

Can you connect to the Internet on 
the local computer?

Then connect to another LapLink Gold Corporate Host computer over 
the Internet this way:

For details 
see

Yes, and there is no router or firewall at 
the host end.

Connect to the Internet as usual and then use Connect over ILS in 
LapLink. page 26

No, but the office has a Windows 
Remote Access server (RAS).

Use Connect over Dial-Up Networking to dial in to a network server and 
connect over the office network connection.

page 37
14



 . . . How can I connect to other computers?
Connecting over modems, networks, cables, or wireless devices

Yes, but the host is protected by a fire-
wall or router.

Use Connect Over LapLink Everywhere, or use the firewall service (see 
page 28) . For more information on what ports are used by LapLink, go to 
www.laplink.com/support.

page 31

No, but the office does use a VPN 
server for access to resources from the 
Internet.

Establish a VPN connection to the office, then use Connect Over LAN 
(Network) to supply the IP Address of the host computer. page 20

What resources are
available for connections Then connect to another LapLink computer this way: For details 

seeon the local 
computer?

on the remote 
computer?

modem modem
Use Connect over Modem and dial in to the modem on the remote computer.
Modem connections are available in all versions of Windows.

page 34

TCP/IP or IPX 
network

TCP/IP or IPX 
network

Use Connect overLAN (Network).
Network connections are available in all versions of Windows.

page 20

USB, parallel or 
serial port

USB, parallel or 
serial port

Attach a LapLink parallel or serial cable to each computer. The connection opens 
automatically. To connect manually, choose Connect Over Cable.
Serial connections are available in all versions of Windows. 
Parallel connections are available in Windows 95/98 and Windows Me.
USB connections are available in Windows 98, ME,2000, XP and 2003.

page 16

wireless device wireless device
The connection opens automatically as soon as the devices come within range 
of each other.
Wireless connections are available in Windows 95/98 and Windows Me.

page 38
15



Connecting by cable

When you connect two computers by LapLink cable, attach the cable—serial, parallel, or USB - to 
both computers and start LapLink on both computers. No separate cable driver installation is required. 
Autoconnect, the default setting for cable connections, opens a connection automatically. To manually 
connect, click the Connect Over button on the LinkBar, and then click Cable. 

Attach one end of 
the yellow LapLink 
parallel cable to a 
parallel port on 
each computer. 
Only available for 
WIn95/98/ME

The blue LapLink serial cable 
has two connectors at one 
end, but only one connector is 
attached at a time: Use the 
larger connector if one of the 
computers has an older 25-pin 
serial port. Otherwise, attach 
one of the smaller connectors 
to each computer.

Attach one end of 
the gold LapLink 
USB cable to a 
USB port on each 

NOTE USB-to-serial 
adapter or gender-
changing devices of 
any kind are not sup-
ported for use with 
LapLink Gold Corpo-
rate!
16



 . . . Connecting by cable

Choose the type of cable—serial, parallel, or USB (Univer-
sal Serial Bus)1 —you are going to use based on the cables 
and ports you have available.
Ports are the connectors to which you attach cables and 
peripherals like printers and external modems. To find out 
which types of ports are available, consult the documenta-
tion or the Windows Device Manager for your computer.
Once you decide which kind of cable connection you’ll use, 
plug a LapLink cable into both computers: attach a LapLink 
serial cable to a serial port on each computer, a LapLink 
parallel cable to a parallel port on each computer, or a 
LapLink USB cable to a USB port on each computer.

Before you connect by cable
• Attach an end of a LapLink cable to each computer.
NOTE When attaching the gold cable that comes with 
LapLink Gold Corporate for the first time, Windows will 
detect the device and install the drivers automatically. Sim-
ply click Next and Finish at the Found New Hardware wiz-
ard to complete driver installation and hardware setup.
• Ensure that the proper port—serial, parallel, or USB—is 

enabled in LapLink on both computers. See ”Checklist 
for cable connections.

• Run LapLink on both computers.

Cables to use for LapLink connections
Use LapLink Gold Corporate’s gold USB cable to connect 
as your first option.

If you don’t have a USB port available, you can also use a 
serial or parallel port. You can obtain cables for these con-
nection types from Laplink. 
If there is more than one type of port available to you, 
remember that USB cables, the fastest of the three, transfer 
up to seven times faster than serial cables. Parallel cables 
transfer data faster than serial cables. 

Connecting to another computer by serial or parallel 
cable
When you start LapLink on two computers connected by 
cable, they will automatically connect. Autoconnect, the 
default setting for cable connections, causes the computers 
to connect automatically. If you change this setting, you can 
connect to the other computer manually.
TIP If the connection does not open automatically, click 
Port Setup on the Options menu and verify that the appro-
priate port (COM, LPT, or USB) is enabled for cable.
To manually connect to another computer by serial or 
parallel cable:
1 Click the Connect Over button on the LinkBar, and then 

click Cable.
2 In the Connection list, click the name of the computer you 

want to connect to.
3 Under Services, check the services you want to use, such 

as File Transfer and Remote Control.
4 Click OK. 
TIP To turn Autoconnect off, click on the Options menu 
and select Connect. On the Connect tab, clear the Enable 
Autoconnect box.

1 Not all connection types are supported in all Windows 
operating systems. See the table on page 15 for more 
information.
17



Using an Address Book entry to connect using Cable 
It’s a good idea to create an Address Book entry, especially 
if you plan to use the connection more than once. LapLink 
Gold allows you to connect directly from the Address Book, 
which makes it even easier. 
To create an entry in the Address Book for a cable con-
nection:
1 Click the Address Book button on the LinkBar, then click 

the Add button.
2 In the Description box, type a brief description of the remote 

computer as a reference.
3 In the Computer Name box, type the exact name assigned 

to the remote computer in LapLink. Remember this field is 
case-sensitive.

4 Click the Connection tab. In the Connection Type list, click 
Cable.

5 Click the Services tab. Choose the services you want to 
enable when you connect to this computer.

6 Click OK to save this Address Book entry. 
Click the Connect button to connect to this computer directly 
from the Address Book.

Connecting by Cable when multiple cable ports are 
enabled
If your computer has multiple cable ports enabled, LapLink 
Gold offers you the option of connecting through the cable 
connection type you choose. 
If you have multiple cable ports enabled, you will see the 
screen below, which will allow you to choose the cable con-
nection.

Simply choose the cable port you want to connect through, 
and click OK. Remember that USB cable speeds are signif-
icantly faster than serial or parallel cables. 
18



Connecting over a home or office network

Connect to any other computer running LapLink on your office network (LAN) and use Remote Control, 
File Transfer, or any other LapLink service. Use Connect over LAN (Network) and click the name of the 
computer you want to connect to or supply its TCP/IP address.

You can establish a LapLink connection to another com-
puter on your home or office network, whether it is an IPX 
(Novell NetWare) network or a TCP/IP network.
NOTE To simplify routine connections over a network, cre-
ate Address Book entries. See ”Adding an Address Book 
Entry- General Tab”.

You can usually open a network connection simply by click-
ing the computer’s name in a list of LapLink computers on 
the network. To open a connection to a computer that lies 
outside your portion (subnet) on a TCP/IP network, how-
ever, you must provide the computer’s TCP/IP address. 

Use Connect over LAN 
(Network) to link computers 
on a home or office net-
work.
You can click the name of a 
computer or switch to the  
TCP/IP Addresses tab and 
type the computer’s IP 
address if necessary.
20



 . . . Connecting over a home or office network
Before you use Connect over LAN (Network)
• The security setup of the host computer must be config-

ured to allow incoming connections. See ”Allowing 
incoming connections.

• The network ports (either TCP/IP or IPX) must be 
enabled in LapLink on both computers. See ”Checklist 
for Internet connections. If you aren’t sure which protocol 
is being used on your LAN, contact your network 
administrator.

• LapLink must be running on both computers.
NOTE Not only does Connect over LAN (Network) Con-
nect Over LAN (Network)work over local networks, it also 
connects over the Internet. For details see ”Checklist for 
Internet connections.
To connect to another computer by network:
1 Click the Connect Over button on the LinkBar, and then 

click LAN (Network).
2 In the Connect Over LAN (Network) dialog box, click the 

name of the computer you want to connect to.
If the computer is not listed and you are attempting to 
connect over a TCP/IP network, click the TCP/IP 
Addresses tab. Then do either of the following:
• In the Connections list, click the name of the com-

puter you want to connect to. The names listed are 
from the Address Book.

• Under TCP/IP Name or Address, type the IP address 
of the host computer.

3 Under Services, check the services you want to use, such 
as File Transfer and Remote Control.

4 Click OK.

Using an Address Book entry to connect over a home 
or office network
It’s a good idea to create an Address Book entry, especially 
if you plan to use the connection more than once. LapLink 
Gold allows you to connect directly from the Address Book, 
which makes it even easier. 
To create an entry in the Address Book for connecting 
to a home or office network
1 Click the Address Book button on the LinkBar, then click 

the Add button.
2 In the Description box, type a brief description of the remote 

computer as a reference.
3 In the Computer Name box, type the exact name assigned 

to the remote computer in LapLink. Remember this field is 
case-sensitive.

4 Click the Connection tab. Click the down arrow by the Con-
nection Type list. When connecting over LAN (Network), 
you have two different options for connecting.
Network:Available Now- This connection type lets 
LapLink Gold establish the connection
OR
Network:TCP/IP Address: This connection type requires 
you to enter the IP Address of the host machine in order 
to connect. 

5 Click the Services tab. Choose the services you want to 
enable when you connect to this computer.

6 Click OK to save this Address Book entry. 
Click the Connect button to connect to this computer directly 
from the Address Book.
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Finding a TCP/IP address of the host computer
To find out a computer’s TCP/IP address in Windows 95 
or Windows 98, or Windows ME:
1 On the Options menu, click Port Setup.
2 Click TCP/IP Network in the Ports list, and then click the 

Configure button.
3 The TCP/IP address appears in the IP Address box.
To find out a computer’s TCP/IP address in Windows 
NT, 2000, XP or 2003:
1 Click the Windows Start button, point to Programs, 

Accessories, and click Command Prompt.

2 Type IPCONFIG and press ENTER.
The TCP/IP address for that computer appears in the IP 
Address line.

Filtering the list of available network computers
You can display the name of a particular computer in the 
Connect Over LAN (Network) dialog box by typing all or part 
of the name in the Computer Name Filter box; then click 
Refresh List.
To display the names of all available computers again, click 
the arrow next to the Computer Name Filter box, click All 
Computers, and then click Refresh List.
22



 . . . Connecting over the Internet using an ILS
Connecting over the Internet using an ILS

Connect to the Internet using an ILS (Internet locator service) directory server, and you can open 
connections to other LapLink computers anywhere in the world. To make a computer easy to find on the 
Internet, LapLink Gold Corporate can"publish" the computer's Internet address to the ILS server.. Other 
computers can then supply this address to open connections using Connect over ILS from the Connect 
menu, above the Link Bar.

When you connect to another LapLink computer on the 
Internet, you can use Remote Control, File Transfer, and 
any of the other LapLink services you would use when con-
nected directly. 

You can also publish your computer's address through an 
ILS (Internet locator service) like the one hosted by LapLink 
Software and then connect using Connect over ILS. Simply 
supply the Internet address published through the ILS.

Go online and use Con-
nect over ILS to locate and 
open connections to 
LapLink computers any-
where on the Internet.
Make a connection by sup-
plying the address pub-
lished by a remote 
computer to the LapLink 
ILS server.
23



Before you use Connect over ILS
• Both computers must be actively connected to the 

Internet.
• The host (remote) computer must have its Internet 

address published through an ILS (Internet Locator 
Service). See ”Making a computer available for ILS con-
nections of this chapter.

• The security setup of the remote computer must have 
been configured to allow incoming connections. See 
”Protecting your security settings with a password.

• The TCP/IP ports must be enabled in LapLink on both 
computers. See ”Checklist for Internet connections.

• LapLink must be running on both computers.
• For more information on connecting behind a firewall or 

router, go to ”Making an Internet connection to a computer 
behind a firewall”.

Using Connect over ILS
To connect to another LapLink computer using ILS:
1 Connect to the Internet as usual.
2 Click the Connect menu above the LinkBar, and then click 

Connect Over ILS.
3 If you have created an Address Book entry for the connec-

tion you want to open, click the Address Book entry, and 
click Connect.
Otherwise, click Manual Connect. In the Internet Address 
box type the remote computer’s Internet address (the 
one the remote computer has published to the ILS 
Server).

4 Under Services, check the services you want to use.
5 Click OK.

Using an Address Book entry to connect over ILS
It’s a good idea to create an Address Book entry, especially 
if you plan to use the connection more than once. LapLink 
Gold allows you to connect directly from the Address Book, 
which makes it even easier. 
To create an entry in the Address Book for Connecting 
over ILS.
1 Click the Address Book button on the LinkBar, then click 

the Add button.
2 In the Description box, type a brief description of the remote 

computer as a reference.
3 In the Computer Name box, type the exact name assigned 

to the remote computer in LapLink. Remember this field is 
case-sensitive.

4 Click the Connection tab. In the Connection Type list, 
choose Internet Address.

5 Enter the address the host machine has published to the 
ILS server. 

6 Click the Services tab. Choose the services you want to 
enable when you connect to this computer.

7 Click OK to save this Address Book entry. 
Click the Connect button to connect to this computer directly 
from the Address Book.

Opening Internet connections using Connect Over 
LAN (Network)
The ILS server is not required for internet connections when 
using LapLink Gold Corporate; it merely facilitates these 
connections. Just as you use Connect Over LAN (Network) 
for connections on a local TCP/IP network, so you can use it 
for connections on the Internet, which is simply a global web 
of TCP/IP networks.
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 . . . Connecting over the Internet using an ILS

When you use Connect Over LAN (Network), you must 
supply the computer’s public, routable IP address, not an 
address published through an Internet directory.

Connect Over LAN (Network) is most useful when you con-
nect to computers whose IP addresses never change. For 
more information about using Connect Over LAN (Net-
work), see ”Connecting over a home or office network.
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Making a computer available for ILS connections

Internet connections are more easily established by the use of easy-to-remember names or addresses. 
To make your computer available to other LapLink computers on the Internet, publish its address through 
an ILS (Internet Locator Service) directory server. LapLink users who know this address can then locate 
your computer on the Internet and open connections from anywhere in the world. LapLink maintains the 
LapLink ILS server as a free service to our users..

Connecting to computers on the Internet is easy—when 
you know their IP addresses. But IP addresses can be hard 
to determine, and they often change. If you dial in to an 
Internet service provider, for example, your computer may 
be assigned a different IP address each time you go online. 
So how do you make your computer available to other 
LapLink computers on the Internet? You have your e-mail 

address (or other unique identifier) “published” as your Inter-
net address. You then let other LapLink users connect to 
your computer by telling them your Internet address. 
NOTEIf the computer is behind a firewall, there are addi-
tional requirements. See”Making an Internet connection to a 
computer behind a firewall, or use LapLink Everywhere. See 
”Connecting Over the Internet Using Laplink Everywhere

To allow other LapLink computers to 
connect to a computer on the Inter-
net, set up LapLink to have the com-
puter’s address published through the 
LapLink ILS.
In Internet Directory Options, specify 
an e-mail address or some other 
unique identifier as the Internet 
address.
Then notify other LapLink users so 
that they can connect by supplying 
the Internet address you have speci-
fied.
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 . . . Making a computer available for ILS connections

Specify the address to be published and when it will be pub-
lished—for example, whenever you are using LapLink on 
the Internet.
Use the LapLink Internet directory to publish your address; 
the directory is available without cost to LapLink users, and 
you don’t have to sign up to use it.
Publishing your Internet address does not open your com-
puter to unwanted connections. LapLink users who know 
your published address can connect; others cannot, even if 
they are using NetMeeting or other programs that rely on 
Internet directories.
NOTE Only the host computer requires publishing; the 
guest computer does not.
To set up LapLink to have your computer’s address 
published on the Internet:
1 On the Options menu, click Internet Directory Options.
2 In the Internet Address box, type your e-mail address or 

another unique identifier.
This will be your Internet address. Give it (as well as log-
in name and password) to any LapLink user you allow to 
connect to your computer on the Internet.

3 Set options to determine how to publish your Internet 
address:

• To publish the address yourself, without a confirma-
tion dialog box, clear this box: When Manually Pub-
lishing My Address, Show Confirmation.

• To have LapLink publish your address for you, check 
this box: Automatically Publish My Address When 
I’m Connected.

4 Set the Internet directory to publish your computer’s 
address like this: Use a LapLink Directory Server: 
ils.laplink.com

5 Click OK.
TIP In addition to publishing a computer’s Internet 
address, you must also change its security setup before 
other computers can connect over the Internet. For more 
information, see ”Protecting your security settings with a 
password.

Publishing your Internet address
You can set up LapLink to publish your address automati-
cally whenever you run LapLink on the Internet (step 3, 
above). Or you can publish it yourself.
To publish your Internet address yourself:
1 Connect to the Internet as usual.
2 On the Connect menu, click Publish My Internet Address.
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Making an Internet connection to a computer behind a firewall

In most cases, a firewall or router will block inbound connections from the internet, including LapLink 
connections1. Since configuration of the firewall is not easy, or even permitted by the network, LapLink 
Gold offers a built-in solution: You can use LapLink Gold Corporate’s Firewall Connection Service to 
make the connection.

1 For more information on the ports that LapLink uses, and for up-to-date instructions on configuring firewalls, visit www.laplink.com/
support.

When the guest computer (outside the firewall) 
requests a connection, the host computer (inside the 
firewall) uses the Address Book entry to initiate the 
connection.

The Log-in name and password in the Log-in List 
entry must match the log-in name and password in 
the Address Book entry.
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 . . . Making an Internet connection to a computer behind a firewall
You must configure both computers before you can make a 
firewall connection. First, configure the host computer 
(inside the firewall) to accept incoming connections using 
either a Log-in List or configuring a Public System (Log-in 
List is more secure) and then create an Address Book entry.
You must also create a Log-in list entry on the computer out-
side the firewall. This entry must match the Address Book 
entry you created on the computer inside the firewall.

NOTE A detailed tutorial is available by clicking on the 
Help menu, and choosing “Tutorials on the Web.”

Before you connect to a computer behind a firewall:
• Both computers must be connected to the Internet.
• Only one of the two computers can be behind a firewall.
• The computer inside the firewall must publish its Inter-

net address through the LapLink Internet directory 
server. See ”Making an Internet connection to a computer 
behind a firewall.

• The computer inside the firewall must have an Address 
Book entry that includes the unique computer name, 
user name, and password for the computer outside the 
firewall to use.

• The computer outside the firewall must be configured to 
allow incoming connections. See ”Making an Internet 
connection to a computer behind a firewall.

• The TCP/IP ports must be enabled in LapLink on both 
computers. See ”Checklist for Internet connections.

• LapLink must be running on both computers.
Connecting to a computer behind a firewall:
1 Connect to the Internet as usual.
2 Click the Connect menu above the LinkBar, and then click 

Connect Over ILS.
3 If you have created an Address Book entry for the connec-

tion you want to open, click the connection in the Connec-
tions list.
Otherwise, click Manual Connect. Type the Internet 
address, log-in name, and password for the computer 
behind the firewall.

NOTE You can get this information from the owner of the 
computer behind the firewall.

To enable a firewall connection, choose the Connection tab 
in the Address Book Entry, and under Connection Type, 
choose Firewall.

NOTE When the Connection Type is Firewall, no ser-
vices need to be selected, and are greyed out on the 
Services tab.
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4 Under Services, check the services you want to use. 5 Click OK.
30



 . . . Connecting Over the Internet Using Laplink Everywhere
Connecting Over the Internet Using Laplink Everywhere

LapLink Everywhere offers the easiest and most flexible 
Internet connections. They are the easiest because they 
maintain security without the need to wrestle with firewalls. 
They are the most flexible because you can connect not just 

in the traditional LapLink-to-Laplink way but from any device 
with which you can browse the Internet, including cell 
phones, PDAs, and public access computers like those 
found in libraries and Internet cafés..

LapLink Everywhere and LapLink Gold are two programs 
that have been designed to work separately or together. 
Unlike LapLink Gold, LapLink Everywhere needs to be 
installed only on the host computer-the home or office 

computer you want to connect to. It does not have to bein-
stalled on the guest computer. 
LapLink Everywhere is an optional subscription service. For 
more information on LapLink Everywhere features and pric-
ing, visit www.laplink.com.

You can use LapLink Everywhere connections for traditional 
LapLink-to-LapLink connections.

Or you can connect from any Internet browser, without using 
LapLink at all..
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Once the LapLink Everywhere program is installed on the 
host computer, you can connect to it in two ways:
You can use LapLink Everywhere connections for tradi-
tional LapLink-to-LapLink connections.

•• Open a LapLink connection from a guest computer 
running LapLink Gold. LapLink Gold must be running 
on both computers, but LapLink Everywhere needs to 
be installed and running only on the host.

Or you can connect from any Internet browser, without 
using LapLink at all.

•• Open a LapLink Everywhere connection from a web 
browser, anywhere there is a connection to the internet. 
Simply leave LapLink Everywhere running on the host 
computer. You do not have to run LapLink at all on the 
guest computer.

For maximum flexibility, leave both LapLink Gold and 
LapLink Everywhere running on the host computer. You can 
then connect from another computer running LapLink Gold 
and from any device that allows you to browse the Internet.

Only LapLink-to-LapLink connections offer the complete 
range of LapLink features. When you use an Internet 
browser, you can read e-mail, transfer files, and perform 
remote control, but advanced features like automatic syn-
chronization are not available.

Preparing to use LapLink Everywhere
As part of the installation of LapLink Gold you are asked 
whether you want to begin your free trial of the LapLink 
Everywhere service by setting up your LapLink Everywhere 
account and installing LapLink Everywhere. Simply create a 
unique user name and password. If you install LapLink 
Everywhere on more than one computer, be sure to use the 
same user name and password for each one.

If you originally chose not to “Learn more about LapLink 
Everywhere” after the installation of LapLink Gold Corpo-
rate, you may still do so at any time by visiting 
www.laplink.com, and there begin your free trial. 
As with other kinds of connections, you must configure the 
security setup of the host computer to allow incoming con-
nections. See Setting up security for incoming connections .
If you intend to connect to the host computer from an Inter-
net browser for remote control, you must also install LapLink 
Secure VNC on the host computer. 
NOTE LapLink Secure VNC is an additional service to 
LapLink Everywhere, with an additional subscription fee. 

Connecting from another LapLink computer over 
LapLink Everywhere
To connect over LapLink Everywhere to another com-
puter running LapLink Gold:
1 Click the Connect Over button on the Linkbar and then 

click Connect over LapLink Everywhere (Internet)
2 Type the user name and password set up for your LapLink 

Everywhere account.
3 All LapLink Everywhere hosts associated with that account 

will appear in a list, showing their current availability. 
4 Choose the correct host computer, and click OK..
5 Depending on the security settings on the host, you may be 

asked for the LapLink Gold username and password. Sup-
ply whatever is required by the LapLink Gold security setup 
on the host computer. See ”Allowing incoming connections.

Connecting from any Internet browser
You can connect to the host computer from almost any 
device equipped to browse the Internet-from another PC or 
a Mac to a PDA or an Internet telephone. The chief require-
ment is that the device must be set up to allow cookies.
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 . . . Connecting Over the Internet Using Laplink Everywhere

To connect to LapLink Everywhere from an Internet-
browser:
1 Log on to www.MyLapLink.com. 
2 Type the user name and password set up for your LapLink 

Everywhere account. 
3 Click the Login button. 
4 LapLink Everywhere features are not the same oas those 

offered by LapLink Gold Corporate. For more information, 
visit www.laplink.com.

NOTE Some features require JAVA and Active X controls. 
Not all web-enabled devices support this technology. 

Using an Address Book entry to connect over 
LapLink Everywhere.
It’s a good idea to create an Address Book entry, especially 
if you plan to use the connection more than once. LapLink 
Gold allows you to connect directly from the Address Book, 
which makes it even easier. 
To create an entry in the Address Book for Connecting 
Using LapLink Everywhere.
1 Click the Address Book button on the LinkBar, then click 

the Add button.
2 In the Description box, type a brief description of the remote 

computer as a reference.
3 In the Computer Name box, type the exact name assigned 

to the remote computer in LapLink. Remember this field is 
case-sensitive.

4 Click the Connection tab. In the Connection Type list, 
choose LapLink Everywhere.

5 Enter your LapLink Everywhere User Name, Password, 
and Computer Name in the appropriate fields. Note that the 
computer name is case-sensitive.I 

Click the Services tab. Choose the services you want to 
enable when you connect to this computer.
6 Click OK to save this Address Book entry. 
Click the Connect button to connect to this computer directly 
from the Address Book

To get your LapLink 
Everywhere Com-
puter Name, go to 
www.mylaplink.com, 
and login in using 
your LapLink Every-
where User Name 
and Password. 

The PC Name listed 
should be entered in 
the Computer Name 
field on the Connec-
tion tab, and should 
match this name 
exactly. Please note 
that this field is case-
sensitive!
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Connecting directly by modem

Using modems and a phone line, you can connect to another computer or to an office network. For a 
direct, LapLink to LapLink connection, dial to a modem on another computer using Connect over Modem. 

When you dial directly to another LapLink computer, and 
open a remote control session, you have access to all the 
programs and files available to that computer (including any 
network resources if the computer is logged on to a net-
work).

Before Connecting over a modem
• The LapLink security setup of the computer you are 

connecting to must be changed to allow incoming con-
nections. See”Allowing incoming connections .

Use Connect over Modem 
to dial a modem on 
another computer and 
open a LapLink connection 
to that computer.
Entries you have created 
for modem connections in 
the Address Book appear 
in the connection list to 
make connecting easier.

TIP For Best Results: Use only hard-
ware-based modems, such as external 
(serial) modems. Most internal modems 
are unreliable for LapLink connections. For 
the latest information, visit 
www.laplink.com/support.
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 . . . Connecting directly by modem

• LapLink must be running on both computers.
• Modem ports must be enabled in LapLink on both com-

puters.
To connect to another computer by modem:
1 Click the Connect button on the LinkBar, and then click 

Modem.
2 In the Connections list, click the connection you want to 

open.
The connections listed under Manual Dial are your 
Address Book entries for modem connections. To create 
a new entry, click Address Book.

3 In the Dialing Location list, click the location you’re dialing 
from.

4 Under Services, check services you want to use.
5 Click the Dial button.

Dialing manually
You can type the phone number without creating an 
Address Book entry beforehand. LapLink dials the number 
exactly as you type it, regardless of how you have set up 
Dialing Properties in other address book entries.
To dial manually:
1 Click the Connect button on the LinkBar, and then click 

Modem.
2 Click Manual Dial.
3 In the Telephone Number box, type the number EXACTLY 

as it is to be dialed, including numbers dialed to get an out-
side line, area codes, country codes, and a “1” when dialing 
long distance. 

4 Click the Dial button.

Using an Address Book entry to connect over modem
It’s a good idea to create an Address Book entry, especially 
if you plan to use the connection more than once. LapLink 
Gold allows you to connect directly from the Address Book, 
which makes it even easier. 
To create an entry in the Address Book for Connecting 
over a modem.
1 Click the Address Book button on the LinkBar, then click 

the Add button.
2 In the Description box, type a brief description of the remote 

computer as a reference.
3 In the Computer Name box, type the exact name assigned 

to the remote computer in LapLink. Remember this field is 
case-sensitive.

4 Click the Connection tab. In the Connection Type list, 
choose Modem.

5 In the Phone Number box, type the number to dial, using 
any standard modem dial string (e.g.: a comma is treated as 
a pause). 

6 If you need to use area codes or country codes, make sure 
to check the Use country code and area code checkbox.

7 Click the Services tab. Choose the services you want to 
enable when you connect to this computer.

8 Click OK to save this Address Book entry. 
NOTE Click the Connect button to connect to this com-
puter directly from the Address Book.
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Dialing in to a network through a network server: Dial-Up Networking

Use Dial-Up Networking to dial in to a dial-up server (RAS) and log on to a network from outside the 
office. Then connect to other LapLink computers on the network and use network resources as if you 
were still in the office.

Use Dial-Up Networking to access a network remotely. By 
dialing in to a dial-up server (RAS) on the network, you can 
connect to any computer running LapLink on that network.
You can also connect to LapLink computers on the Internet 
and browse the Internet using the Internet connection in the 
office. In short, you can access the same network resources 
you use in the office.

Before you use Dial-Up Networking
• Dial-Up Networking, a Windows feature, must be 

installed on the the guest computer. See Windows help 
for instructions.

• Your network must have a dedicated dial-up server 
(such as Novell NetWare Connect, Windows Remote 
Access Server, or Shiva NetModem). The computer 

Use Dial-Up Networking to 
dial in to a dial-up server 
and connect to a network. 
Then open connections to 
other LapLink computers 
on the network.
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 . . . Dialing in to a network through a network server: Dial-Up Networking

you connect to must be connected to an IPX or TCP/IP 
network. 

• The LapLink Gold security setup on the host computer 
must be configured to allow incoming connections. For 
more information, See “Allowing incoming connections” on 
page 64. 

• LapLink must be running on both computers.
• TCP/IP or IPX ports must be enabled.

Setting up a Dial-Up Networking connection
Before using Dial-Up Networking, create a Dial-Up Net-
working connection to the network server by supplying the 
number to dial.
To create a Dial-Up Networking connection:
1 Click the Connect Over button on the LinkBar and then 

click Dial-Up Networking.
2 Click the New Connection button and follow the instructions 

on your screen. This launches Windows “Make A New Con-
nection wizard. Alternatively, LapLink Gold Corporate can 
use any existing dial-up connection available to Windows.

Connecting to a network computer using Dial-Up 
Networking

To use Dial-Up Networking to connect to a network 
computer:
1 Click the Connect Over button on the LinkBar and then 

click Dial-Up Networking.
2 In the list of connections, click the connection to your RAS 

server.
3 Ensure that this box is checked: After Dialing, Connect to a 

Computer on a Network.
4 Click the Dial button.
5 When prompted, type the user name and password 

required by the dial-up server. If your user name or pass-
word fail, contact your network administrator for assistance 
with logging on to the RAS server.

6 In the Connect Over LAN (Network) dialog box, click the 
name of the computer you want to connect to.
If the computer is not listed and you are attempting to 
connect over a TCP/IP network, click the TCP/IP 
Addresses tab. Then do either of the following:

•In the Connections list, click the name of the computer 
you want to connect to.

•Under TCP/IP Name or Address, type the IP address of 
the computer.

7 Under Services, verify that the services you want to use are 
checked.

8 Click OK.
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Connecting by wireless

To connect to another computer using wireless devices, simply start LapLink, and the connection opens 
automatically..

Using LapLink, you can open short-range connections 
between computers equipped with infrared (IrDA) ports.1

You can also connect using other wireless devices: With a 
cellular modem, use Connect over Modem. With a wireless 
LAN adapter, use Connect Over LAN (Network).

Before you connect by wireless
• Prepare your infrared or other wireless devices to com-

municate with each other. (e.g.:move within range).
• Ensure that the wireless port on each computer is 

enabled in LapLink. See ”Checklist for wireless connec-
tions.

• Run LapLink on both computers.

Connect over Wireless 
works automatically, 
connecting two 
Win95,98 or WinME 
computers when their 
infrared or other wire-
less devices are within 
range of each other.

1 Wireless connections are not available in Windows NT or 
Windows 2000, XP or 2003.
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 . . . Connecting by wireless
Connecting to another computer by wireless
When you start LapLink on both computers, a connection 
opens automatically over their wireless devices. Autocon-
nect, the default setting for wireless connections, forces the 
computers to connect to each other. If you change this set-
ting, you can connect to the other computer manually.
TIP If the connection does not open automatically, click 
Port Setup on the Options menu and verify that the appro-
priate COM port is enabled for wireless communications.
To manually connect to another computer by wireless:
1 Click the Connect Over button on the LinkBar and then 

click Wireless.
2 In the Connection list, click the name of the computer you 

want to connect to.
3 Under Services, check the services you want to use, such 

as File Transfer and Remote Control.

4 Click OK. 
TIP To turn Autoconnect off, select the Options menu, 
and click Connect Options. On the Connect tab, clear the 
Enable Autoconnect box.
TIP

Using infrared devices
The infrared devices you use in LapLink must first be set up 
in Windows. The Windows infrared driver supports a variety 
of built-in devices, including fast infrared devices, as well as 
adapters connected to serial ports. If the driver is not 
installed on your computer, you can download it from the 
Microsoft site on the Internet.
TIP When you install the infrared driver, specify any 
COM port from COM1 to COM9 as the redirected port. In 
LapLink, click Port Setup (Options menu) and enable the 
same redirected port for wireless communications.
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Connecting over CAPI 2.0/ISDN

If CAPI 2.0/ISDN lines are available to your computer and the computer you are connecting to—and if 
both computers are set up for CAPI 2.0/ISDN communications—you can open a high-speed connection 
and use Remote Control, File Transfer, and other LapLink services. To connect, click the Connect Over 
button on the LinkBar, and then click CAPI 2.0/ISDN.

CAPI 2.0/ISDN is an implementation of ISDN, an interna-
tional communications standard for sending voice, video, 
and data over digital telephone lines, at faster rates than 
those possible using modems.
NOTE LapLink does not offer CAPI 2.0/ISDN as a means 
of connecting unless CAPI 2.0/ISDN is installed on your 
computer.

CAPI 2.0/ISDN is widely used in Europe, particularly in Ger-
many. In North America ISDN seldom is implemented as 
CAPI 2.0, but you can still use your ISDN device for high-
speed LapLink connections. If you use your ISDN device as 
a modem, use Connect over Modem in LapLink. If you use 
it to dial in to, and log on to, a network, use Connect Over 
LAN (Network) in LapLink.

Use Connect over CAPI 2.0/
ISDN to link computers wher-
ever the CAPI 2.0 version of 
ISDN is available.
Entries you have created for 
CAPI 2.0/ISDN connections 
in the Address Book appear 
in the connection list to make 
connecting easier.

NOTE Both modems must 
be ISDN modems. DIgital 
modems cannot communi-
cate directly with analog 
modems. 
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 . . . Connecting over CAPI 2.0/ISDN
Before using Connect over CAPI 2.0/ISDN
• A CAPI 2.0/ISDN adapter and driver must be installed 

on both computers.
• Both computers must be running a version of LapLink 

that supports CAPI 2.0/ISDN.
• The security setup of the remote computer (the one you 

are connecting to) must be configured to allow incom-
ing connections. See ”Allowing incoming connections.

• CAPI 2.0/ISDN ports must be enabled in LapLink on 
both computers.

• LapLink must be running on both computers.

Connecting to a computer over CAPI 2.0/ISDN
To connect to a computer over CAPI 2.0/ISDN:
1 Click the Connect Over button on the LinkBar, and then 

click CAPI 2.0/ISDN.
2 Click the name of the computer you want to connect to in 

the Connection list or type a phone number under Dialing.
The connections listed under Manual Dial are your 
Address Book entries for CAPI connections. To create a 
new entry, click Address Book.

3 Under Services, check the services you want, such as File 
Transfer and Remote Control. 

4 Click the Dial button.
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Changing CAPI 2.0/ISDN performance in LapLink

Before using CAPI 2.0/ISDN in LapLink, you may want to customize the way that LapLink responds to 
CAPI 2.0/ISDN calls and uses the two channels available for LapLink communications. For example, you 
can specify that LapLink not respond to any incoming calls to a particular channel, or you can double the 
rate at which data is transmitted over your CAPI 2.0/ISDN connections.

In Port Setup, you can 
modify the way LapLink 
implements CAPI 2.0/
ISDN connections.
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 . . . Changing CAPI 2.0/ISDN performance in LapLink

To change CAPI 2.0/ISDN performance in LapLink:
1 On the Options menu, click Port Setup.
2 Under Port Settings, click CAPI.
3 Click the Configure button.
4 If you do not want LapLink to answer any incoming CAPI 

2.0/ISDN calls, clear the Enable box under Auto Answer.
To answer calls to only one number, type the number in 
this box: Accept Calls Only on the Following Numbers.

5 If you want to combine the two CAPI 2.0/ISDN channels for 
faster connections, check the Enable box under Channel 
Bonding.
Be sure that channel bonding is also enabled on the 
computer you will connect to.

6 Customize the Timeout options as necessary.
The Callback Timeout, Callback Delay, and Redial Delay 
settings are specified in seconds.

7 Click OK.

Answering calls
By default, LapLink is set up to answer all incoming CAPI 
2.0/ISDN calls on both channels. You can modify this so 
that it does not answer any of these calls or it answers calls 
to just one of the channels.

TIP If you don’t want LapLink to answer any incoming 
calls, clear the Enable box under Auto Answer; then make 
sure that the Accept Calls Only on the Following Numbers 
box is blank.
TIP When typing the number to accept calls to, use only 
numerals; avoid characters like dashes, parentheses, 
slants, and periods. When typing more than one number, 
use a semicolon to separate them.

Channel bonding
CAPI 2.0/ISDN provides two channels that can be used for 
LapLink communications. Each channel has a transmission 
speed of 64 Kbps. By combining (“bonding”) these chan-
nels, the transmission rate can double to 128 Kbps.
By default, LapLink does not use channel bonding, even 
when both channels are available. This setting keeps trans-
mission costs to a minimum for users who pay additional 
fees for each channel connection.
For faster transmissions, enable channel bonding. When 
both channels are available, LapLink can then transmit at 
speeds up to 128 Kbps. 
TIP Be sure to enable channel bonding on both comput-
ers. LapLink may not be able to make a connection 
between them otherwise.
TIP When one channel is already in use, LapLink uses 
the available channel to transmit at 64 Kbps, even when 
channel bonding is enabled.
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Connecting automatically

Once you have established a connection, you can save it for easy restoration later. You can restore a 
saved connection by double-clicking a shortcut icon, setting up LapLink to restore the connection 
automatically when you start LapLink, or restoring the connection while running LapLink. When LapLink 
restores a connection, it connects to the same computer or computers and opens the same services.

Instead of spending time connecting to the same computer 
and opening the same services time after time, you can 
save the connection and use the saved connection as a 
convenient way to reconnect later.
NOTE To connect to several computers at once, open 
connections to each of those computers before saving 
connections.

When you save a connection, you record such details as 
the number and types of connections (modem, network, 
Internet, cable), the names of computers, the user name 
and password if necessary, and the kinds of services in use. 
Each connection is saved as a file. Opening the file reopens 
the connections and services and arranges windows to 
appear much as they did before.

You can restore a saved connection three ways:

• Double-click its desktop icon.
• Set up LapLink to restore the connection 

automatically, whenever you run LapLink.
• Restore the connection yourself, while 

using LapLink.
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 . . . Connecting automatically
Saving a connection
To save a connection:
1 Open one or more connections as usual.
2 On the Connect menu, click Save Connections.
3 In the File Name box, type a name to identify the connection 

file.
4 Click Save.
5 When asked whether you want a shortcut icon for this con-

nection on your Windows desktop, click Yes or No.

Restoring a saved connection
Once you have saved a connection, you can restore it three 
ways:
• If you created a shortcut icon on your Windows desk-

top, double-click the icon.
• Set up LapLink to restore the connection when you run 

LapLink again.
• Open the connection file while running LapLink.
NOTE To completely automate the connection process, 
create entries in the Address Book for saved connections. 
Include the log-in name and password required to open 
each connection.
To set up LapLink to restore a saved connection when 
you start the program:
1 On the Options menu, click Connect Options.

2 On the Startup tab, check this box: Restore Saved Connec-
tions at Startup.

3 Click the name of the connection file you want to open, or 
type it in the Connection File box.
If the file does not appear in the list of files, click the 
Browse button and locate the drive and folder containing 
the file.
TIP Connection files have the .LLC extension. In Win-
dows 95 and Windows 98, as well as Windows ME, they 
are stored in the My Documents folder. In Windows NT, 
they are stored in the \Profiles\yourname\Personal folder 
within the Windows folder (where yourname is your Win-
dows NT logon name).
TIP In WIndows 2000, XP and 2003, they are stored in 
C:\Documents and Settings\username\My Documents.

4 If you want the connection restored without confirmation, 
click Automatically Connect at Startup. Otherwise, click Ask 
Before Connecting.

5 Click OK.
To open a saved connection while running LapLink:
1 On the Connect menu, click Restore Connections.
2 Click the name of the connection file you want to open, or 

type it in the File Name box.
If the file does not appear in the list of files, locate the 
appropriate drive in the Look In box; then double-click the 
folder containing the file.

3 Click Open.
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Using the Address Book

LapLink Gold Corporate’s all-new Address Book offers expanded flexibility and 
control to users.  It allows you to save connections you use frequently, create folders, 
organize your work, import and export connection information to and from a global 
database, and allows connections to users directly from the address book itself.

To use the Address 
Book, click on the 
Address Book icon 
on the toolbar..

The Address Book 
screen.
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 . . . View Options and Folders
View Options and Folders 

  The Address Book provides a folder structure and 
other options for viewing connections to computers. 

  Favorites- LapLink Gold Corporate allows you to mark 
Laplink computers you connect to as Favorites when you 
create address book entries.  One click on the Favorites 
icon on the Address Book tree will list all users you have 
marked as Favorites in the pane on the right.  These might 
be frequently accessed computers, VIP’s or other connec-
tions you want to keep on your Favorite list for easy access. 

 All Users- Selecting All Users lists all connections you 
have in your entire address book, including all folders and 
subfolders.

  Choosing Global lists the Global folders.  Global folders 
contain connections that may be accessed by many differ-
ent users in your organization.  For instance, it might be 
useful to provide a group of connections to your entire tech 
support team, and another list to your IT team.  Global fold-
ers can be shared among your teams using the Import/
Export features, which will be discussed later in this chapter

  Choosing Local lists the Local folders on your system.  
Local folders are used to store connections that you 
wouldn’t need to share with the group.  Local folders are not 
affected by importing or exporting.

Renaming, Adding and Deleting Folders
LapLink Gold Corporate allows users to the ability to Add, 
Rename or Delete Address Book folders

Adding a folder
To add a folder, select where in your address book you’d 
like the new folder to appear.  For instance, are these com-
puter connections you’d want to share with others?  If so, 
you might click Global, as shown below.  Right-click on the 
location you selected to see your User and Folder options.  
Choose Folder.
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A new folder will 
appear under the 
Global list called New 
Folder, as shown left.

Renaming a folder
To rename a folder, 
right-click on the folder 
you want, and choose 
Rename. 

Type in the new folder 
name in the box.  The 
new folder below is 
called Remote Sites.  
Once finished, click 
outside the folder 
name text box to fin-
ish.

Adding a Sub-folder

It is just as easy to 
create a sub-folder 
using LapLink Gold 
Corporate.  Simply 
highlight the folder in 
which you’d like to 
create a sub-folder, 
and right-click, then 
choose Folder again.
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 . . . View Options and Folders
Deleting a Folder

To delete a folder, 
highlight the folder, 
then right-click to 
view folder options.  
Select Delete to 
remove this folder.

CAUTION LapLink 
Gold Corporate 
prompts you with the 
confirmation screen 
to the right, but it is 
important to under-
stand that deleting a 
folder will delete the 

folder and all of its contents, including any entries in that 
folder.

LapLink Gold Cor-
porate also allows 
you to Cut and 
Paste a folder, and 
any connections in 
the selected folder.  
You can delete it 
from your Address 
Book in this man-
ner, or paste it to a 
new location.  For 
instance, you might 
have a local folder 
you want to share 
with your entire 
team.  You could 
cut and paste this 
folder from the 

Local folders to your Global folders, and export it so that 
everyone can use the connections. Importing/Exporting, is 
explained in detail later in this chapter.
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The Button Bar

The Address Book button bar is the control panel 
for much of the user function in the Address Book.  

Below is a brief description of the function of each 
button.

Close- Exits the user from the Address 
Book.

Connect- Connects you to the selected 
user.

Add- Brings up the Add User screen.

Edit- Allows you to edit a selected user.  

Delete- Deletes the selected user.

Find- Bringsup a Search interface for 
finding users.

Setup Global- Allows for the importing 
and exporting of a global database.
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 . . . Adding an Address Book Entry- General Tab
Adding an Address Book Entry- General Tab

Description
This describes the connection you are making. It could be at 
a person’s desk, or represent a server to you. LapLink Gold 
Corporate automatically populates whatever is typed in the 
Description field to the Computer Name field, though it is not 
necessary for these fields to be identical. 

Computer Name
NOTE The Computer Name information entered must 
match the LapLink name of the computer you're connect-

ing to EXACTLY, and is case-sensitive. This is not neces-
sarily the same as the Windows computer name. To see or 
change the computer name on the host computer you are 
connecting to, go to the Options menu in LapLink on that 
machine, and choose ‘Computer Name’.
The other fields in the top section (Company Name, Job 
Title, Notes) allow you to describe the connection.  Some-
times a computer is a person's desktop, sometimes it is a 
server.  These fields allow you to describe this computer 
connection more fully.  

Clicking on the Add button on the 
Address Book toolbar brings you to the 
Add Address Book Entry screen, on the 
General tab, as seen here.  The 
address book allows you to create and 
save connections, so that frequently 
used connections can be instantly 
accessed, without having to redefine 
the connection information each time. 
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Security information to send
If you are connecting to a computer that requires you to log 
in, and use a password, enter these pieces of information 
here.  These fields are both case-sensitive, so make sure 

the Log-In Name and Password match exactly. However, 
only the password field is case-sensitive.

Add To Favorites checkbox
Checking this box will allow this entry to be viewed when 
clicking Favorites on the left Address Book pane.
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 . . . Connection tab
Connection tab

The connection tab allows you to define how you want to 
connect to this computer. LapLink Gold Corporate allows 
many connection options, and these are discussed below. 

Important Requirements:  
NOTE LapLink Gold Corporate must be 
installed and running on both machines:  
Please note that no connection is possible, 
regardless of connection method, unless 
LapLink Gold Corporate is running on both 
your computer and the computer to which 
you are trying to connect.  Make certain 
LapLink Gold Corporate is set up on the host 
computer before attempting to create a con-
nection. 

Security Must Allow a Connection:  On the 
Host machine, or the machine to which you are 
trying to connect, security must be set to allow a 
connection; otherwise a connection is not possi-
ble.  To learn more about creating secure con-
nections and host options, go to ”Setting up 
security for incoming connections. 

A Port Must Be Enabled:  Each connection type 
has different requirements for connection, and 
LapLink Gold Corporate requires a port to be con-
figured for each connection type.  Click the Port 
Setup button to configure LapLink Gold Corpo-
rate to use your different port options.  To learn 
more about setting up ports, go to the chapter 
entitled”How can I connect to other computers?, 
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Connection Types

Laplink allows many different methods to connect to other 
LapLink computers. To learn more about ways to connect 
using LapLink Gold Corporate listed below, go to ”How can I 
connect to other computers?

Network: Available Now
Use this connection type if the computer you are connecting 
to normally appears in the list of available computers when 
you use Connect over LAN (Network).

Network: TCPIP Address
Use this connection type if you want to connect to this com-
puter using a TCPIP address. 

Internet Address
This connection type uses the address that the host com-
puter has published to the ILS server, such as Jane-
Doe@ACME.com. 

Modem
Use Modem if you use a modem on your machine to con-
nect directly to a modem on this user's machine.  Simply 
enter in the modem number in the Phone Number fields.

Cable
LapLink Gold Corporate accepts use of parallel, serial, or 
USB cable as connection types. 
NOTE It is generally not necessary to create an address 
book entry for cable connections, as LapLink Gold Corpo-
rate asutomatically creates the connection when the 
cables are attached (by default).

Firewall
If the host computer is behind a firewall or router, LapLink 
offers an alternative to opening ports and configuring the 
firewall by creating a persistent connection to the LapLink 
server. To learn more, please go to the online tutorial http://
laplink.com/tutorials/firewall.asp for detailed instruction on 
this connection type. 

LapLink Everywhere
LapLink Everywhere is another connection type offered.  To 
use LapLink Everywhere as a connection type, LapLink 
Gold Corporate must be running on both the client and host 
computers, and LapLink Everywhere must be installed and 
running on the Host computer.
LapLink Everywhere offers great flexibility by also allowing 
you to access other LapLink hosts via a browser. 
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 . . . Services tab
Services tab

The Services tab is where you can define what you'll be 
able to do once your connection is established. You can 
choose as few or as many different services as you need.

Host Locking on Connect
From a guest computer, you can ensure privacy and pre-
vent interruptions at the host by disabling its keyboard and 

mouse and blanking its screen.  Enable the options you 
want to control once you connect by checking the appropri-
ate checkboxes. 

To learn more about any of these services, click 
on the links below:

• ”Using File Transfer
• ”Using Remote Control
• ”Using Text Chat and Voice Chat
• ”Using Print Redirection

NOTE Host Locking options 
are only enabled when the 
Remote Control service is 
checked.
57



Once you’ve completed your selections on the three 
Address Book tabs (General, Connection and Services) 
click OK to save your changes.
NOTE There are four fields in each entry that must be 
filled in order to save an entry, and for a connection to be 
possible. 
On the General tab

•The Description and Computer Name fields must con-
tain characters.

On the Connection tab
•A Connection Type must be selected

On the Services tab

•At least one Service must be selected

CAUTION Once these fields contain data, the OK and 
Connect buttons become enabled, but this does not guar-
antee a connection. Make sure to use the correct com-
puter name, and that your connection type is correct, 
before attempting to make a connection. 
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 . . . Other Toolbar Options
Other Toolbar Options

The toolbar has several other buttons that allow you to man-
age your address book in different ways. 

Connect
Once you’ve created your Address Book entry, simply hit 
the Connect button to instantly connect you to this com-
puter. This is great for computers you need to connect to 
frequently.

Edit
If you need to change information in a particular Address 
Book entry, click Edit to make changes. 

Delete
If you want to delete a user or a user folder from your 
Address Book, choose the user or folder and select the 
Delete key.

Find
Find allows you to search your Address Book for a particu-
lar user or computer on your system. Search from a particu-
lar folder, or from any of the options on the Address Book 
tree in the left pane. Find searches for Computer Name 
only.

CAUTION You will 
see the confirma-
tion screen to the 
right, but it is impor-
tant to remember 
that if you choose a 
folder, the folder 
and all users in the 
folder will be 
deleted.
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Using Find Choose the folder on the left pane you want to search, then 
click the Find button, and enter the compter name you are 
looking for. See below.

If LapLink Gold Corporate is not able to 
locate this computer in the selected 
folder, it will ask you whether you’d like to 
look through the rest of the Address book 
to find it. See Below.

.

At this Point, LapLink Gold Corporate will 
search the rest of the Computer Names 
in the Address Book for the name or 
name segment you entered, and provide 
you all matches
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 . . . Other Toolbar Options
Setup Global
LapLink Gold Corporate provides the ability to link to a SQL 
database through the Address Book. This allows you to cre-
ate a Global Address book, and share this Address Book 

with anyone in your corporation you choose, provided 
LapLink Gold Corporate is installed on their desktop. This 
makes it easy to create a single address book and easily 
share it with your tech support or IT teams. 

When clicking on the Setup Global button, the Import/
Export screen on the left appears. LapLink Gold Corpo-
rate requires a connection to an SQL database through 
an ADO string. If you or your administrator know this 
information, you can enter it on the left, or click the Build 
ADO button, which will bring up the Windows Data Link 
Properties screen seen below.

LapLink Gold Corporate uses Microsoft’s Data Link Prop-
erties utility to step you through the process of connecting 
to your database. If you have questions about creating 
this connection, consult with your company’s database 
administrator for more information.
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Importing and Exporting
It is important to understand how importing and exporting 
works in LapLink Gold Corporate’s address book..

Importing
Importing allows you to download a local copy of the Global 
Address book. As the Address Book gets updated by other 
users, who might add or delete users or folders, importing 
allows you get any new folders and users in your address 
book. 

NOTE To import, you must have read access privileges to 
the database. See your database administrator for more 
information.

Exporting
Exporting allows you the capability of making changes to 
your address book, then Exporting those changes to the 
database. Exporting is primarily an administrative function. 
NOTE If you’ve made changes to your Global Address list, 
and you want to share these changes with other LapLink 
Gold users, you must first use Export to send those 
changes back to the main database. Then, other LapLink 
Gold users must use Import to receive the changes.
CAUTION If you make changes to your Global address 
book, then Export it, those changes are permanent, both 
in your Address Book, and in anyone’s Address Book who 
later imports it.
CAUTION Exporting requires write privileges. Database 
administrators should carefully manage which users have 
Address Book Exporting capabilities. 

Help
Click the Help button to get information on all the different 
components of the Address Book. 

Importing and 
Exporting ONLY 
affect the Global fold-
ers.

Connections in your 
Local folders are 
computers only you 
need to connect to, 
and can’t be shared.

You can, however, 
cut and paste or 
Copy from your 
Local folders to your 
Global folders, and 
then share these 
connections using 
Import/Export..

Once you’ve clicked the Build ADO 
button and established a connection 
to your database, your Import/Export 
buttons will become enabled.
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Allowing incoming connections

As a safety precaution, LapLink’s default security setting is “Private System”. After you install LapLink, 
you can connect to other computers, but other computers cannot open incoming connections to yours 
except by cable or wireless. To allow incoming connections, you can change the security setting to “Public 
System”. For more security, change the security setting to “Protected System” and create one or more 
entries in the Log-in List. In each entry, specify the password and the log-in name the user must provide to 
open an incoming connection, and grant the user permission to use services and other features.

The safest way to allow incoming connections is to set up 
password-protection by creating entries in the Log-in List. If 
you will be the only person to connect to this computer, 
make a single Log-in List entry and grant yourself whatever 

privileges you want. For other users, create separate entries 
for each user or group of users according to privileges 
granted.

Click Log-in List 
Only (Protected 
System) and then 
click the Log-in List 
button.

Create an entry in 
your Log-in List for 
the remote user.
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 . . . Allowing incoming connections

To set up password-protected access to your com-
puter:
1 Click the Security button on the LinkBar.
2 On the General tab, click Log-in List Only (Protected 

System).
3 Click the Log-in List button, and then click the Add button.
4 On the General tab, type the log-in name and the password 

the user must provide to make a connection to your 
computer.
Reenter the password and click OK to confirm.

5 Under Services, check File Transfer, Remote Control, or 
any of the other services you want to make available to that 
user.

6 Under Locking Permissions, check options to determine 
whether the user can blank the screen of your computer 
and disable its mouse and keyboard.
TIP You can grant locking permissions only if you select 
Remote Control as an available service.

7 To deny access to particular drives and folders, click the 
Folder Security tab. For more information see ”Denying 
access to certain drives and folders.

8 To specify whether or how a user opening a connection by 
modem is to be called back, click the Modem Callback tab. 
For more information, see page 70.

Specifying passwords
LapLink Gold passwords are case-sensitive (i and I, for 
example, are treated differently). For incoming connections 
from computers running LapLink Gold, you can specify 
more secure passwords by mixing capital letters and lower-
case letters. The introduction of case sensitivity has these 
important consequences:

CAUTION For incoming connections from computers run-
ning versions earlier than LapLink 2000,1 type passwords 
using ALL CAPITALS. If your Log-in List has passwords 
for such connections, retype them as all capitals, or assign 
new passwords.
CAUTION If your Log-in List contains passwords 
assigned in an earlier LapLink version, other computers 
that have also upgraded may not be able to connect to 
your computer until you assign new passwords.
CAUTION By default, security is not imposed on incoming 
connections over a cable or by wireless. If you set up 
password protection for modem and network connections, 
however, you can extend that protection to cable and wire-
less connections as well. On the Local Security tab, check 
this box: Enforce Security for Local Connections.

Setting up a public system
If security is not an concern, you can open your computer to 
any LapLink users. Though you do not require that they 
type a password, you can limit the services, drives, and fold-
ers they can access.
To allow access to your computer without password 
protection:
1 Click the Security button on the LinkBar.
2 On the General tab, click Anybody (Public System). Then 

click the Public Privileges button.
3 On the General tab, check the services and locking 

privileges you want to grant.
4 On the Folder Security tab, deny access to drives and 

folders as you wish. For more information see page 66.

1 Versions before LapLink 2000 include LapLink Pro, 
LapLink Tech, and LapLink 7.5 or earlier.
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Denying access to certain drives and folders

When you open your computer to incoming connections, you can specify whether all drives and 
folders—or only certain ones—are accessible to users who connect to your computer for File Transfer. 
You can also grant different privileges to different users. 

Opening your computer to incoming connections does not 
mean that files on all your drives and folders must be acces-
sible to other users. You can “hide” certain drives and fold-
ers so that other users will not see them in their File Transfer 
windows and cannot copy files to or from them.

You can set up drive and folder security when you secure 
your computer using the Log-in List. Specify a different 
setup for each entry in the list if you like. Until you specify 
otherwise, every user in your Log-in List has access to all of 
your drives and folders.

Folders removed from access in a 
Log-in List entry... 
...do not appear in File Transfer win-
dows on a remote computer.
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 . . . Denying access to certain drives and folders

CAUTION Denying access to a drive or folder makes it 
invisible to anyone who connects for File Transfer but has 
no effect in Remote Control. Anyone who connects for 
Remote Control can still access all of your files.
To limit access to certain drives and folders:
1 Click the Security button on the LinkBar.
2 Ensure that Log-in List (Protected System) is selected, and 

click the Log-in List button.
3 Click the Add button to create an entry in the Log-in List.

TIP If you want to change an existing entry, highlight it in 
the list of current users and click the Edit button.

4 Click the Folder Security tab and then click Only Allow 
Access as Specified Below.

Access is now denied to all drives and folders.
5 In the list of drives and folders, highlight each one you want 

to make accessible and click the Allow button.
TIP You can navigate through the drives and folders on the 
Folder Security tab much as you do in a File Transfer window. 
For fastest navigation, double-click a drive or folder or click 
the plus sign beside it.
NOTE You can also specify drive and folder security for a 
computer designated as a public system (no password 
required). Click the Security button on the LinkBar and 
click the Public Privileges button. Then click the Folder 
Security tab.
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Locking out password crackers

When you open your computer to incoming connections, it’s a good idea to include Lockout protection 
so that anyone who supplies an incorrect password more than a particular number of times is denied 
access to your computer. You enable Lockout and set the number of allowable tries as part of Security 
setup.

Like combination safes, security passwords can be compro-
mised. Password crackers use a variety of techniques; 
some techniques are more sophisticated than others, but 
almost all require guessing.

To guard against unauthorized access, use Lockout to bar 
anyone who makes repeated attempts at guessing a pass-
word for entry to your computer.

Use Lockout to protect 
against someone who 
attempts to guess your 
passwords.
As set up here, Lockout 
will take effect after five 
failed attempts for each 
log-in name.

Someone supplying the 
log-in name NormaJean 
has been locked out and 
won’t be able to connect 
even if he or she supplies 
the correct password.
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 . . . Locking out password crackers

To lock out anyone who repeatedly tries to connect 
using incorrect passwords:
1 Click the Security button on the LinkBar.
2 On the Lockout tab, check this box: Lock Out User after 

Repeated Wrong Passwords.
3 In the Lock Out After This Many Wrong Passwords box, 

click the number you want to allow before Lockout takes 
effect.
TIP The lower the number, the less the security risk.

4 Click OK.

Monitoring failed log-in attempts
Lockout is designed to monitor and control access accord-
ing to the log-in names in your Log-in List. A separate count 
of failed attempts is kept for each log-in name; when a count 
reaches your maximum (step 3 above), users can no longer 
connect using that log-in name.
Beside the log-in names listed on the Lockout tab appear 
numbers for the number of incorrect passwords. When a 
count reaches the maximum, the log-in name is labeled 
Locked Out.
You can reset to zero the count for any or all of the log-in 
names. This action also makes a locked out name usable 
once again.
TIP Unless a log-in name has been labeled Locked Out, 
its count is reset to zero automatically whenever a user 
connects using that log-in name and the correct password. 
For this reason, only consecutive failed attempts are 
recorded permanently, not cumulative failed attempts.

To reset to zero the count for a single log-in name:
• Click the log-in name and click the Reset User button.
To reset to zero the count for all log-in names:
• Click the Reset All button.

Tips for more secure passwords
• Use at least six characters.
• Include letters (both lowercase1 and capitals), num-

bers, punctuation, and symbols.
• Avoid any words found in dictionaries. (Some pass-

word-cracking programs rely on dictionaries to guess 
passwords.)

• Don’t make your passwords so complex or long that 
you can’t remember them.

• Change your passwords at regular intervals.
• In order to gain access to your computer in LapLink, a 

hacker would ALSO need LapLink installed and running 
on their system, and would need to locate your LapLink 
host, which is nearly impossible over the internet. If you 
are using Laplink with a firewall or router, the hacker 
would need to get around that security as well, before 
they would be able to attempt to crack passwords. All of 
this protection makes LapLink Gold Corporate very 
secure. 

1 Passwords for incoming connections from versions earlier 
than LapLink 2000 are the exception. They must be all 
capital letters.
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Allowing or requiring callbacks

When you allow incoming modem connections, you can require that the guest computer be called 
back before a connection is opened. Or you can let the guest computer determine whether to be called 
back. In both cases you can supply the phone number ahead of time or leave the number to the guest 
computer. You set callback options in the Log-in List.

A callback occurs when the guestcomputer attempts to con-
nect to host computer by modem; instead of completing the 
connection, the LapLink Gold Corporate host computer 

reverses the call by hanging up and then dialing to the guest 
computer. The connection is established when the guest 
computer answers.

LapLink will call you 
back at a number 
you enter, or will dis-
connect.

Laplink will call 
you back using a 
number you enter, 
or will connect 
without reversing 
the call.

LapLink will call 
you back at a 
number that has 
been specified, or 
will connect you 
without reversing 
the call.

LapLink will call you 
back at a number 
that has been speci-
fied, or will discon-
nect..
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 . . . Allowing or requiring callbacks

You can use callbacks as a security measure: e.g; require a 
callback to a phone number you specify. Or you can use 
callbacks to save money, as when you are connecting to 
your office from a hotel room.
You can set callback options when you secure your com-
puter using the Log-in List. Specify a different option for 
each entry in the list if necessary.
To set callback options:
1 Click the Security button on the LinkBar.
2 Ensure that Log-in List (Protected System) is selected and 

click the Log-in List button.
3 Click the Add button to create an entry in the Log-in List.

TIP If you want to change an existing entry, highlight it in 
the list of current users and click the Edit button.

4 Click the Modem Callback tab.
5 Click one of these options:

• None Prevents callbacks.
• Optional, Any Number Lets the guest user decide 

whether to be called back; users who choose to be 
called back can specify the number to dial. This is the 
most flexible of all the options.

• Optional, Specified Number Only Lets the guest 
user decide whether to be called back to the number 
you specify or to open the connection without any 
callback. Only the number you specify in the Phone 
Number box can be dialed for the callback.

• Required, Any Number Requires guest user to be 
called back but allows them to specify the number to 
be dialed. The number can vary from session to ses-
sion.

• Required, Specified Number Only Requires the 
guest user to be called back to the number you spec-
ify in the Phone Number box.

6 If you clicked either of the options for which you must specify 
a phone number, type that number in the Phone Number 
box.
Type the entire number, including any prefixes or suffixes 
necessary to dial the remote computer from this one. 
(Your Dialing Properties settings do not apply here.)

TIP Do not require callbacks from computers that con-
nect by running Xchange Agents. The agents will not finish 
because they cannot perform callbacks.
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Protecting your security settings with a password

Creating password protection for your LapLink security settings prevents unauthorized users from 
compromising your security system; it also keeps them from viewing your Address Book entries and 
using them to open connections to other computers. Protecting your security settings is a particularly 
good idea if you allow others to control your computer remotely. 

Setting up password protection for your LapLink security 
settings ensures that the protections you set up for your 

computer cannot be compromised—either by someone 
using your computer in your absence or by remote users.

On the Local Security tab 
in Security, check the Pro-
tect Local Security with a 
Password box. Then click 
the Set Password button.
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 . . . Protecting your security settings with a password

Without knowledge of your password, users cannot view or 
change any of this information:
• Log-in names, passwords, and other security settings
• Phone numbers, passwords, and other information 

stored in your Address Book entries
• Privileges you have granted to guest computers and 

other settings in Remote Control Options
In addition, the same password is required for access to 
Connect over Modem and certain Logging features.
To protect your LapLink security settings:
1 Click the Security button on the LinkBar.
2 On the Local Security tab, check this box: Protect Local 

Security with a Password.

3 In the Change Password dialog box, type a password at 
least 4 characters long in the New Password box. In the 
Confirm New Password box, type it again.
TIP Passwords are case-sensitive: capital letters and low-
ercase letters are treated differently. For more secure 
passwords, mix the two cases.

4 Click OK.
TIP To remove password protection, clear this box: Pro-
tect Local Security with a Password. To change the pass-
word currently in effect, click the Set Password button.
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Encrypting information over incoming connections

Encryption is a good idea over Internet connections and other connections where your information 
might be intercepted and compromised. You can use the encryption methods provided in LapLink, or use 
the powerful encryption options available in Windows opertating system. The settings you make on the 
host computer determine encryption level for incoming connections.
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 . . . Encrypting information over incoming connections

By default, LapLink encrypts log-in names and passwords, 
but nothing else. This setting is usually fine for transmitting 
data over office networks or other secure connections.
On the Internet, intranets, or wide area networks, however, 
it is usually a good idea to encrypt your data, including files, 
text from chat sessions, and instructions sent to the remote 
computer during Remote Control.
While opening your host computer to incoming connections, 
you can specify whether and how data transmitted over 
those connections will be encrypted. The settings on the 
guest computer are irrelevant. It is the settings on the host 
computer that determine encryption.1

To encrypt data over incoming connections:
1 Click the Security button on the LinkBar.
2 On the Encryption tab, check this box: Use Encryption to 

Send Data.
3 If you want to limit encryption to connections over a TCP/IP 

network or to dial-up connections to a TCP/IP network, 
including the Internet, check this box: Only Encrypt When 
Connecting over TCP/IP (Internet/Intranet).

4 Click a method of encryption:
• LapLink-compatible Encryption Provides com-

patibility with versions earlier than LapLink 2000.
• CryptoAPI Encryption Using the Specified 

Provider2 Sets a higher degree of security, using 
an algorithm installed on your computer. Cannot be 
used in connections with versions earlier than 
LapLink 2000.

5 If you clicked the CryptoAPI Encryption option, click a 
CryptoAPI provider in the box below the option.
Be sure to specify a provider that is installed on the 
remote computer too. That computer cannot connect to 
your computer otherwise.

6 If you clicked the CryptoAPI Encryption option—but still 
want to accept calls from earlier versions of LapLink (which 
lack CryptoAPI)—check this box: Use LapLink Encryption If 
Guest Doesn’t have CryptoAPI.

CAUTION This option opens your computer to a lower 
level of security than you specified in the previous step.
TIP Be sure to enable encryption before a connection is 
opened. Changing the setting during a connection won’t 
have any effect until the next connection.1 The only exception occurs when you connect to a com-

puter running a version older than LapLink 2000. In this 
case only, the settings on your newer LapLink 2000 guest 
computer determine encryption levels.

2 CryptoAPI encryption is available only if your computer is 
equipped with software written to the Microsoft CryptoAPI.
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Using Remote Control—Overview

When you open a Remote Control window, you can view and operate the host as if you were sitting in 
front of it. Images from the host appear on your screen in a Remote Control window within the LapLink 
workspace. .

Remote Control provides a way to operate another com-
puter at a distance. You begin Remote Control as soon as 
you open a Remote Control window. While you are working 
in this window, your mouse moves the mouse pointer on the 
remote computer, your keyboard types characters on the 
remote computer, and your Remote Control window shows 
the remote computer’s screen.

Remote Control terminology
A LapLink Remote Control session consists of the following:
Guest  The Remote Control window and the mouse and 
keyboard on the guest are your links to the remote com-
puter. Working in the Remote Control window, you use your 
mouse and keyboard to operate the host. Your work, mean-
while, is being processed on the host computer.
Host  There is no special procedure associated with setting 
up a host. The computer need only be running LapLink and 
configured to allow incoming connections. You do not need 
to be at the computer. On the other hand, you may want to 
join the guest as an observer or an active participant.

Opening a Remote Control window
On a guest, you can open a Remote Control window at the 
time you connect to the host. Or you can open one some-
time after the connection is made. Because LapLink sup-

ports multiple connections, the guest can maintain several 
Remote Control windows, one for each host computer.
To open a Remote Control window while connecting:
• Click the Connect Over button on the LinkBar and then 

click Modem, Network, or some other means of con-
necting. Under Services, check the Remote Control 
box. (For more information about connecting to other 
computers, see ”How can I connect to other comput-
ers?)

To open a Remote Control window after opening a con-
nection:
• Click the Open Remote Control button on LapLink Gold 

Corporate’s left shortcut bar.. Or click Open Remote 
Control on the Window menu.

• If you have more than one connection, select a window 
for the desired connection before clicking the Open 
Remote Control button.

What you see
The host screen appears on your screen as a window within 
LapLink. The name of the host computer appears in the 
window’s title bar. You can move, resize, minimize, or maxi-
mize the window as you would any other window. Use the 
scroll bars to view other parts of the host screen.
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Hosting a Remote Control session

For Remote Control to take place the host need only be running LapLink—you do not need to be at the 
computer. Sensitive information is protected by the conditions of the connection. You can grant greater 
access, or limit these conditions, through the LapLink security system.

After installation, change the default 
security setting to allow your com-
puter to accept incoming connec-
tions and serve as a host.

To host a Remote Control session, 
leave LapLink running. (Minimize it if 
you wish.)
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 . . . Hosting a Remote Control session

When you control a host, you specify who can connect to 
that computer and the kinds of services they can use. For 
example, you can limit a guest to Remote Control only, or 
you can allow access to Text Chat and File Transfer as well. 
You can even allow a guest to blank your computer’s 
screen or disable the mouse and keyboard. All of these 
options are set in the LapLink security system.
You can leave the host computer unattended, giving an 
authorized user exclusive control. Or you can stay at the 
computer and interact with the guest by trading off control. 
For example, the two of you could edit a document together, 
participate in a training session, or explore a new program.
When in a Remote Control session, both users can end up 
competing to control the mouse and keyboard, which can 
be frustrating and confusing for both parties. To avoid this 
problem, consider using “Host Locking On Connect” to dis-
able the host machine’s keyboard and mouse, and if you 
choose, to blank the host machine’s screen. See ”Disabling 
the host keyboard and mouse and blanking its screen” for 
more information.
TIP A host can be controlled by only one computer at a 
time. In the meantime, however, other computers can con-
nect to the host using any other services.

What you see on a host
When a guest connects and begins Remote Control, your 
LapLink workspace is minimized on the host. If you double-

click the icon, the LapLink workspace is restored to a win-
dow.
At the bottom of the restored LapLink workspace, you see 
an icon for the Remote Control connection. The icon is iden-
tified by the name of the remote computer. Clicking this icon 
displays a Windows menu with standard commands. Click-
ing Close closes the Remote Control connection.
TIP You can make the LapLink workspace remain a win-
dow when a guest connects: Click Remote Control 
Options on the Options menu, and then click the Host tab. 
Clear this box: Minimize LapLink When This Computer Is 
a Host.

Reversing a Remote Control session
There may be times when the guest and you want to switch 
roles so that you become the guest controlling the remote 
computer.
To reverse the direction of Remote Control, the current 
Remote Control connection must be broken on either com-
puter. Then, as the prospective guest, you open a Remote 
Control window and begin controlling the other computer.
TIP To avoid breaking the connection when a Remote 
Control connection is closed, make sure that there is at 
least one other service window open, such as File Trans-
fer. If Remote Control is the only service in use, open 
another service window before closing Remote Control.
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Viewing the host

As a guest, you can alternate between two views of the host screen. Your first view appears in a 
window within LapLink. Inside the window, you control the host; outside the window, you perform other 
tasks, in LapLink or in other applications on your computer. Switch to a full-screen view when you want to 
maximize your view of the host and use Remote Control exclusively. When you cannot see the entire host 
screen even in full screen, you can change the resolution of the host screen or scale its image to fit within 
your view.

Devoting your entire screen to a view of the host
You can view the host screen in two ways:
• In a window within LapLink (the default)
• As a full-screen display, hiding LapLink and the rest of 

your Windows workspace

In a window view, you have quick access to File Transfer, 
Text Chat, and other LapLink features. You can also switch 
to other applications on your computer.
To maximize the area in which you view and control the 
host, switch to a full-screen view. Your entire screen is now 
devoted to controlling the host; you do not have access to 
your own applications. When you want to do something 
other than control the host, switch back to the window view.

To alternate between a window and a full-screen view of 
the host, press CTRL+SHIFT+F.
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 . . . Viewing the host

To switch between window and full-screen view:
• Press CTRL+SHIFT+F.
TIP In full screen, you can also switch to a window from 
the copy of LapLink running on the host: If LapLink is an 
icon, click it to restore it to a window. Then click the icon 
representing your Remote Control window, and click 
Guest Full Screen to clear the check mark.
TIP To make Remote Control alternate between full 
screen and icon, bypassing the window view, click Remote 
Control Options on the Options menu. On the Guest tab, 
check the Always Use Full-Screen box.

Viewing the entire host screen at once
There are two ways to fit the host screen into your view:
• From your computer, lower the resolution of a higher-

resolution host screen to match that of your screen.
• Scale the image of the host screen to fit within your 

view.
Temporarily changing the resolution of the host dis-
play adapter  When using a laptop to control a desktop, 
you often can’t view the entire host screen at once if the 
desktop operates at a higher screen resolution. From your 
laptop, you can lower the desktop’s screen resolution to 
match your laptop’s.1

You can then view all of the host screen in full-screen view. 
The original resolution is restored automatically on discon-
nect or at your direction.
To lower the resolution of the host screen to match that 
of your screen:
1 On the Options menu, click Remote Control Options.
2 On the Guest tab, check this box: Match Host to Guest.

Clearing the box restores the host to its original resolu-
tion.

3 Click OK.
Scaling the image of the host screen to fit  You can 
also view the entire host screen at once by scaling the 
image to fit within the LapLink window. You always see all of 
the host’s screen, whether you are working in full screen or 
window, though the image may be distorted or compressed.
To scale the image of the host screen to fit within your 
view:
• Press CTRL+SHIFT+S.
• Pressing CTRL+SHIFT+S again restores the image to 

normal.
1 You cannot lower the resolution of a host computer unless 

its monitor and display adapter allow the change without 
restarting Windows. The host must also be running a ver-
sion of LapLink that supports this feature.
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Customizing keyboard control

By default, Windows system keys pressed on the guest computer take effect on the host. If you want 
the system keys to operate on the guest while working in a Remote Control window, click Remote Control 
Options on the Options menu. Then on the Guest tab, click Execute on Guest. Through Remote Control 
Options, you can also change the key combinations that control your view of the host.

Windows system keys
Windows system keys are key combinations that perform a 
variety of tasks. Pressing ALT+TAB, for example, switches 
to the program you used last. The ‘Windows’ Start key 

found on most keyboards is another example. By default, 
LapLink sends most system keys to the host during Remote 
Control: pressing ALT+TAB on the guest, therefore, 
switches to the program last used on the host.

When you are working in a Remote 
Control window, CTRL+TAB and 
other Windows system keys you 
press on your computer (the guest) 
take effect on the remote computer 
(the host).

To have system keys take effect on 
your computer instead of the remote 
computer, click Execute on Guest.
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 . . . Customizing keyboard control

You can make system keys work on your own computer 
(the guest) when you are working in a Remote Control win-
dow.
TIP Windows system keys (except 
CTRL+ALT+DELETE) always take effect on the host 
when you are using Remote Control in the full-screen 
view.
TIP If you intend to control a remote computer using the 
keyboard exclusively (without a mouse), set the Windows 
system keys to execute on your computer (the guest). 
When you want the keys to execute on the remote com-
puter (the host), switch to the full-screen view.
To execute Windows system keys on the guest:
1 On the Options menu, click Remote Control Options, 

and then click the Guest tab.
2 Click Execute on Guest.
3 Click OK.

Remote Control shortcut keys
LapLink offers two shortcut keys to change your view of a 
host screen. Pressing CTRL+SHIFT+F switches between 

full-screen and window view of the host. Pressing 
CTRL+SHIFT+S switches between scaled-to-fit and normal 
view. (See page 82 for more information.)
You can change these default key combinations to certain 
other combinations. (To avoid interference with other 
LapLink and Windows shortcut keys, you are limited in your 
choice of replacements.)
To change the LapLink shortcut key combinations:
1 On the Options menu, click Remote Control Options.
2 On the Guest tab, click in one of these boxes:

• Full-screen Toggle Changes the shortcut key that 
alternates between full-screen and window view.

• Scaling Toggle Changes the shortcut key that 
alternates between scaled-to-fit and normal view.

3 Change to any of the following key combinations (where n is 
a number or a letter):
SHIFT+ALT+n  
CTRL+SHIFT+n 
CTRL+ALT+n 
CTRL+SHIFT+ALT+n
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Disabling the host keyboard and mouse and blanking its screen

From a guest computer, you can ensure privacy and prevent interruptions at the host by disabling its 
keyboard and mouse and blanking its screen. To perform any of these “locking” operations from the 
guest, click the appropriate command on the Session menu. On the host, you must allow locking by 
changing the default security setup.

Configuring a host for locking
You can configure a host to determine who can lock it and 
how it will be locked. Guests cannot lock the host without 

your permission, and locking privileges you grant cannot be 
changed during a Remote Control session.
Whether you permit any kind of locking depends on how 
you intend to use LapLink. If you want to use Text Chat, for 
example, there should be no locking.

On the host: Allow users to blank 
the screen and disable the keyboard 
and mouse when you grant them 
access through the Log-in List.

On the guest: Blank the host screen 
and disable its keyboard and mouse 
through the Session menu.
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 . . . Disabling the host keyboard and mouse and blanking its screen

You grant locking permission by changing the security setup 
on the host computer: Click the Security button on the Link-
Bar. You then have a choice:
• Set up a Log-in List by specifying Log-in List (Protected 

System) and adding one or more entries. In each entry, 
check any of the three boxes under Locking Permis-
sions. The permissions apply only to guests whom you 
provide with the appropriate log-in name and password. 
For more information about setting up a Log-in List, see 
”Allowing incoming connections.

• If security is not an issue, open the system to any 
LapLink user by clicking Anybody (Public System). 
Click the Public Privileges button. On the General tab, 
check the Remote Control box, and then check any of 
the three boxes under Locking Permissions. The per-
missions apply to all guests.

Locking the host from the guest
With the permission of the host computer, you can:
Blank the host screen The host’s screen is darkened, 
preventing your work from being viewed at the host.
• Disable the host mouse The host’s mouse is locked, 

preventing anyone at the host from using the mouse to 
interrupt your work.

• Disable the host keyboard The host’s keyboard is 
locked, preventing anyone at the host from using the 
keyboard to interrupt your work.

To lock the host during a Remote Control session:
• On the Session menu, click any of these commands to 

place a check mark beside the command: Blank Host 
Screen, Lock Host Mouse, or Lock Host Keyboard.

• To disable locking, click the command again to clear the 
check mark.

TIP If a command is dimmed, it is not available: either the 
host cannot perform the action, or the security setup of the 
host computer does not allow it. Support for screen blank-
ing is determined by test performed after the installation of 
LapLink Gold Corporate, and after any changes to the 
Windows display settings. 
TIP The Session menu is available only when you are 
connected to another computer.
TIP Through the Address Book, you can request the 
kinds of locking you want to take effect as soon as you 
open a Remote Control session. Your requests will be 
honored as long as they are allowed by the host. For infor-
mation on using the Address Book to make connections, 
see ”Using the Address Book.
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Rebooting and logging on to the host

From a guest computer, you can reboot a host computer and restart Windows. To reboot a host from the 
guest during Remote Control, click the Reboot Host command on the Session menu. To configure a host 
for rebooting and restarting Windows, click Remote Control Options on the Options menu.

Rebooting the host from the guest
From a guest computer you may want to restart a host to 
put into effect changes you have made on that computer. Or 
you may want to restart a host computer to ensure that no 
one else can call in after you disconnect.

To reboot the host from the guest during Remote Con-
trol:
• On the Session menu, click Reboot Host.

If Reboot Host is dimmed on the Session menu, the host 
has not set the option to allow rebooting by a guest.

On the host: Allow users to reboot 
the computer in Remote Control 
Options.

On the guest: Reboot the host on 
the Session menu.
88



 . . . Rebooting and logging on to the host
Logging onto Windows NT, Windows 2000, XP or 
2003 from the guest
You must always press CTRL+ALT+DELETE before you 
can log on to Windows.
To send CTRL+ALT+DELETE to the host, do one of 
these:
• Press the key combination specified for this purpose on 

the host. By default: CTRL+SHIFT+D.
• On the host’s Session menu, click Send 

CTRL+ALT+DELETE to the Host.
• Click the Remote Control icon at the bottom of the 

host’s LapLink workplace, and then click Feed 
CTRL+ALT+DELETE.

Configuring the host for rebooting
You must configure a host to allow any guest to restart it 
during a Remote Control session. You can also require that 
the host be restarted whenever a Remote Control connec-
tion is interrupted.
To configure a host computer for rebooting:
• On the Host tab of Remote Control Options (Options 

menu), check either or both of these boxes:
• Allow Guest to Reboot on Command Check this 

box to allow guests to restart the host using the 
Reboot Host command on their computers.

• Always Reboot When Guest 
Disconnects Check this box to require that the 
host be restarted whenever a guest breaks a con-
nection or the connection is broken accidentally.

Ensuring access to the host after a reboot
At the same time you are configuring a host for rebooting, 
you can configure it so that a guest can resume a LapLink 
connection after the host is rebooted. You can do this by 
setting up LapLink to run whenever Windows is started.
To configure a host so that it automatically runs 
LapLink each time Windows is started:
• On the Advanced tab of Program Options (Options 

menu), check this box: Always Start LapLink before 
Windows Logon Prompt.

Logging on to Windows NT  When a Windows NT, Win-
dows 2000, XP or 2003 host requires the user to press 
CTRL+ALT+DELETE at logon, a guest can press a special 
key combination specified on the host.
To specify the key combination for 
CTRL+ALT+DELETE:
1 On the Host tab of Remote Control Options (Options 

menu), change the key combination in this box: Send 
CTRL+ALT+DELETE to this computer when a guest 
presses this key combination.By default, it is 
CTRL+SHIFT+D.

2 Press one of the chosen key combinations 
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Taking Screen Shots

Laplink now allows you to snap a screen shot from the host computer and save it to your hard drive during 
a remote control session. This is very useful for capturing error messages, odd displays or other behavior 
that might be hard to describe. Using Screen Shot will save technicians time when troubleshooting.

Taking a Screen Shot
To take a screen shot, you must first establish a Remote 
Control session with a host computer. Once this connection 
has been established, simply click on theSession menu, 
and choose Screen Shot to take a snapshot of the host 
desktop. You will see the dialog box below.

Window or Full Screen?
Laplink allows you to take two different types of screen 
shots. If you use Window, you will get a snapshot of the cur-
rent active window on the remote desktop. Choosing Full 
Screen will provide you a picture of the entire remote desk-
top screen. See the difference on the screens to the right.

Full Screen view

Window view
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 . . . Taking Screen Shots
Saving a Screenshot
Once you’ve taken a snapshot of the screen, you can save 
it to your hardrive for later viewing. Laplink saves the snap-
shot as a PNG file, which by default are viewed with Internet 
Explorer. 
NOTE:Internet Explorer 5.0 or higher must be in use in 
order to view PNG files. 
91



Viewing a Screen Shot

To review snapshots you’ve taken, click on the Session menu, and select View Screen Shot. This opens 
the View Screen Shot dialog, where you can view thumbnail screens of your snapshots, view them full 
screen, and delete screenshots you no longer need. You can view captured screens anytime, whether 
connected or not.

Viewing a Screen Shot

NOTE:From the Sessions menu, choose View Screen 
Shot. Note that screen viewing is enabled both during a 
session and when not connected, and it is the only Ses-
sion option available when not connected. Once you’ve 

selected a thumbnail snapshot, and clicked the View but-
ton, Laplink launches Internet Explorer or whatever appli-
cation your computer has associated with PNG files.

Highlight a thumb-
nail, and click View 
to view captured 
screens.

Select Sessions, 
View Screen Shot to 
access previously 
captured screens.
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 . . . Viewing a Screen Shot

NOTE:If you want to access the PNG files themselves, 
LapLink Gold Corporate saves them to the 
C:\WINNT\TSI32\LLW directory. 
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Saving System Information

Laplink makes it possible to capture important system information on the host computer, and save it to a 
file on your local machine. This troubleshooting tool provides your support professionals with a single 
report offering a great deal of useful information. 

Saving System Information
To save system infor-
mation from the host 
computer to your 
local machine, you 
must first be con-
nected via a Remote 
Control session.

Once this connec-
tion has been estab-
lished, choose 
Session, Save Sys-
tem information
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 . . . Saving System Information

Laplink saves all Windows system information from the 
remote computer, and exports it to your computer. For this 
reason, you’ll see a popup message, seen below.

Creating a Report
Laplink creates a report that saves your Windows System 
information. Below are just a few of the headings of informa-
tion contained in your Laplink report.

•System summary information
•Hardware resources
•IRQ information
•Memory
•Components
•Audio and Video Codecs
•Devices
•Display
•Keyboard
•Adapters

Laplink Gold lets you 
know the report you 
are about to create 
may take a few min-
utes.

Next, it asks you 
where to save the file.
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Sharing clipboard information with remote computers

Computers in a Remote Control connection share a common clipboard: you can copy or cut 
information to the clipboard on one computer and paste this information on another. .

When you cut or copy information for pasting in another 
document, the information is stored temporarily in the clip-
board. Normally, clipboard information is transferred 
between documents on the same computer. When you use 
Remote Control, however, you can use the clipboard to 
transfer information from one computer to another. You can 
copy text or graphics on the host computer, for example, 
and paste it on the guest.
TIP Only information placed in the clipboard during 
Remote Control can be pasted on other computers. You 
cannot share any information copied or cut to a clipboard 
before a Remote Control connection is opened.
TIP When you clear the contents of the clipboard on one 
computer, you clear the clipboard contents of the other 
computer as well.

Pasting from the clipboard during Remote Control
When you copy or cut information to the clipboard during 
Remote Control, only a small part of the information is trans-
ferred to the other computer immediately. The rest of the 
information is transferred when you paste.
To prevent the loss of information added to the clipboard 
from the remote computer during Remote Control, paste the 
information before disconnecting.

If you are controlling several host computers, information in 
the clipboard on your computer is available to any of them. If 
you want to transfer clipboard information from one com-
puter to another, however, you must first paste the informa-
tion into a document on your guest computer; then paste it 
into a document on another remote computer.

Disabling clipboard sharing
By default, clipboard sharing is available during Remote 
Control sessions unless you disable it.
To disable clipboard sharing:
1 Open a Remote Control connection to another com-

puter.
2 On the Edit menu, click Link Clipboards to clear the check 

mark.
If there is data in the common clipboard that hasn’t been 
transferred completely, you are asked whether to com-
plete the transfer.

TIP To enable clipboard sharing again, repeat the proce-
dure to restore the check mark to Link Clipboards. Only 
data placed in the clipboard after you enable this option 
can be shared with other computers.
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 . . . Customizing Remote Control performance
Customizing Remote Control performance

As a guest, you can change several Remote Control settings either to speed up performance or to 
enhance your view of the host screen. When speed is your priority, change the settings to enhance 
performance. When you want the best view of the host screen, turn off the performance enhancements. .

To improve Remote Control performance, LapLink tempo-
rarily alters the host screen by removing its wallpaper, 
screen saver, and other visual enhancements. You can 
restore any of these enhancements. Or you can improve 
performance even more by minimizing the number of bit-
maps and bitmap colors transferred over a connection.
To change Remote Control performance settings:
1 On the Options menu, click Remote Control Options.
2 On the Performance tab, click either of these options:

• Best Quality Improves the appearance of fonts 
and does not change the appearance of the host 
screen except to disable its screen saver.

• Best Performance Displays smaller bitmaps in 
black and white and does not show larger bitmaps at 
all; also changes the appearance of the host screen 
to maximize performance.

3 To customize the settings for any of these options, click the 
Settings button.Changing your view of the host screen

Choose between enhancing your 
view of the host screen and speeding 
up Remote Control performance.

Click one of the preset options.

Or click the Settings button and 
specify your own settings.
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Click the Settings button in Remote Control Options to 
change the quality of your view of the host screen without 
affecting the host screen itself.
On the Guest Display tab, adjust these options:
Send Font Information  Displays text and symbols on 
the guest computer. Checking this box speeds display per-
formance but may not present the most accurate represen-
tation of text and symbols.
Prevent Display of Large Bitmaps  Determines the 
size of the largest bitmap to be displayed in your view, rang-
ing from 32 by 32 to 512 by 512 pixels. Choosing a smaller 
size improves performance but may cause bitmaps not to 
appear in some dialog boxes, wizards, and buttons. (Exper-
iment with the setting, increasing it as necessary to display 
larger bitmaps.)
On the Guest Colors tab, adjust these options:

Use Solid Colors  Displays solid colors instead of dith-
ered, or patterned, colors. Performance is not affected, but 
your view of the host may improve.
Bitmap Color  Selects the palette used to display bitmaps. 
The values range from Monochrome to True Color (24 bit). 
Choose a palette with fewer colors to improve performance.

Temporarily changing the host screen
Click the Settings button in Remote Control Options to alter 
your view of the host by changing the appearance of the 
host screen itself. When you disconnect, the host screen is 
restored to its original appearance.
On the Host Display tab, change these settings:
Disable Screen Saver   Keeps the host’s screen saver 
from running.
Disable Special Windows Effects  Disables several 
Windows features, including desktop wallpaper or patterns, 
animated windows, and Web Page view.
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Using File Transfer—Overview

Once you have connected to another computer and opened File Transfer windows, you are ready to 
transfer files between the computers. First, display your target, and then select the files you want to 
transfer. If you want the files on both computers, copy them. If you want to transfer the files to one 
computer and delete them from the other, move the files.

You can open File Transfer windows at the time you con-
nect to a remote computer. Or you can open File Transfer 
windows sometime after the connection is made.
NOTE In Windows, folder and subfolder are used in place 
of directory and subdirectory.

To open File Transfer windows:
• Connect to another computer with the File Transfer ser-

vice selected, or click the Open File Transfer button on 
the Shortcut bar. Or click Open File Transfer on the 
Window menu.
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NOTE If you click the ‘Open File Transfer Window’ button 
when no active connection has been established, you’ll be 
creating a local-to-local file transfer connection.
• Two File Transfer windows appear: one for the remote 

computer, one for your computer. Using these windows, 
you can view all the files on any drive on both comput-
ers.

Step one: display the target
To use the drag-and-drop method of copying and moving 
files, first find your target and make it visible on your screen. 
A target is the drive or folder you want to transfer the files to.
To display the target:
1 Identify the target window: it may be the window for your 

computer or the remote computer—whichever you want 
to receive the files.

2 On the left side of the target window, double-click the target 
drive.

3 Click the target folder. Its contents now appear on the right.
4 If you are looking for a subfolder, click the plus sign (+) 

beside the folder containing the subfolder. Then click the 
subfolder itself.

NOTE To determine which File Transfer window is which, 
look for the computer name in the title bar, at the top of 
each window. In the case of a local-to-local connection, 
each window will show the same name, followed by a (1) 
or (2).

Step two: select the files

In the opposite File Transfer window, select the files you’ll 
be transferring to the target you just displayed.
To select the folders and files you want to transfer:
• On the right side of the window, click the folder or file 

you want to transfer.
• To select more than one item, do either of the following:

• Hold down CTRL as you click each item.
• To select two or more items listed next to each other, 

click the first item and press SHIFT while you click 
the last item.

NOTE If you prefer, select a group of files or folders by 
clicking at a right corner of the group and dragging to the 
opposite corner to form a selection box.

Step three: drag and drop
Using the drag-and-drop method simplifies file transfers. 
Keep in mind the difference between copying and moving: 
Copying puts a copy of the files on the other computer, leav-
ing the originals where they were. Moving puts the files on 
the other computer, deleting the originals.
To drag and drop the selected files:
• To copy the files, hold down CTRL and your left mouse 

button as you drag them to the target folder.
• To move the files, hold down SHIFT and your left 

mouse button as you drag them to the target folder.
TIP If you drag without using CTRL or SHIFT, files are 
copied when you drag to a different drive or computer and 
moved when you drag to another location on the same 
drive.
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Navigating through drives and folders

Each File Transfer window is split into a left and a right side. The left side is designed for navigating 
through drives and folders: click or double-click a drive or folder to open it and display its contents. On the 
right side, you see the contents of the open drive and folder. Commands on the View menu let you 
change the appearance and the order of the contents.

Click a drive or folder to open it, with-
out showing its contents.

Click a plus sign to show the con-
tents of a drive or folder without 
opening it. Click a minus sign to hide 
the contents.

Double-click a drive or folder to open 
it and show its contents.
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Follow these guidelines to navigate through the left side of a 
File Transfer window:
• Double-click a drive or folder Opens and expands 

the drive or folder, displaying its subfolders immediately 
below. (Double-clicking is the fastest way to navigate 
downward in a hierarchy of folders.)

• Click a drive or folder Opens the drive or folder with-
out expanding it.

• Click a plus sign (+) Expands the drive or folder, dis-
playing its subfolders immediately below. The drive or 
folder is not opened.

• Click a minus sign (-) Collapses the drive or folder, 
hiding its subfolders.

TIP Want to locate a particular folder or file? Type the first 
letter of its name. The highlight moves to the next item 
beginning with that letter. Typing the letter again finds the 
next occurrence.

Changing the view
When you open a drive or folder, you see its contents—sub-
folders and files—on the right side of the File Transfer win-
dow.

By default, the contents appear in Detail view: file name, 
size, type (based on the MS-DOS name extension), modifi-
cation date, and attributes.
To change the appearance of the items displayed on 
the right side of a File Transfer window:
• On the View menu, click one of these commands: 

Large Icons, Small Icons, or List.
Try the different views to find your preference. To return to 
the original view, click Detail.

Sorting files and folders
Regardless of the view, you can rearrange the folders and 
files on the right side of a File Transfer window according to 
name, size, date, and so on.
To change the order of files and folders:
• On the View menu, point to Arrange Icons; then click 

one of these commands: By Name, By Type, By Size, 
By Date, or By Attributes.

TIP If you are displaying files in Detail view, you can sort 
them by name, size, type (file name extension), modifica-
tion date, or attribute: click the corresponding button at the 
top of a column. Clicking the same button again reverses 
the order.
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Selecting files and folders

On the left side of a File Transfer window, you can select only one folder at a time. On the right side, you 
can select multiple folders and files. To select a single item, point to it and click the left mouse button. To 
select several items in sequence, click the first item; then hold down SHIFT while you click the last item. 
To select items out of sequence, hold down CTRL while you click each one. You can also click Select All 
or Select By on the File menu. To cancel an individual selection, hold down CTRL, and click the item.

You must select a folder or file before you can copy or move 
it. When you select an item, its name and icon are high-
lighted.

You can select a single folder on either side of a File Trans-
fer window. You can select files and multiple folders only on 
the right side.

Select a group of items by dragging 
a selection box around them, from 
right to left.

Select several items not listed 
together by holding down CTRL 
while you click the items.
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NOTE By default, selecting a folder selects all of its files 
and its subfolders. To change the default, click File Trans-
fer Options (Options menu). On the Filter tab, clear this 
box: Include Subfolders in Copies. (You can always over-
ride this setting when you are asked to confirm a copy or 
move operation.)
To select a single file or folder:
• Place the mouse pointer on its name or icon, and click 

the left mouse button.
To select a group of items, do either of the following:
• Click the first item, and press SHIFT while you click the 

last item.
• Click at a right corner of the group and drag to the 

opposite corner to form a selection box.
To select two or more items out of sequence:
• Press CTRL while you click the items.
To select all folders and files in the current folder:
•  On the File menu, click Select All.
TIP To select everything on a drive, click the drive and 
then click Select All.

To select folders and files using the Select By com-
mand:
1 On the File menu, click Select By.
2 In the Filter box, type the name of a file or folder. Or use wild-

cards to specify items with similar names.
For example, typing *.DOC selects all files with the .DOC 
extension. The default (*.*) selects all files and folders.
You can specify several criteria at once by typing them 
one after another and inserting a space or a comma 
between them. For example, typing *.DOC,*.TXT dis-
plays all files with those extensions.

3 If you want to select according to date, check the Enable 
Date/Time Range box. Then type the dates and times 
under Oldest File and Newest File.

4 Click OK.

Clearing selections
To clear an individual selection:
• Hold down CTRL while you click the item.
To clear all selections:
• On the File menu, click Clear Selection.
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Copying or moving files and folders

Once you have displayed the target and selected the items to be transferred, you are ready to use the 
Copy or Move command. Or you can use the mouse to drag the items and drop them onto the target. 
Before the transfer is completed in either case, you see a confirmation dialog box showing details of the 
operation you are about to perform. You can then proceed immediately, change certain conditions, or 
cancel the operation entirely.

When you copy or move, you transfer items from one loca-
tion—the source—to another—the target. You can transfer 

items using the Copy or Move commands or by dragging 
them with the mouse.

Before copying or moving, you 
can confirm that you have 
selected the source and target 
as you intended.
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 . . . Copying or moving files and folders

To prepare for a copy or move operation:
1 Navigate through the left side of the target window to 

display the folder where you want to put the selections. 
Click the folder. (For more information, see page 102.)

2 In the source window, select the items you intend to transfer. 
Make sure that the source and the target are still showing. 
(For more information, see page 104.)

NOTE Before attempting to transfer between computers, 
open a File Transfer window for each of them.
To copy or move using drag and drop:
1 Place the mouse pointer over a single item or one of 

several items you have selected on the source.
2 Do either of the following:

• To copy, press CTRL and your left mouse button as 
you move the pointer over to the target folder.

• To move, press SHIFT and your left mouse button as 
you move the pointer over to the target folder.

3 Once the target is highlighted, release the mouse button 
and the CTRL or SHIFT key.
You now see the File Copy or File Move dialog box, as 
shown on the previous page.

To copy or move using a command:
• With the source window still active, click Copy or Move 

on the File menu.

You now see the File Copy or File Move dialog box, as 
described next.

NOTE Copy and Move also appear as buttons on the tool-
bar near the top of each File Transfer window.
To complete the copy or move:
1 In the File Copy or File Move dialog box, you can verify 

the source and the target, change the target, and set 
options. Do any of the following:
• Under To, verify the target. You can choose a differ-

ent computer from the Computer list; in the Folder 
box, you can type any drive and folder already on the 
target.

• Under Options, check or clear the boxes as you 
wish. For more information, see page 108.

2 Click OK to complete the operation or Cancel to halt it.
You now see a dialog box reporting on the operation as it 
proceeds. Click Cancel to halt the operation. If the Pro-
tected Files dialog box appears, select the files you want 
to transfer, and click OK.

TIP Dropping onto a drive puts the selections at the high-
est level of the hierarchy of folders.
TIP Dropping onto a folder puts the selections inside the 
folder.
TIP Dropping onto a file puts the selections on the same 
level as the file.
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Setting File Transfer options for the results you want

Certain File Transfer options play a crucial role when you are copying or moving files. Depending on 
how you set them, you can include or exclude subfolders, prevent the overwriting of files except by newer 
copies, or copy only files you have backed up before. To specify global preferences for these options, click 
File Transfer Options on the Options menu; then click the Filter tab. Whenever you confirm a copy or 
move operation, you can change the settings for that operation.

There are three File Transfer options that determine which 
files are transferred and which are overwritten:
• Transfer Only If Files Are Newer

• Include Subfolders in Copies
• Transfer Only If Files Are Already on Target
The first two options are in effect until you change them.

Set global options on the Filter tab of File 
Transfer Options.
When copying or moving, verify the settings 
before clicking OK to continue.
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To change your global preferences for File Transfer 
options:
• On the Options menu, click File Transfer Options. Click 

the Filter tab, and then check the appropriate boxes.
When you transfer files, you can tailor these options for that 
operation before giving your confirmation.
NOTE Before transferring files between computers, 
ensure that their clocks are reasonably in sync. If they are 
not, files that appear to be older may actually be newer, 
and you could lose your most recent work.

Protecting newer copies of files
One of the options—Transfer Only If Files Are Newer—is 
designed to preserve files that represent your most recent 
work. It is also useful for speeding up file transfers; files that 
do not need to be updated are excluded from the operation.
When the box is checked, Transfer Only If Files Are Newer 
ensures that files are not overwritten by older copies of 
those files. (Files not already on the target will be copied 
anyway.) When the box is cleared, files are overwritten with-
out regard to their dates and times.

Including or excluding subfolders
One of the options—Include Subfolders in Copies—is 
designed for copying a hierarchy of folders and subfolders 
and is potentially the most powerful of the File Transfer 
options. It can make the difference between copying hun-
dreds of files or only a few.

When the box is checked, Include Subfolders in Copies 
extends your selection to include any subfolders within the 
folders you have selected. When the box is cleared, your 
selection is limited to the selected files and folders (including 
the files in those folders); subfolders within folders are 
excluded.

Updating older copies of files
One of the options—Transfer Only If Files Are Already on 
Target—simplifies the task of updating older copies of files 
without adding new ones. It is designed for anyone who reg-
ularly updates the same set of files. No matter how many 
files you select on the source, only those already on the tar-
get will be copied; the others will be ignored.
In preparation for using this option the first time, copy the 
files to the target with the box cleared. When you are ready 
to update the same files, check the box.

Deleting to the Recycle Bin
By default, any files you delete from a hard drive are “recy-
cled,” that is, moved to the Windows Recycle Bin, where 
you can retrieve them later.
NOTE Whether files are recycled or permanently removed 
is determined solely by the setting on the guest computer.
To permanently remove files when you delete them in 
LapLink:
1 On the Options menu, click File Transfer Options.
2 On the Delete tab, clear this box: Move Deleted Files and 

Folders to the Recycle Bin.
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Synchronizing folders with SmartXchange

U se SmartXchange to synchronize two folders in a two-way exchange of files. You can limit the scope 
of the operation by including only the files already in both folders. You can also use SmartXchange to 
update a backup folder quickly. In either case, older files are overwritten, but no files are deleted.

Synchronizing folders
If you have ever copied files back and forth between com-
puters so that they share the latest files, you have synchro-
nized. Unlike the usual copy operation, synchronization 
works in two directions: from one folder to the other and 
back again.
NOTE With SmartXchange, you determine the items to be 
copied by selecting the folder containing the items, not by 

selecting the items themselves. Select the folder on the left 
side of a File Transfer window.
With SmartXchange, you can accomplish this in one opera-
tion, one folder at a time. You can increase the scope of the 
operation by including subfolders within the folder. You can 
limit its scope by exchanging only the files that are on both 
folders already.

Files are overwritten when there are 
newer copies in the other folder.

In SmartXchange

After SmartXchange, the two folders 
are identical.

Files are not copied when there are 
identical copies in both folders.

Files are copied when they are in 
one folder but not the other.
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CAUTION SmartXchange is a tool for exchanging files 
between folders. It does not merge the contents of files. If 
you need to merge databases, schedules, or other shared 
files, see the documentation for the program in which they 
were created.
TIP If you synchronize the same folders on a routine 
basis, consider using Xchange Agent instead of SmartX-
change. Xchange Agent automates the process of open-
ing connections, selecting the pairs of folders to be 
synchronized, setting the appropriate options, initiating the 
exchange, and disconnecting. For more information, see 
page 120.
TIP Any files that you intentionally delete on one com-
puter will be automatically replaced by two-way synchroni-
zation. If you wish to use a two-way transfer, you must 
manually delete the files in question on both computers 
before running the SmartXchange. For more information 
on deleting data, see page 112.
To use SmartXchange to synchronize folders:
1 On the left side of each File Transfer window, click the 

folder (not an entire drive) containing the files you want 
to exchange.

NOTE LapLink cannot synchronize an entire drive, the 
folders containing the Windows operating system, or any 
other data that is locked (in use).
NOTE To verify which folder is open, look at the title bar, at 
the top of the File Transfer window.
2 On the SyncTools menu, click SmartXchange. Or click the 

Sync button on the toolbar near the top of the File Transfer 
window, or hit F9.

3 Verify that the source and target are correct. If necessary, 
change the target.

• If you want to include subfolders in the exchange, 
check this box: Include Subfolders.

• If you merely want to update files—and not add new 
ones—check this box: Transfer Only If Files Are 
Already on Target. If you want the two folders to be 
identical, the box must be cleared.

4 Make sure that this box is cleared: One-way Transfer Only.
5 Click OK.

Updating backup folders
You can also use SmartXchange to simplify the process of 
updating a folder to which you have backed up a set of files.
To use SmartXchange to update a backup folder:
1 On the left side of the target (backup) window, click the 

folder you want to update.
2 On the left side of the source window, click the folder con-

taining the files you want to back up again.
3 On the SyncTools menu, click SmartXchange.
4 Verify that the source and target are correct. Change the tar-

get if necessary.
• If you want to include subfolders in the exchange, 

check this box: Include Subfolders.
• If you want to update files—and not add new ones—

check this box: Transfer Only If Files Are Already on 
Target. If you want the folders to be identical, the box 
must be cleared.

5 Make sure that this box is checked: One-way Transfer Only.
6 Click OK.
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Replacing one folder with another: Clone Folder

C lone Folder replicates one folder onto another by adding, deleting, and updating files on the target 
until they match those on the source. After opening the target and the source folders, click Clone Folder 
on the SyncTools menu. Then choose whether to include or exclude subfolders.

Clone Folder replaces one folder (the target) with another 
(the source). The effect is the same as deleting everything 
on the target and copying everything from the source.
Cloning a folder adds and updates target files until they are 
identical to those on the source. In addition, it deletes any 
target file that has no counterpart on the source.

NOTE With Clone Folder, you determine the items to be 
copied by selecting the folder containing the items, not by 
selecting the items themselves.

Source Target

Use Clone Folder to replace the con-
tents of one folder (the target) with 
the contents of another (the source).
Clone Folder has the effect of eras-
ing the target and copying the entire 
source.

CAUTION This is the ONLY File 
Transfer function of LapLink Gold 
Corporate that allows data dele-
tion. Since this function cannot be 
undone, consider carefully before 
using a Clone folder. 
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It’s the deletion of files that makes Clone Folder useful, par-
ticularly when you are maintaining a backup folder. With the 
usual copy operation, the backup folder over time accumu-
lates all the files you have deleted from the source. With 
Clone Folder, those unwanted files are removed with each 
backup.
CAUTION Use this command with caution. Any subfolder 
or file not on the source will be deleted from the target.
To replace one folder with another:
1 On the left side of the target window, click the folder 

whose contents you want to replace.

2 On the left side of the source window, click the folder whose 
contents you want to reproduce.

3 With the source window still active, click Clone Folder on the 
SyncTools menu.

4 Verify that the source and target are correct. Change the tar-
get if necessary.

5 If you want to reproduce subfolders within the selected 
folder, check this box: Include Subfolders.

6 Click OK.
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Speeding file transfers with SpeedSync and compression

When you are updating files, SpeedSync can shorten transfer times by sending only the parts of the 
files that have changed since the last update. SpeedSync is most effective when you update files that 
have not been changed extensively since the last update. Compression, on the other hand, speeds file 
transfers by “shrinking” files before they are sent and restoring them to their original sizes afterward. 
Compression is most effective with large files that have not been compressed already. Though both 
features are in effect by default, there may be circumstances in which you might improve transfer times by 
disabling them.

Using SpeedSync
SpeedSync is designed to cut transfer times when you are 
updating files. It has no effect when you are copying files 
that were not on the target before you started copying.
Before a file is copied, SpeedSync searches the target for a 
file with the same name. If none is found, the entire file is 

copied. Otherwise, the two files are compared to locate 
changes in the source file. Only the changes located in the 
source file are copied.
The time necessary to locate changes is usually more than 
offset by the smaller amount of data that has to be trans-
ferred. The reverse may be true in a few circumstances, 

With SpeedSync
Source and target files are compared 
to locate changes in the source file.
Only the changes are copied, usually 
resulting in faster transfers.

Without SpeedSync
Source and target files are not com-
pared for changes.
Entire files are copied, often resulting 
in longer transfer times.
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e.g.; when you are updating many small files over a fast 
connection.
NOTE Whether SpeedSync and compression are used in 
file transfers depends entirely on the settings of the guest 
(the computer that opens the connection).
CAUTION SpeedSync is a tool for decreasing transfer 
times. It does not merge the contents of two files. The con-
tents of one file will always replace the contents of the 
other. If you need to merge databases, schedules, or other 
shared files, see the documentation for the program in 
which they were created.
To disable SpeedSync:
1 On the Options menu, click File Transfer Options.
2 On the Performance tab, clear this box: Use SpeedSync on 

All File Transfers.
TIP To review the effect of SpeedSync on your past file 
transfers, open at least one File Transfer window. Then 

click SpeedSync Statistics on the SyncTools menu. You 
see the statistics for your most recent transfer as well as 
combined statistics for earlier transfers.

Using compression
Because compression usually results in the transfer of less 
data, it is particularly useful when you transfer large files by 
modem: the larger the files, the greater the savings.
Since compression would actually slow the transfer of files 
that have already been compressed (or zipped by another 
file-compression program), LapLink automatically turns this 
feature off while it is transferring such files.
If you find a situation in which compression does not speed 
up file transfer, you can disable it: On the Options menu, 
click File Transfer Options. On the Performance tab, clear 
this box: Use Compression When Transferring Files.
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Resuming an interrupted file transfer

If you lose your connection to another computer while transferring files, File Transfer Recovery lets you 
connect again and continue the transfer where it left off. Any file—or portion of a file—copied before the 
interruption is skipped; only the untransmitted data is copied.

File Transfer Recovery lets you continue a file transfer even 
when you have lost a connection. Instead of starting the 
transfer at the beginning, File Transfer Recovery resumes 
at the point where the connection was lost:
• Only the missing part of the interrupted file is copied.
• Files successfully copied before the interruption are not 

copied again.
TIP File Transfer Recovery is particularly useful when 
you copy large files over an unreliable modem connection.

To resume an interrupted file transfer:
• If you were running an Xchange Agent when the inter-

ruption occurred, run the agent again.
• If you were transferring from File Transfer windows:

1 Re-establish the connection.
2 Select the same files and folders.
3 Begin the transfer again.

If you lose a connection while 
transferring a file, the data 
transferred at the point of inter-
ruption is stored on the target 
computer.

When you reconnect and 
resume the transfer, the miss-
ing part of the file—not the 
entire file—is copied, along with 
the remaining files.
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File Transfer Recovery and other options
Three options must be enabled for File Transfer Recovery 
to work effectively. All three appear in File Transfer Options 
(Options menu) and are enabled by default.
Enable File Transfer Recovery  Located on the Copy/
Move tab, this box must be checked for File Transfer 
Recovery to occur at all.
Use SpeedSync on All File Transfers  Located on the 
Performance tab, this box must be checked to allow the 
transfer to resume with the missing part of a file. When it is 
cleared, the entire file must be sent again.

Transfer Only If Files Are Newer  Located on the Filter 
tab, this box must be checked so that files successfully cop-
ied before the interruption are not copied again.
When a transfer is interrupted, File Transfer Recovery cre-
ates a file in the target folder containing whatever part of the 
file has been transferred successfully. The file is named 
!LAPLINK.TSI.
When File Transfer Recovery resumes a transfer, this file is 
compared with the source file to determine what’s missing. 
Once the file is complete, !LAPLINK.TSI is given its original 
name. (If you do not use File Transfer Recovery to resume 
the transfer, the file remains in the folder and can be safely-
deleted.
117



 . . . 
7 Automating file 
synchronization 
with Xchange 
Agent

120 Using Xchange Agent—Overview
122 Creating an Xchange Agent
124 Previewing and running an Xchange Agent
126 Dealing with conflicts
128 Customizing an Xchange Agent
130 Using filters to include or exclude files
132 Scheduling an Xchange Agent to run automatically
119



Using Xchange Agent—Overview

X change Agent takes the function of SmartXchange to a higher level, by automating 
synchronization—the process of keeping your files updated. To set up an Xchange Agent, open a 
connection to another computer, choose the pairs of folders to be synchronized; then preview and 
perform the synchronization. After working on the files on either or both of the computers, run the saved 
agent to reconnect and update the older copies of the files automatically. You can run an agent by double-
clicking its shortcut icon or by scheduling it to run unattended.

Xchange Agent simplifies the repetitive process of keeping 
two computers—often a laptop and a desktop—in sync. 
Whether your most recent work appears on one or both of 
the computers, Xchange Agent transfers files so that both 
have only the newer copies of your files.
Xchange Agent automates the process of opening connec-
tions, selecting the pairs of folders to be synchronized, set-

ting the appropriate options, initiating the exchange, and 
disconnecting. To prevent unwanted results, you can pre-
view beforehand.
NOTE Xchange Agent is also useful for local synchroniza-
tions, as when you keep files on your desktop in sync with 
files on a local network.

Xchange Agent automatically copies the newer versions of all 
files regardless of which computer they are on. Files that have 
no match are copied onto the computer that lacks them.

In the end, files in the synchronized 
folders are identical.
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Creating an Xchange Agent
Open a LapLink connection—by modem, network, or any 
other means—to the computer with which you want to 
exchange files.
Then use the Xchange Agent wizard to create your own 
Xchange Agent:
• From the hierarchy of folders displayed for each com-

puter, choose the pair of folders—one folder on each 
computer—you want to synchronize. Choose as many 
pairs as you want.

• Name your Xchange Agent file and save it.
• Preview the agent you just created, making sure that 

you set it up as intended.
Then run the agent to make the files in each pair of folders 
identical.
NOTE Xchange Agent automatically copies the newer 
versions of all the files regardless of which computer they 
are on. Files that have no match are copied onto the com-
puter that lacks them.

Previewing an Xchange Agent
To prevent unintended consequences, you can preview an 
agent before synchronizing. The preview screen shows 
pairs of folders and files, with arrows to indicate the direction 
in which files will be copied when the agent is run.
In a preview, you can customize the agent by excluding 
pairs of files (and entire folders) from the current synchroni-
zation, leaving the files as they are on each computer.

TIP By default, agents are previewed before being run. 
To bypass preview, click Properties on the File menu and 
click an option on the Run Options tab. For more informa-
tion see page 129.

Running an Xchange Agent
There are several ways to run an Xchange Agent:
• Double-click its shortcut icon on the desktop.
• Schedule the agent to run unattended.
• Start LapLink and run the agent.
• Double-click the agent file in Windows Explorer.
CAUTION Xchange Agent exchanges files between fold-
ers. It does not merge the contents of files. To merge data-
bases and other shared files, use the program in which the 
files were created.

Beyond the basics
Xchange Agent offers various options for customizing each 
synchronization. For example, you can:
• Change the direction of copy: instead of a two-way 

exchange of files, copy files in one direction only, from 
one computer to the other.

• Include or exclude (filter) files according to type or 
name.

• Include or exclude subfolders within synchronized fold-
ers.
121



Creating an Xchange Agent

Once you connect to another computer, you create an Xchange Agent by selecting the pairs of 
folders—one folder on each computer—which you want to keep synchronized. You can select the pairs 
from a window displaying the folders on both computers, or you can drag folders from File Transfer 
windows onto the Xchange Agent window. In either case, you can preview the agent to ensure that you 
have set up the synchronizations as intended.

To create an Xchange Agent:
1 Start LapLink and open a connection with the computer 

with which you want to synchronize files.
For a local synchronization, simply start LapLink.

2 On the SyncTools menu, click either of these:
• Xchange Agent wizard
• New Xchange Agent
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Using the Xchange Agent wizard
The wizard guides you through the process of selecting 
pairs of folders to be synchronized. After naming and saving 
the agent file, you can preview the agent and change its set-
tings.
To make the files in each folder pair identical, click the Run 
button on the toolbar.
NOTE There are two “modes” in Xchange Agent: edit and 
preview. Certain operations are available in one mode and 
not the other. To save an agent, for example, you must be 
in edit mode. To change to edit mode from preview mode, 
click the Close Preview button on the toolbar.

Using New Xchange Agent
After choosing New Xchange Agent from the SyncTools 
menu, you can select the pairs of folders to be synchronized 
in two ways:
• On the Edit menu, click Add Folder Pair. After specify-

ing whether the synchronization is Local-Local or Local-

Remote, click a folder on each side of the window. 
Repeat the procedure to add other folder pairs.

• Drag folders from File Transfer windows onto the 
Xchange Agent window. Drag a folder first from one File 
Transfer window, then from the other one. Repeat the 
procedure to add other folder pairs.

Once you have selected the pairs to be synchronized, you 
can do any of the following:
• Preview the agent: click the Preview button on the tool-

bar.
• Name and save the agent file: On the File menu, click 

Save. In the File Name box, type a name, and click OK.
• Run the agent to make the files in each folder pair iden-

tical: click the Run button on the toolbar.
TIP Xchange Agent files are given the .LLX extension. In 
Windows 95 and Windows 98, Windows ME, XP, 2000 
and 2003, they are stored in the My Documents folder. In 
Windows NT, they are stored in the \Profiles\your-
name\Personal folder within the Windows folder (where 
yourname is your Windows NT logon name).
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Previewing and running an Xchange Agent

Previewing an Xchange Agent lets you see exactly which folders will be synchronized and which files 
will be overwritten. It also lets you skip pairs of folders and files and resolve conflicts. Unless you specify 
otherwise, you preview each agent before you run it. You can run an agent from the Windows desktop, 
from within LapLink, or you can schedule it to run in your absence.

Previewing
By default, a preview appears whenever you run Xchange 
Agents. You can also open an agent and preview it.
NOTE By default, only agents that you schedule to run 
unattended will proceed without a preview. To set up 
agents to run without a preview, see page 129.
To open and preview an Xchange Agent:
1 In LapLink, click Open Xchange Agent on the Sync-

Tools menu. (In Xchange Agent, click Open Xchange 

Agent on the File menu.) Then click the agent file and 
click Open.

2 Click the Preview button on the toolbar.
While previewing an agent you can do any of the following:
• Select files or folders to be omitted from the current 

synchronization only Click a pair and click the Skip 
Pair button on the toolbar. Skipping a folder skips all the 
files and subfolders it contains.

While previewing an Xchange Agent, you can 
tell the direction of copy from the arrows.

A special icon appears when both files have been modified since a 
previous synchronization. You can specify how these “conflicts” are 
handled.
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• Put skipped pairs back into a 

synchronization Click a skipped pair and then click 
the Undo Skip button on the toolbar.

• Resolve conflicts Click a pair showing a conflict icon, 
click the Resolve Conflict button on the toolbar, and 
specify how you want the conflict resolved. For more 
information about resolving conflicts, see page 126.

NOTE In a preview, arrows indicate the direction in which 
files will be copied, and thus which files will be overwritten. 
Special icons indicate conflicts between files.
CAUTION Once you have resolved conflicts or marked 
pairs to be skipped, run the agent before closing the pre-
view. Your modifications will be lost otherwise.
TIP To select every pair of folders and files in the agent, 
click Select All on the Edit menu.
TIP To locate a pair with a conflict, click the Next Conflict 
button on the toolbar.
To close a preview:
• Click the Close Preview button on the toolbar. You are 

now in edit mode.
TIP While in edit mode you can customize an agent in 
several ways. For more information see page 128.

Running an Xchange Agent
There are several ways to run a saved Xchange Agent:
• Double-click the agent’s shortcut icon on the desktop. 

To create a shortcut icon for an open agent, click Create 
Desktop Shortcut on the File menu.

• Schedule the agent to run at an appointed time. For 
more information see page 132.

• Run the agent from within LapLink: Click Run Xchange 
Agent on the SyncTools menu. Then click the name of 
the agent file and click Open.

• Run an agent you have opened in Xchange Agent: click 
the Run button on the toolbar.

• In Windows Explorer, double-click the agent file. By 
default, agent files have .LLX extensions, and are 
saved to the ‘My Documents’ folder.

Once an agent finishes synchronizing files, the connection 
to the host computer is closed. If LapLink was not running to 
begin with on the guest computer, it is shut down automati-
cally.
TIP For a record of your latest synchronizations, refer to 
the LapLink log file: on the Options menu, click Logging.
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Dealing with conflicts

When you are keeping folders on two computers in sync, a conflict occurs when a file has been 
modified on both computers since the last time you synchronized. You can handle these conflicts when 
you preview or run the agent, or you can set options to handle them automatically.

Conflicts between files
Conflicts occur when you modify a file on both of your com-
puters. Since both files are new, you need to decide how to 
handle them. These are the choices you can make while 
previewing or running an Xchange Agent:
• Copy either the older or the newer file to the other 

folder, replacing the file already in that folder.
• Copy either the older or the newer file to the other folder 

and give the file a new name. Nothing is replaced.
• Skip the conflict, without copying either file.

When you skip a conflict, you carry it over to future synchro-
nizations. There are now two categories of conflicts:
• New conflicts Files have been changed on both 

computers since the previous synchronization.
• Old conflicts Conflicts were left unresolved in earlier 

synchronizations. The two computers now have differ-
ent versions of the same file, and both are dated prior to 
the latest synchronization. You can treat these conflicts 
like new conflicts, or ignore them and let both versions 
remain.
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Changing how all conflicts are handled  By default, 
each conflict is presented for resolution when you run an 
Xchange Agent. You can change this so that conflicts are 
handled automatically.
To change how conflicts are handled by an Xchange 
Agent:
1 Open the Xchange Agent.
2 On the File menu, click Properties.
3 On the Run Options tab, click this option: Run Unattended, 

without Preview or Confirmations. Then click either of these 
options:
• Do Not Copy Either; Keep Both Files
• Copy the Newer File over the Older

Ignoring old conflicts  By default, old and new conflicts 
are treated alike, according to the settings on the Run 
Options tab in Properties. For example, if you specify that 
conflicts are to be displayed every time you run an agent, 
old conflicts will appear every time you run the agent. The 
alternative is to exclude old conflicts, regardless of how 
other conflicts are handled.
NOTE To retain both versions of files in old conflicts, click 
this option on the Advanced tab in Properties: Exclude 
Previously Skipped Files.
To exclude old conflicts from synchronizations:
1 Open the Xchange Agent.

2 On the File menu, click Properties.
3 On the Advanced tab, click this option: Exclude Previously 

Skipped Files.

Other conflicts
You may encounter other kinds of conflicts in these situa-
tions:
• When you attempt to copy a file or folder with a long 

name to a drive that does not accept long names.
• When you attempt to synchronize a file with a folder; 

this happens only when a file and a folder have exactly 
the same name.

Long name conflicts  If you do not shorten long names, 
you are given this choice when you run an agent: copy the 
file and give the copy a short name, or skip the conflict with-
out copying the file.
Conflicts between files and folders  If you do not 
rename the file to avoid the conflict, you are given this 
choice when you run an agent: copy both the file and folder 
and give the copies new names, or skip the conflict without 
copying either.
The best way to handle either of these conflicts is to rename 
files: shorten the long names or rename the file so that it 
does not conflict with the name of the folder. True synchroni-
zation cannot occur otherwise. If you set an agent to run 
unattended, for example, neither file in a conflict is copied.
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Customizing an Xchange Agent

Instead of a two-way synchronization, you can customize an agent so that files within folder pairs are 
copied in one direction only, from one computer to the other. Among other modifications, you can create a 
shortcut icon to run an agent directly from the desktop, run an agent without a preview, and limit 
synchronizations just to the files that already appear on both computers.

To customize an agent, you must open it from within 
LapLink or Xchange Agent.
To open an agent:
• In LapLink, click Open Xchange Agent on the Sync-

Tools menu. Click the agent file and then click Open.
OR

• In Xchange Agent, click Open Xchange Agent on the 
File menu. Click the agent file and then click Open.

Changing the direction of copy
When you create an Xchange Agent, all folder pairs are set 
for a two-way exchange of files. Files are copied in both 
directions, until the folders on both computers are identical.
You can modify this by specifying that files in a folder pair be 
copied in one direction only, so that only one folder updates 
the other.
NOTE To customize an agent, you must be in edit mode. If 
you are previewing, click the Close Preview button on the 
toolbar.

To change the direction of the copy, click one 
or more of the folders.
Then click either the left or right arrow button to 
specify the direction.
128



 . . . Customizing an Xchange Agent

To change the direction in which files are copied in a 
folder pair:
1 Click the folder pair.

To change the direction of copy for all folder pairs, click 
Select All on the Edit menu.

2 Click an arrow button on the toolbar to change the direction 
of the copy.

Adding folder pairs
To add a pair of folders to an Xchange Agent:
1 Open a connection with the computer with which you 

are synchronizing.
2 On the Edit menu, click Add Folder Pair.
3 Click one folder for each computer and then click OK.
NOTE To delete a pair of folders, click the pair and click 
Delete Pair(s) on the Edit menu. Then click Yes. The fold-
ers are deleted from the agent, not from the computers.

Changing how an Xchange Agent is run
There are several ways to customize how an agent is run:
• Create a shortcut icon for running an agent from the 

desktop: on the File menu, click Create Desktop Short-
cut.

• Schedule the agent to run at the time you want: on the 
File menu, click Schedule. For more information see 
page 132.

• Set up the agent to run unattended: On the File menu, 
click Properties. On the Run Options tab, click this 
option: Run Unattended, without Preview or Confirma-
tions. Then determine how conflicts will be handled by 
clicking either of these options: Copy the Newer File 
over the Older or Do Not Copy Either; Keep Both Files.

Changing which files are included in synchronizations
By default, subfolders within folder pairs are included in syn-
chronizations. Read-only files are also included, but hidden 
files and system files are not. To change these settings, click 
Properties on the File menu. Then click the File Options tab 
and change the settings as necessary.
Also on the File Options tab, you can set an option to limit 
synchronizations by exchanging only files that already 
appear on both computers. To exclude files that have been 
added to one computer and not the other, check this box: 
Include Files Only If They Are Present in Both Folders.
NOTE Filters offer another way of determining which files 
are included in synchronizations. For more information, 
see page 130.
TIP Instead of changing the various options every time 
you create a new agent, you can set default options to 
apply to any agents you create in the future. These 
defaults will take effect in new agents unless you specify 
otherwise in Properties. To change the defaults, click Prop-
erties for New Agents on the Options menu.
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Using filters to include or exclude files

Using preset filters or filters you create yourself, you can limit synchronizations by including only certain 
files or types of files. Or you can use the same filters to exclude files and file types.

Xchange Agent includes filters for some of the most com-
mon types of files, including Microsoft Office file types, Lotus 
1-2-3, and dBase. File types are defined by one or more 
extensions. Word files, for example, are defined by the 
extensions .DOC and .DOT.
You can also create your own filters for different file types—
or for specific files.
You can use filters to synchronize only the files matching the 
filters. Or you can exclude the files matching the filters and 
synchronize the rest of the files.

To filter files by type using the preset filters:
1 Click a folder pair, and then click Set Filter on the Edit 

menu.
To filter all folder pairs, click Select All on the Edit menu.

2 In the list of available filters, click a filter and then click the 
Add button. Repeat the process to add other filters.

3 To use the filters to exclude—not include—file types, check 
this box: Exclude Files That Match These Filters.

4 Click OK.

Click a filter in the list of 
available filters. Then 
click the Add button.

By default, filters limit syn-
chronization to files that 
match the filters.
If you prefer, you can use 
filters to exclude matching 
files—and synchronize the 
rest.
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To create and apply your own filter:
1 Click a folder pair and then click Set Filter on the Edit 

menu.
2 Under the list of available filters, click the New button.
3 In the Filter Name box, type a description for the filter.
4 In the Pattern(s) box, type one or more file extensions or file 

names, using a semicolon (;) to separate them.
To specify file types, use extensions preceded by aster-
isks: *.png;*.jpg and so on. To specify certain files, 
type their entire names: 
annual.xls;march.xls;april.xls and so on.

5 Click OK.
Your filter now appears in the list of available filters.

6 Click the filter and then click the Add button.
7 To use the filters to exclude—not include—file types, check 

this box: Exclude Files That Match These Filters.

To remove the effects of a filter:
1 Click the filter in the list of active filters.
2 Click the Remove button.

Modifying a filter
You can modify any of the filters appearing in the list of 
available filters. To apply the modifications, you must add 
the filter to the list of active filters, even if the filter already 
appears in that list.
To edit and apply a filter:
1 Click the filter in the list of available filters.
2 Click the Edit button.
3 Change the Filter Name or Pattern(s) as necessary and 

then click OK.
4 In the list of available filters, click the filter then click the Add 

button.
TIP To delete an available filter, click it and then click the 
Delete button.
131



Scheduling an Xchange Agent to run automatically

You can schedule an Xchange Agent to run at a certain time on the days you specify. Scheduled 
agents can be configured to run unattended: there is no preview, and conflicts are handled automatically. 
Xchange agents can be scheduled using the LapLink Schedule Wizard. To run the agent on schedule, 
simply leave the scheduler running on the guest computer..

You can set up an Xchange Agent to run at a particular time 
on one of these schedules:
• Just once, on a particular date.
• Every day

• On certain days of the week (such as Monday and Fri-
day)

• Once a month on a particular day (such as the first day 
of each month)

You can schedule an 
Xchange Agent to run 
unattended.
When the scheduled 
time comes, LapLink 
starts, the connection is 
opened, files are syn-
chronized, the connec-
tion is closed, and 
LapLink shuts down.
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LapLink does not have to be running on the guest for an 
agent to run as scheduled. When the scheduled time 
comes, LapLink starts, the connection is opened, files are 
synchronized, the connection is closed, and LapLink shuts 
down.
LapLink prepares an Xchange Agent to run on schedule by 
setting it up in the LapLink scheduler program.
NOTE You can also use the Windows Task Scheduler 
included in Windows 98, ME, 2000, XP, and 2003. For 
more information, consult your Windows documentation.
To schedule an Xchange Agent Using the LapLink 
Scheduler:
1 From within LapLink or Xchange Agent, open the agent.
2 On the File menu, click Schedule.

The Schedule wizard begins.
3 Give a name to the schedule file.
4 Fill out the schedule by specifying the time and frequency.
TIP To create another schedule for the same agent, 
repeat the above procedure and assign a different name 
to the schedule file. 

TIP To change how an Xchange agent is scheduled, 
access it throught the LapLink scheduler icon, which 
appears at the right end of the Windows taskbar. 
To run a scheduled agent:
• Leave your Windows operating system and your 

scheduler running.

Running an agent unattended
A scheduled agent runs without preview, even if you have 
specified preview on the Run Options tab of Properties.
When conflicts are encountered, they are ignored; neither 
file is copied. If you prefer to have the newer file in each 
conflict copied over the older one, click Properties on the 
File menu. On the Run Options tab, click this option: Run 
Unattended, without Preview or Confirmations. Then click 
this option: Copy the Newer File over the Older.1
TIP To ensure that an agent runs and synchronizes as 
scheduled, the agent should originally be created while 
connected to the host via an Address Book entry. This 
stores the log-in name and password required by the 
remote computer to open the connection.

1 For more information about resolving conflicts, see page 
126.
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Using Print Redirection—Overview

There are two ways to print over a LapLink connection. While controlling a host computer, you can print 
from that computer directly to your local printer. Or reverse direction and print directly from your local 
computer to a host printer. Either way, you can use Print Redirection to send a document over LapLink to 
be printed at the opposite end of the connection. 

Once you have opened a LapLink connection, you can use 
Print Redirection to send a document from the computer at 
either end of the connection to a printer at the other end.
There are two ways to use Print Redirection over a LapLink 
connection:
• Print from remote to local While using Remote Con-

trol to view and operate a hostcomputer, you can send 
a document from that computer to a printer at your loca-
tion. For example, you can prepare a document on your 
office computer from home and print the document on 
your home printer.

• Print from local to remote When connected to a 
LapLink host computer, you can print a document from 
your computer to a printer at the remote location. For 
example, after working on a report at home or on the 
road, you can connect to your office computer and print 
the report to a high-quality laser printer in your office.
Without Print Redirection, you’d have to transfer the doc-
ument to the other computer and then use Remote Con-
trol to run a program on the remote computer and print 
the document.

Printing a document over a LapLink connection is much like 
printing it on a local printer: In the program in which you 
have prepared the document, choose the standard Print 
command. Normally you would then choose a printer close 
at hand. In Print Redirection, however, you choose a printer 
at the opposite end of the connection from the document.1

When printing from remote to local, use Remote Control to 
choose Print on the remote computer; then choose a printer 
attached to your local computer.
When printing from local to remote, choose Print on your 
local computer; then choose a printer attached to the com-
puter at the other end of the LapLink connection.

Preparing for Print Redirection
To print documents from a computer to a printer at the other 
end of a LapLink connection, you need to set up the desti-
nation printer on that computer, using the exact same driver. 
If you want to print reports on the office printer while at 
home, for example, set up the office printer on your home 
computer.2

1 For detailed instructions on printing over a LapLink con-
nection, see page 138.

2 For detailed instructions on setting up a printer for Print 
Redirection, see page 140.
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You can set up a printer for Print Redirection during LapLink 
Setup or afterward, using Print Redirection options in 
LapLink.

Requirements for Print Redirection
There are three requirements for using Print Redirection:
• You must connect to another version of LapLink that 

supports Print Redirection.
• The default security setup on the other computer must 

be changed to allow Print Redirection.
• Both LapLink computers must have the same printer 

driver (software) installed.
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Printing over a LapLink connection

To print over a LapLink connection, choose the standard Print command in any Windows program and 
then choose a printer set up especially to receive print jobs from remote computers. The document is then 
transmitted over the LapLink connection to a printer at the other end.

Printing over a LapLink connection is much like printing to a 
local printer. You simply choose a different printer—one that 
has been installed especially to print over LapLink.

When printing from remote to local, choose a local printer 
from the remote computer using Remote Control. When 
printing from local to remote, choose a remote printer from 
the local computer.

Print from a Windows 
program as you normally 
would, using the Print 
command.

Then choose the 
printer you set up 
for Print Redirec-
tion.
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 . . . Printing over a LapLink connection

To print a document over a LapLink connection:
1 Open a LapLink connection to the remote computer.

• To print from remote to local, include Remote Control 
in the services you open.

• To print from local to remote, open Print Redirection 
or any of the other services.

2 Open a word processor, spreadsheet, or other program and 
prepare the document for printing.

3 Use the standard Print command for your program and 
choose the printer you set up just for Print Redirection. (It is 
typically a printer with [LapLink] at the end of its name.)

The Print Redirection icon on the LapLink status bar ani-
mates as the document is sent over a LapLink connection 
to the destination printer.
When the animation stops, the document has arrived at the 
other computer. You can then close LapLink if you want.
TIP You can monitor the status of the printing document 
after it’s been sent over a LapLink connection. On the 
computer to which the printer is attached, click the Win-
dows Start button, point to Settings, and click Printers. 
Then double-click the printer icon.
NOTE You can use Print Redirection over a LapLink con-
nection even when it is not one of the services currently 
open. Print Redirection becomes available on demand.

Choosing among several printers
Normally, Print Redirection sends documents to the printer 
that has been set up as the default printer on the connected 
computer. If you send a print job from home to the office, for 
example, the printer designated as the default on the office 
computer automatically gets the job. (If there is only one 
printer set up on a computer, that printer is always used.)
If you want to use a printer other than the default, you need 
to set up LapLink to prompt you with a list of available print-
ers whenever you print. Change this setting on the com-
puter the printers are attached to, not the computer with the 
document.
TIP If you’re not in front of that computer, you can still 
change this setting by remote controlling the computer.
To set up LapLink to prompt with a list of printers:
1 On the computer the printers are attached to, click Print 

Redirection Options on the Options menu.
2 Click Prompt with a List of Available Printers.
Whenever you send a document to that computer to be 
printed, you are prompted with a list of all the printers set up 
on that computer.
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Setting up printers for Print Redirection

To print documents from a computer to a printer at the other end of a LapLink connection, you need to 
set up the destination printer on that computer. If you do not set it up while installing LapLink, you can set it 
up later, using the Print Redirection Options in LapLink. For best results, set up a printer identical to the 
one you will be printing to at the other end of the connection.

Before you can use Print Redirection, you need to add a 
printer for Print Redirection to the computer you’ll be printing 
from (the location where your documents are kept).

For example, if you’re remote controlling your office com-
puter and want to print a document on that computer to your 
printer at home, you need to set up your home printer on the 
office computer.

To set up a new printer, click the Setup button in the Print 
Redirection Options dialog box.

Choose the printer from the list.
If your printer arrived with a setup disk, 
click Have Disk.
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If you want to print a document on your home computer to a 
high-quality printer at your office, you need to set up that 
printer on your home computer.
The printer you set up for Print Redirection must match the 
printer you’ll be printing to at the other end of the connec-
tion. If the destination printer was originally set up using a 
manufacturer’s installation CD ROM or downloaded driver, 
use that same installation method for both computers.
CAUTIONUsing the Printer Redirection wizard in LapLink 
Gold Corporate will not ensure that both computers are 
using the same printer drivers. For more information about 
configuring a printer for LapLink Printer Redirection, see 
technical document #36 at www.laplink.com/support. 

Setting up a printer
You can set up a printer during LapLink Setup or from within 
LapLink after installation. You will probably need your Win-
dows CD-ROM or the disk that accompanied your printer.
To set up a printer from within LapLink:
1 On the Options menu, click Print Redirection Options.
2 Click the Setup button to start the Print Redirection Setup 

wizard.
3 Follow the instructions in the wizard.
Once the printer is set up, you can print to it, and your docu-
ment is sent over your LapLink connection. In order to print, 
LapLink must be running and connected to the computer 
you want to print to.
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Exchanging typed messages using Text Chat

Text Chat lets you exchange typed messages with a person sitting at a remote computer. Used with a 
service like Remote Control or File Transfer or by itself, Text Chat is useful for exchanging brief messages 
and sending instructions. However, if you have a microphone, sound card, and speakers, you can use 
Voice Chat instead.

Opening a Text Chat window
When you connected to the remote computer, you may 
have opened a Text Chat window. If not, you can open one 
after you open the connection.
To open a Text Chat window:
• Click the Open Text Chat button on the Shortcut bar. Or 

click Open Text Chat on the Window menu.

TIP If you have opened a connection to multiple remote 
computers, click a window for the desired connection 
before opening Text Chat.

Sending messages
A Text Chat window is divided into two parts:
• The upper part displays the messages you have sent to 

the remote user as well as those the remote user has 

Read messages sent from the 
remote computer—as well as 
your own—in the upper part of 
the Text Chat window.

Type your messages in the lower 
part. Press ENTER to send.
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sent to you. Each message is identified by the name of 
the computer from which it was sent.

• The lower part serves as a note pad on which you write 
your messages. It clears each time you send a mes-
sage.

NOTE A Text Chat window pops to the foreground on your 
screen whenever the remote user sends a message. To 
keep the Text Chat window from activating automatically, 
click Text Chat Options on the Options menu. Then clear 
this option: Restore Text Chat Window Automatically.
To send a message to the remote user:
1 Click the Text Chat window.
2 Type your message.

Avoid pressing ENTER until your message is complete. 
To start a new paragraph, press CTRL+ENTER.

3 Press ENTER to send the message.

Pasting text into your Text Chat window
Instead of typing messages while connected, you can pre-
pare them ahead of time and paste them into the Text Chat 
window as necessary.
To paste text into a Text Chat window:
1 In Notepad or another Windows text editor, select the 

text and copy it.

2 In LapLink, click the lower part of the Text Chat window.
3 On the Edit menu, click Paste.
NOTE To reverse your latest editing action in the lower 
part of a Text Chat window, click Undo on the Edit menu.

Copying text from your Text Chat window
You can copy part or all of a Text Chat conversation and 
paste it into another Windows program.
To copy your Text Chat conversation:
1 In the upper part of the Text Chat window, highlight part 

of the text, or select the entire conversation by clicking 
Select All on the Edit menu.

2 On the Edit menu, click Copy.
3 Switch to another Windows program, and paste the text into 

that program.
TIP As a guest during Remote Control, you can carry on 
a Text Chat conversation with the host only by viewing the 
host screen in a window. (In full-screen view, you cannot 
see your own Text Chat window.) To arrange the Text Chat 
window beside the Remote Control window, click Tile Side 
by Side on the Window menu.
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Talking to someone using Voice Chat

Voice Chat lets you speak with a person at the other end of a LapLink connection, using the same line that 
transfers data between the two computers. Both computers must be configured for full duplex if you are to 
talk as you would on the telephone. If either computer is configured for half duplex, you must wait for the 
other person to stop talking before you begin.

Use Voice Chat to talk to someone you’re connected to over 
LapLink while using other LapLink services like File Transfer 
and Remote Control. To use Voice Chat, you must have a 
computer that is capable of recording and playing sound.

You may have started Voice Chat when you connected to 
the remote computer. If not, you can start it after you open 
the connection.

How you talk to the other person 
in Voice Chat depends on 
whether the current conversation 
is using half duplex or full duplex.

You can adjust the volume of the 
speaker and microphone or mute 
them entirely.

When you’re using half duplex, 
watch the icon to determine when 
to talk and when to listen.
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 . . . Talking to someone using Voice Chat
Starting Voice Chat
To start Voice Chat:
1 Click the Open Voice Chat button on the Shortcut bar. 

Or click Open Voice Chat on the Window menu.
2 The person on the other end of the connection is “called” 

and asked whether he or she wants to talk with you.
If the Voice Chat connection is accepted, a Voice Chat 
window opens, and you can begin talking to the other 
person.

TIP If you have opened a connection to multiple remote 
computers, click a window for the desired connection 
before starting Voice Chat.

Talking in Voice Chat
To use Voice Chat, you speak into the microphone and lis-
ten through headphones or speakers. If the other person 
can’t hear you very well, increase the microphone level in 
the Voice Chat window. If the other person’s voice is too 
loud or too soft, change the speaker level.
NOTE Although there are other volume/level controls in 
Windows, it is recommended that you use the ones in 
LapLink for best results.
Depending on the configuration of the sound card in both 
computers, you may be able to talk as you would on a tele-
phone; that is, your voice and the voice of the other user 
can be transmitted simultaneously. This is known as full 
duplex.
If you and the other user are not using full duplex, you must 
talk as you would on a walkie-talkie; that is, you must wait 
for the other person to finish before you begin. The trans-
mission of just one voice at a time is known as half duplex.

Voice Chat conversations are always half duplex unless 
both sound cards are configured for full duplex. The indica-
tor at the top of the Voice Chat window shows whether your 
current conversation is half duplex or full duplex.
Voice Chat provides an alternate method you can use to 
talk using Voice Chat, known as Manual mode; see page 
150.

Talking using half duplex
When you are having a half-duplex conversation, refer to 
the stoplight icon in the lower right corner of the Voice Chat 
window to know when you can talk. When the light is green 
or the text says “Talk,” you can talk. When the light is red or 
the text says “Don’t Talk,” you should wait until the other per-
son has finished talking.
TIP Saying “over” when you are finished talking may help 
facilitate conversation.
Notice that the stoplight icon is also available on the LapLink 
status bar, so you can minimize the Voice Chat window and 
continue talking.

Configuring your sound card for full duplex
Some sound cards can be reconfigured for full duplex 
merely by updating to new sound card driver software. Con-
tact your sound card manufacturer to find out whether your 
sound card is capable of full duplex. Updated sound card 
drivers are usually available on the manufacturer’s website. 
Remember that the sound card of the person you’re talking 
to also must be configured as full duplex in order for you to 
talk in full duplex.
NOTE Over slower connections, you may not be able to 
use full duplex, because of the lower bandwidth of the con-
nection.
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Improving Voice Chat performance

To improve Voice Chat performance, click the Levels tab in the Voice Chat Options dialog box, and then 
configure the microphone and speaker levels and specify information about your environment.

If you have already used a program that records and plays 
sound in Windows, you probably do not have to change set-
tings for your speakers and microphone before using Voice 
Chat. (For exceptions, see online help.)

However, Voice Chat lets you change settings for your 
speaker, microphone, and environment to improve perfor-
mance in Voice Chat. It is recommended that you do this 
once, preferably before you start using Voice Chat.

Use the Levels tab of the Voice 
Chat Options dialog box to con-
figure your speaker, microphone, 
and environment levels.

For the speaker and microphone 
levels, click the button, and then 
adjust the sliders to the desired 
level.

For the environment level, click 
the Setup button and follow the 
instructions.
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 . . . Improving Voice Chat performance
Setting levels in Voice Chat
The Levels tab on the Voice Chat Options dialog box lets 
you perform recording and playback tests and measure 
other speech qualities. Use the Levels tab when you’re not 
using Voice Chat, (e.g.;before you begin chat).
To configure levels in Voice Chat:
1 On the Options menu, click Voice Chat Options.
2 Click the Levels tab.
3 Under Set Speaker Level, click the Play Speech button.

TIP Some sound cards do not allow these settings to be 
changed using software; in this case, the sliders won’t be 
available.

4 While listening to the speech, move the Speaker Level slider 
to a comfortable level.
If you cannot hear the speech, move the slider towards 
High. If the speech is too loud, move the slider towards 
Low.

5 Under Set Microphone Level, click the Record button. The 
Windows Sound Recorder opens. 
TIP If the Sound Recorder is not available, adjust this 
option while you are using Voice Chat, instead.

6 Use the Sound Recorder to record and play back a few sec-
onds of speech. 

7 If you could not hear what you recorded, move the Micro-
phone Level slider towards High, and try using the Sound 
Recorder again.

8 Under Set Environment Level, click the Setup button. The 
Environment Setup wizard begins, and you’re asked to 
record a few seconds of background noise and a few sec-
onds of speech. 
Setting the environment level helps avoid transmitting 
sound that is not speech. It is recommended that you use 
the Setup button, and not the slider, to adjust this level.

Improving quality over a fast connection
Voice Chat works best over a fast connection. If you use 
Voice Chat over a network or other fast connection, you 
might be able to improve the Voice Chat sound quality.
To improve Voice Chat performance over a fast connec-
tion:
1 On the Options menu, click Voice Chat Options.
2 On the Advanced tab, change Transmission Quality to 

Medium or High. 
Be sure to reset this option to Low when you use a 
modem or other slow connection.

CAUTION When you have a slow connection, using 
Medium or High may cause problems with your connec-
tion.
It is recommended that you set up your environment level 
every time you change the transmission quality.
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Using Manual conversation mode

Use Voice Chat’s Manual conversation mode if you’re having problems using Voice Chat or you want 
additional control over when speech is sent over the connection. Manual mode requires that you press a 
button in order to talk.

Voice Chat has two conversation modes: Automatic and 
Manual.
• Automatic is the normal conversation mode, and allows 

hands-free operation of Voice Chat. Automatic mode 
sends speech whenever you talk.

• Manual mode requires you to click a button in order to 
talk.

In most cases, Automatic mode is recommended.

In Manual mode, click the 
walkie-talkie button in order 
to talk.

If you are using full duplex, 
you can leave the button 
down and still hear the 
other person. If you are 
using half duplex, you 
must release the button to 
hear the other person.
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 . . . Using Manual conversation mode

Use Manual mode if you’re having problems using Auto-
matic mode, or if your sound card does not support Auto-
matic mode. If your work environment is very noisy, you 
might have problems using Automatic mode. You can also 
use Manual mode to control exactly when speech is sent to 
the other person. 
To change to Manual conversation mode:
1 On the Options menu, click Voice Chat Options.
2 On the Advanced tab, click Manual Mode.
3 Click OK.
The next time you use Voice Chat, the window includes a 
walkie-talkie button that you use to talk. 

Talking in Manual mode
Manual mode works differently depending on whether your 
conversation is full duplex or half duplex.
• When using half duplex, you click the walkie-talkie but-

ton once in order to talk. While you’re talking, the other 
person cannot talk to you (he or she sees a “Don’t Talk” 
icon) until you click the button again to release it. The 
other person can then talk.

• When using full duplex, you also click the walkie-talkie 
button once in order to talk, but you don’t need to 
release it to allow the other person to talk, since in full 
duplex, you can both talk at the same time.
Therefore, you can just leave the button down until you 
and the other person are finished talking, since the other 
person can talk to you when your button is pressed.
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Introduction to troubleshooting

This chapter provides checklists for solving problems and 
improving performance. These checklists are designed as a 
quick overview of possible solutions.
For detailed, step-by-step information, consult the trouble-
shooters in online Help. The troubleshooters are designed 
to solve problems you may encounter in opening connec-
tions and using the services once you have opened con-
nections.
To use an online troubleshooter, open the Troubleshooting 
book in Help Topics and display one of the topics. Then 
answer the questions about your problem and try the sug-

gested remedies. In some cases you will find shortcut but-
tons to dialog boxes; use these buttons to resolve the 
problem faster.

For further assistance, visit www.laplink.com/support. In 
addition to the latest technical information, you’ll have 
access to the following support options: FAQ’s, Knowledge 
Base, Web incident (email) support, live chat support, and 
fee-based telephone support. 

Use the online troubleshooters for step-by-
step solutions.
On the Contents tab of Help Topics, open 
the Troubleshooting Book and display one 

Try the solution that 
fits your problem.
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Checklist for modem connections 

For Best Results: Use a hardware (controller-based) 
modem, such as an external (serial) modem. LapLink 
Gold works best when all the functions of the modem 
are performed on the modem device itself. Use of soft-
ware-based (controller-less) modems often result in 
poorer performance and reliability, and the possibility of 
incompatibility with LapLink Gold. For a list of modems 
that are known to be incompatible with LapLink Gold, 
visit www.laplink.com/support. 

Run LapLink on both computers
No connections are possible by modem or any other means 
unless LapLink is running on both computers. You can con-
nect to a computer running LapLink Gold or another Win-
dows-based version of LapLink.

Ensure that the modem can answer a call or dial out
A modem cannot answer an incoming call unless the Auto 
Answer option is on. In Port Setup (Options menu), click 
Windows Modems. Click Configure, and then verify that En-
abled under Auto Answer is checked.

Test the modem outside of LapLink Gold
Does the modem work with other applications? Test the mo-
dem with other Windows tools, such as dialing your Internet 
service, or using hyperterminal, to ensure the modem is 
working properly.

Check the settings for a Windows modem
If your modem does not answer calls or dial after you have 
enabled it as a Windows modem in LapLink, exit LapLink, 
and make sure the modem is turned on. In the Windows 
Control Panel, double-click Modems, click the Diagnostics 

tab, and click the appropriate port. Click More Info. If the test 
fails, click the General tab, and remove the modem. Shut 
down the computer and then restart it. Return to Modems in 
the Control Panel and reinstall the modem.

Disable error control and data compression on both 
computers
Some modems communicate better if error control and data 
compression are disabled on both computers. In Port Setup 
(Options menu), click Windows Modems, Configure, and 
then Properties. On the Connection tab, click Advanced. 
Then clear Use Error Control. Repeat this procedure on the 
other computer.

Set a longer timeout value
If the computer you are dialing takes a long time to answer 
and complete the connection, try increasing its modem tim-
eout. In Port Setup (Options menu), click Windows Modems. 
Click Configure and then Properties. On the Connection tab, 
type a larger number in this box: Cancel the Call If Not Con-
nected Within.

Lower the modem speed on the computer opening the 
connection
In Port Setup (Options menu), click Windows Modems. Click 
Configure and then Properties. On the General tab, click a 
lower speed in the Maximum Speed box.

Check the security setup on the remote computer
If you are denied the use of Remote Control or one of the 
other services while connected to another computer, check 
the security setup on that computer. You can gain access to 
services through Security (Options menu).
155



NOTE To let other computers connect to your computer by 
modem, you must change the security setup established 
during installation. Remember that passwords are case-
sensitive.

Disable call waiting and answering machines
Ensure that the call waiting feature is disabled on the tele-
phone systems at both ends of the connection. Call waiting 
and answering machines can interfere with modem connec-
tions when incoming calls are detected.

Use Dialing Properties to simplify the dialing process. 
In the Telephone Number box, type the number EXACTLY 
as it is to be dialed, including numbers dialed to get an out-

side line, area codes, country codes, and a “1” when dialing 
long distance. 

Disable other programs that use COM ports while run-
ning LapLink
You may experience problems if you use LapLink to connect 
by modem while running any other programs that monitor 
serial (COM) ports; modem and fax programs as well as 
PDA software, typically monitor serial ports for incoming 
calls or faxes and may cause a modem to disconnect unex-
pectedly. Disable such programs while using LapLink.
156



Checklist for Dial-Up Networking connections

Ensure that Dial-Up Networking is installed
You can connect over Dial-Up Networking only if Microsoft 
Dial-Up Networking has been installed. Dial-Up Networking 
should already be installed. However, if necessary, you can 
install this feature from your Windows 95/98/ME CDROM as 
follows: In the Windows Control Panel, double-click Add/Re-
move Programs. Click the Windows Setup tab, and double-
click Communications. If Dial-Up Networking is checked, it is 
installed. If it is not checked, click Dial-Up Networking, and 
then click OK to begin installation.
NOTE For more information about Microsoft Dial-Up Net-
working, consult Windows Help.

Once connected using Dial-Up Networking, connect to 
your corporate network
When you connect over Dial-Up Networking in LapLink, you 
dial in to a remote access server and connect to a network. 
Then you make LapLink connections in the Connect Over 
LAN(Network)Connect Over LAN(Network) dialog box. Un-
less you specify otherwise, the list of available LapLink con-
nections appears automatically as soon as you are 
connected to the network. If the list of connections does not 
appear automatically, click the Connect button on the Link-
Bar and then click Network.
TIP To connect to another LapLink computer once a Dial-
Up Networking connection is established, make sure that 
this box is checked in the Connect over Dial-Up Networking 
dialog box: After Connecting to the Network, Choose a 
LapLink Connection.

Ensure that your computer is set up for network con-
nections
Making connections to other LapLink computers through 
Dial-Up Networking requires that your computer meet the re-
quirements for network connections in LapLink: a network 
protocol must be installed, your network ports must be en-
abled in LapLink, and so on. For more information about net-
work connections, see page 159.
NOTE To let other computers connect to your computer 
through Dial-Up Networking, you must change the security 
setup established during installation.

Run LapLink on both computers
No connections are possible by Dial-Up Networking or any 
other means unless LapLink is running on both computers. 
You can connect to a computer running LapLink Gold or an-
other Windows-based version of LapLink. Verify that the 
computer has a network port enabled for the same kind of 
network connection as your network port.

Use Dialing Properties to simplify the dialing process. 
In the Telephone Number box, type the number EXACTLY 
as it is to be dialed, including numbers dialed to get an out-
side line, area codes, country codes, and a “1” when dialing 
long distance. 

Disable other programs that use serial (COM) ports 
while running LapLink
You may experience problems if you use LapLink to connect 
by modem while running any other programs that monitor 
serial (COM) ports; modem and fax software, as well as PDA 
programs, typically monitor serial ports for incoming calls or 
157



faxes and may cause a modem to disconnect unexpectedly. 
Disable such programs while using LapLink.

Disconnect a Dial-Up Networking connection manually
When connecting by modem, you can instruct LapLink to 
break a connection after a specified number of minutes in 
which there is no activity at either end of the connection: 
Click Connect Options (Options menu). On the Disconnect 
tab, check the Disconnect Inactive Connections box, and 
type the number of minutes below.

In most cases, the connection is completely broken after the 
specified period. With Dial-Up Networking connections, 
however, you must complete the process: click Disconnect 
(Connect menu) and then click Disconnect All.

TIP Consult the network administrator to ensure that the 
RAS server is accessible and responding to connection 
requests. 
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Checklist for network connections

Enable the network port for LapLink connections
Access to a network by e-mail and other programs does not 
automatically provide network access in LapLink. To con-
nect by network in LapLink, your network port must be en-
abled—that is, made available for use in LapLink. To enable 
a network port in LapLink, click Port Setup (Options menu). 
Click the type of network—either IPX or TCP/IP—in the 
Ports list. Then check the Enable Port box. If the network is 
IPX, click Configure, and ensure that Internetwork Name 
Broadcast is checked.

Run LapLink on both computers
No connections are possible by network or any other means 
unless LapLink is running on both computers. You can con-
nect to a computer running LapLink Gold or another Win-
dows-based version of LapLink. Verify that the computer has 
a network port enabled for the same kind of network connec-
tion as your network port.

Refresh the list of connections
If LapLink was started on the other computer after you start-
ed connecting, you may need to refresh the list of available 
connections in order to include the computer in the list. Click 
the Refresh List button, and wait while the list of LapLink 
computers is updated.

Ensure that the network is installed
LapLink cannot connect by network unless a network proto-
col—either IPX or TCP/IP—is installed. Network protocols 
are installed using the Networks option in the Windows Con-
trol Panel. See your Windows Help and documentation for 
information on adding network protocols, or consult your net-
work administrator.

Type the password carefully
In LapLink Gold, passwords are case-sensitive. For more in-
formation, see the security chapter.

Type the TCP/IP name or address
If you do not see a computer listed as an available connec-
tion over a TCP/IP network, you may have to type the com-
puter’s IP address. Click the Connect button on the LinkBar, 
and then click Network. On the TCP/IP Addresses tab, type 
the IP address or the Windows computer name in the TCP/
IP Name or Address box. (This name usually differs from the 
name assigned to the computer in LapLink.)
TIP To determine the TCP/IP address for a Windows 95 or 
Windows 98, or ME computer, click Port Setup (Options 
menu); click TCP/IP in the Ports list; and then click Config-
ure. The computer’s address appears in the IP Address 
box.
TIP To determine the TCP/IP address for a Windows NT, 
XP 2000 or 2003 computer, click the Start button, click Run, 
and then at the command line, type CMD.EXE, and press 
Enter. Then type IPCONFIG and press ENTER. The 
address appears on the IP Address line.
TIP If you cannot connect after typing a TCP/IP address, 
disable any firewall software on the host machine.

Check the security setup of the host computer

If you receive a “not authorized” error message, be sure to 
change the security setting on the host from the default of 
“Private System”. Access security settings from the Options 
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menu, then choose Security. To learn more about allowing 
connections, go to chapter ”Allowing incoming connections.

IPX connections: change the type of frame on both 
computers
Some IPX connections work better if the frame type for the 
IPX connection is preset rather than selected automatically; 

try setting the frame type to Ethernet 802.2 or Ethernet 
802.3. This setting should be changed on both computers 
making a LapLink connection. Network protocols are in-
stalled using the Networks option in the Windows Control 
Panel. See Windows Help and documentation for informa-
tion on changing the frame type.
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Checklist for Internet connections

The computer you want to connect to must have its In-
ternet address published by an Internet directory, and 
you must know what the address is
Connect over Internet is designed for connecting to a com-
puter whose Internet address is “published” to the LapLink 
IILS server. To set up the computer for this kind of connec-
tion, click Internet Directory Options (Options menu) and 
type an e-mail address or other unique identifier to be pub-
lished as the computer’s Internet address. Let other LapLink 
users connect by sharing the address with them.
TIP Set up Internet Directory Options to have the address 
published automatically. Or publish the address yourself, 
when you are online: on the Connect menu, click Publish 
My Internet Address.
TIP If you are connecting to a computer whose IP address 
you know, use Connect Over LAN (Network) instead to sup-
ply the IP Address.

Both computers must be on the Internet and running 
LapLink
It doesn’t matter how it’s done—by dialing in to an ISP or 
connecting over a high-speed connection—but both com-
puters must be connected to the Internet before they can 
connect using Connect over Internet. LapLink must be run-
ning on both computers.

Enable a TCP/IP port in LapLink
To connect over the Internet in LapLink, a TCP/IP network 
port must be enabled—that is, made available for use in 
LapLink. To enable a TCP/IP port in LapLink, click Port Set-
up (Options menu). Click TCP/IP in the Ports list and then 
check the Enable Port box. 

Check the security setup on the host computer
If you receive a “not authorized” error message, be sure to 
change the security setting on the host from the default of 
“Private System”. Access security settings from the Options 
menu, then choose Security. To learn more about allowing 
connections, go to chapter ”Allowing incoming connections.

Internet connections between computers behind fire-
walls may require special configuration
Without proper configuration, LapLink connections over the 
Internet may be prevented if either of the computers is be-
hind a firewall or router. This may be a personal router appli-
ance, or a corporate network’s firewall.
To facilitate LapLink connections over the Internet, LapLink 
has registered port 1547 with the Internet Assigned Num-
bers Authority. This port is used by the host computer. To al-
low LapLink connections through a firewall, a network 
administrator should forward port 1547 to the internal (pri-
vate) IP Address of the LapLink Gold computer behind the 
firewall or router.
NOTE If you have any questions about your corporate 
network, consult your network administrator.
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Other Tips

Confirm that the host computer is currently published 
to the ILS Server:
Confirm that both computers have an active connection to 
the internet.

If the host computer is behind a firewall, there are 3 op-
tions to establish a connection. 

• LapLink Firewall Service see ”Making an Internet con-
nection to a computer behind a firewall”.

• Laplink Everywhere. See ”Connecting Over the Inter-
net Using Laplink Everywhere

• Configure the firewallor router to allow LapLink con-
nections over CTCP port 1547. For more informa-
tion, visit www.laplink.com/support. 

TIP Do not attempt to connect two computer over the 
internet through the same shared internet connection. The 
computers will share the same public IP Address, and will 
not be able to communicate. If you are testing a connec-
tion before travelling, contact LapLink technical support 
staff to test the connection to the host for you. (Live Chat 
support is ideal for performing internet connection testing.)
TIP LapLink Everywhere troubleshooting- Ensure that 
the host is accessible via web browser at www.myla-
plink.com.
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Checklist for cable connections

Important: Different cable types are supported for differ-
ent versions of Windows.
Serial cable: All versions of Windows
Parallel cable: Windows 95/98/ME
USB cable: Windows 98, ME, 2000, XP, and 2003.

Ensure that Autoconnect is turned on
Autoconnect opens cable connections for you automatically. 
To ensure that Autoconnect is in effect, click Connect Op-
tions (Options menu). On the Connect tab, verify that this 
box is checked: Enable Autoconnect. Below the option, ver-
ify that the services you want to use are also checked.
TIP If you have trouble maintaining a cable connection, try 
disabling Autoconnect on one or both of the computers.

Run LapLink on both computers
No connections are possible by cable or any other means 
unless LapLink is running on both computers. You can con-
nect to a computer running LapLink Gold or another Win-
dows-based version of LapLink.
For USB connections with the Gold USB 1.1 cable or the 
Iogear Smartlink 2.0 USB cable, the other computer must be 
running LapLink Gold, version 11.5 or higher.

Check the cable
Make sure that each end of the cable is securely attached to 
the proper port; check the port labels for proper identification. 
Check a parallel cable for damaged pins. Try reconnecting 
the cable to each port or even reversing the cable ends.
TIP Attach a yellow LapLink cable to parallel/LPT (printer) 
ports. Attach a blue LapLink cable to serial/COM (modem or 

mouse) ports; connect only one end to each computer. 
LapLink does not work over most other serial cables or any 
printer cables. Attach a LapLink USB cable to a USB port at 
each computer. Do not use a non-LapLink USB cable. 

Consult the Windows Device Manager when in doubt 
about USB or other kinds of ports
If you are not certain whether you have a USB port or anoth-
er kind of port, check the Windows Device Manager: Right-
click My Computer; then click Properties. Look on the Device 
Manager tab, or in the Device Manager button on the Hard-
ware tab.
The LapLink Gold USB cable should appear in the device 
manager under the the LapLink Gold USB devices category. 
(Serial and parallel cables never appear in the Device Man-
ager.)

Enable the port
You cannot connect by cable until a port is enabled—that is, 
made available specifically to LapLink. To enable a port for 
cable connections, click Port Setup (Options menu). Click 
the port you want to enable. Then check the Enable Port 
box.
TIP If a port is listed as unavailable, quit any program that 
may be using the port, such as palm software, fax, et cetera. 
Make sure that the cable is attached to an available port.
TIP Do not install any separate USB drivers for the LapLink 
Gold USB 1.1 cable, or the Iogear USB 2.0 cable. LapLink 
Gold has the drivers built-in. If the gold cable has been con-
figured on either computer for use with an older version of 
LapLink (using USB network drivers), you may experience 
problems connecting. Contact LapLink technical support for 
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assistance. Visit www.laplink.com/support for more informa-
tion.

Serial cable connections: lower the speed of a serial 
port
In Port Setup (Options menu), click the COM port to which 
the cable is attached. Click Configure. In the Port Speed box, 
click 57600. Repeat this procedure on the other computer. If 
you still can’t connect, repeat the procedure, lowering the 
speed one step at a time until you can connect.

Restart the computer
If all else fails, remove the cable from both computers, and 
restart the computers. Reattach the cable, and try the con-
nection again.

Improving parallel cable performance in Windows 95 
and Windows 98
There are three drivers you can use in LapLink for parallel 
ports: the LapLink Enhanced driver (the default), the LapLink 

Standard driver, and a Windows driver. The LapLink En-
hanced driver is preferable when you alternate between par-
allel communications and other types of communications: 
you can leave the parallel port enabled without experiencing 
any degradation of performance. The Windows driver, on 
the other hand, generally provides better performance for 
parallel connections; use the Windows driver if you intend to 
use parallel connections exclusively. If you then want to 
switch to modem or some other type of communication, be 
sure to disable the parallel port beforehand.
NOTE For maximum performance from an ECP port, use 
the Windows driver for the parallel port to which the cable 
is attached.
To change the parallel port driver, click Port Setup (Options 
menu) and then click the appropriate LPT port. Ensure that 
the Enable Port box is checked. Click Configure and then 
click one of these options: Use the Windows Driver, Use the 
LapLink Enhanced Driver, or Use the LapLink Standard 
Driver.
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Checklist for wireless connections

Make sure you’re not trying to connect to a Windows 
NT, 2000, XP, or Windows 2003 computer
You cannot connect computers using wireless devices when 
either or both of the computers are running Windows operat-
ing systems listed above. Wireless connection in LapLink 
Gold work in Windows 95, 98 and ME exclusively. 

Set up the Windows infrared driver
The Windows infrared driver supports a variety of built-in 
ports and devices attached to serial ports. When you set up 
the driver, specify any serial port, from COM1 to COM9, as 
the redirected port. In LapLink Port Setup (Options menu), 
enable the redirected port for wireless communications.
NOTE In LapLink, wireless refers to short-range connec-
tions over infrared or radio devices. Other “wireless” con-
nections are available over wireless LAN adapters (using 
Connect Over LAN (Network)) and cellular modems (using 
Connect over Modem).

Enable the wireless port
You cannot connect by wireless until a serial port is enabled 
for wireless connections in LapLink. In Port Setup (Options 
menu), click the COM port to which the wireless device is at-
tached. Click Wireless in the Type box, and then check the 
Enable Port box.

Ensure that Autoconnect is turned on
Autoconnect opens wireless connections for you automati-
cally. To ensure that Autoconnect is in effect, click Connect 
Options (Options menu), and verify that this box is checked: 
Enable Autoconnect. Below the option, verify that the servic-
es you want to use are also checked.

Run LapLink on both computers
No connections are possible by wireless or any other means 
unless LapLink is running on both computers. You can con-
nect to a computer running LapLink Gold or another Win-
dows-based version of LapLink.

Check the cable, if any
If you have an external wireless device, make sure that its 
cable is securely attached to the proper port.

Lower the speed of the ports
If you are using wireless devices without the Windows infra-
red driver, try lowering the port speeds on both computers. 
In Port Setup (Options menu), click the COM port to which 
the wireless device is attached. Click Configure, and then 
click 57600 in the Port Speed box. Repeat this procedure on 
the other computer. If you still can’t connect, repeat the pro-
cedure, lowering the speed one step at a time.
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Checklist for CAPI 2.0/ISDN connections

Run CAPI-compatible versions of LapLink on both com-
puters
No connections are possible by CAPI 2.0/ISDN or any other 
means unless LapLink is running on both computers. En-
sure that the version of LapLink running on that computer is 
compatible with CAPI 2.0/ISDN.

Check the security setup on the remote computer
If you are denied the use of Remote Control or one of the 
other services while connected to another computer, check 
the security setup on that computer. You can gain access to 
services through Security (Options menu).

Ensure that LapLink is set up to answer calls over CAPI 
2.0/ISDN
CAPI cannot answer an incoming call unless the Auto An-
swer option in LapLink is enabled. In Port Setup (Options 
menu), click CAPI 2.0/ISDN. Click Configure, and then verify 
that the Enable box under Auto Answer is checked.

If you are using ISDN in North America, avoid using the 
LapLink CAPI 2.0/ISDN
In North America, ISDN doesn’t usually include CAPI 2.0 but 
you can still use your ISDN device in LapLink. If the device is 
set up as a Windows (TAPI) modem, you can open a 
LapLink connection using Connect over Modem or Connect 
over Dial-Up Networking. Simply ensure that the device is 
enabled in LapLink Port Setup (Options menu) as a Win-
dows modem.If your ISDN device is set with its own dialer, 
use the dialer to log on to a network. Then, in LapLink, use 
Connect Over LAN (Network) to connect to other computers 
running LapLink on that network.

Close some LapLink services to allow connections over 
both channels
Normally CAPI 2.0/ISDN hosts on which channel bonding is 
not enabled can handle incoming connections on both chan-
nels. When only one connection is possible, try closing ser-
vices on that connection.
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Checklist for File Transfer

Drop files directly on target folder
The most common mistake in drag and drop is dropping files 
on the wrong target folder (the folder to receive the files). To 
help prevent this mistake, open the target folder first; the 
name of the folder now appears in the title bar. Then open 
the source folder and select and drag the files until the 
mouse pointer rests on the open folder and the folder is high-
lighted. As soon as you release the mouse button, you re-
ceive a confirmation dialog box showing, among other 
things, the target you just dropped on. Check the target, and 
change it if necessary.
TIP To ensure that files are copied, press CTRL while drag-
ging. To ensure that files are moved, press SHIFT while 
dragging.
TIP If you are copying an entire folder (rather than files 
within a folder), drop the folder on the target one level higher 
than where you want the files to appear; this may be 
another folder or a drive letter. Assume that you want to 
update your Letters folder on your desktop computer with 
your Letters folder from your laptop, and the Letters folder 
appears at the highest level of folders on drive C. Drag the 
folder from the laptop to the desktop and drop it on drive let-
ter C.
TIP If you have File Transfer difficulties, such as error mes-
sages or disconnections, try reducing the amount of data 
being sent, either by reducing the number of files sent or 
size of sent files. 
CAUTIONDo NOT attempt to move the entire contents 
(root) of a drive. Windows may create hidden files or fold-
ers that could be in use and cannot be transferred. Like-
wise, do not attempt to transfer directories containing the 

Windows operating system. LapLink Gold cannot move 
any data that has been locked or is in use, such as the 
Windows Registry. If you wish to ‘clone’ a drive for the pur-
pose of making a bootable operating system on the target 
drive, use drive imaging software designed for these pur-
poses instead of LapLink Gold.

Use the Copy or Move command
Instead of using drag and drop, use the Copy or Move com-
mand. First, click the target folder. After selecting the files to 
be transferred, click Copy or Move (File menu). Then verify 
that the source and target are correct.

Make File Transfer available to other computers
If you are denied the use of File Transfer or one of the other 
services while connected to another computer, check the se-
curity setup on that computer. You can gain access to ser-
vices through Security (Options menu).

Log on to Windows before trying to use File Transfer
As a security measure, LapLink does not allow users to con-
nect to a computer and open File Transfer while the comput-
er is waiting to be logged on to Windows. (When you attempt 
to open a File Transfer connection to a computer running 
LapLink and displaying the Windows logon dialog box, you 
see this message: “Creation of window failed.”)
The solution is to open a Remote Control connection first. 
Log the remote computer on to Windows and then open File 
Transfer.
NOTE To set up LapLink to run before the Windows logon 
dialog box appears, click the Options menu and choose 
Program Options. Choose the Advanced tab, and check 
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this box: Always Start LapLink before Windows Logon 
Prompt.

General tips for faster transfers
Follow these suggestions to improve transfer speeds:
•  Check the folders and files you have selected for trans-

fer, making sure that you are not including more than 
necessary. For example, have you selected an entire 
folder when you want to transfer only a few files within 
the folder?

•  Use SpeedSync to improve file transfer times when 
updating files, particularly over modems: on the Perfor-
mance tab of File Transfer Options, make sure that the 
Use SpeedSync on All File Transfers box is checked.

•  Disable any ports that are not in use: in Port Setup 
(Options menu), click an unused port, and then clear 
the Enable Port box.

•  Close other service windows and any connections to 
other computers you may have opened in LapLink.

•  On laptop computers, disable power management 
functions. Attach the AC adapter to the computer to 
ensure steady voltage throughout the transfer.

•  Disable screen savers, and close other programs.
•  Serial cables transfer at 0.4mb/s, while the LapLink 

Gold USB cable can transfer at up to 5 mb/s.

Tips for transfers over a serial cable
•  Ensure that the serial port is configured for maximum 

speed: in Port Setup (Options menu), click the appropri-
ate COM port; click Configure; and ensure that Port 
Speed is set at 115200.

•  Change the transfer mode to standard: in Port Setup 
(Options menu), click the appropriate COM port; click 
Configure; and click Standard under Transfer Mode.

Tips for transfers over modems
Consult the documentation for your modem and verify that 
the port speed is set for optimum performance: In Port Setup 
(Options menu), click Windows Modems. Click Configure, 
and click the modem you are using. Click Properties. In the 
Maximum Speed list on the General tab, click the maximum 
speed your modem can use.

Tips for transfers over a network
•  Transfer your files when there is less traffic on the net-

work.
•  Ask your system administrator to verify that the network 

drivers are current.

Tips for SmartXchange
Use SmartXchange to update files in two folders so that the 
folders share the latest files. Since SmartXchange always 
overwrites older files, do not use it if you want to merge the 
contents of two files. Use SmartXchange by opening the two 
folders you want to update; do not select the individual files. 
After clicking SmartXchange (SyncTools menu), verify that 
you have opened the right folders. If you do not want to add 
new files to either folder, check this box: Transfer Only If 
Files Are Already on Target.

Ensure that you have read access rights to network files 
you want to copy
If you can locate the files you want to copy but then are de-
nied access when you attempt to copy them, contact the net-
work administrator. You can copy only files to which you 
have been assigned read access.
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Checklist for Xchange Agent

Ensure that LapLink is running on the host computer
LapLink must be running on the remote computer before an 
agent can connect to it and synchronize files. On the guest 
computer merely keep Windows running. (LapLink will start 
automatically when the agent runs.)

Make sure that a scheduler program is running
To schedule Xchange Agents—and have them run on 
schedule—you must have a supported scheduler program 
running.
NOTE When LapLink Scheduler is running, a red alarm 
clock icon appears on the Windows taskbar.

Change an Xchange Agent schedule in your scheduler 
program
Once you've created an Xchange Agent schedule in 
LapLink, revise or delete the schedule in the scheduler pro-
gram itself.

Close an Xchange Agent before it is scheduled to run
An agent cannot run on schedule while it remains open in 
Xchange Agent.

Create an Address Book entry to meet the security re-
quirements of the remote computer
If the remote computer requires a name and password, cre-
ate an Address Book entry and include the name and pass-
word required by that computer. LapLink can then send this 
information and connect automatically.

Turn off the LapLink callback feature
If the remote computer requires or requests a callback be-
fore opening a modem connection, the agent cannot run. On 
the remote computer, turn off the callback feature: Click the 
Security button on the LinkBar. On the Log-in List tab, click 
the name of the guest computer and then click Edit. Under 
Modem Callback, click None.

Avoid moving or deleting agent files for which you have 
created shortcut icons
If you have moved or deleted the Xchange Agent file, the 
shortcut icon can no longer run the agent. Create the agent 
again. You can reuse the shortcut icon by saving the new file 
in the same location, with the same name, as the original file. 
Or you can create a shortcut icon for the new agent file.

Create a filter to synchronize a single file
Xchange Agent always synchronizes by folder pairs, but you 
can create a filter so that only one file within a folder pair is 
synchronized. Open the agent in Xchange Agent and click 
the folder pair. On the Edit menu, click Set Filter and then 
click New. After typing a description for the filter, type the 
complete name of the file, including its extension. (To add 
more than one file name, type a semicolon and then the next 
file name.) Click OK. Click the filter’s name in the Available 
Filters list, and then click Add.
TIP Preview the agent to see if the correct files are included 
in the synchronization.
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Use Preview to limit the files to be copied in the current 
synchronization
While previewing an agent, you can specify that certain pairs 
of files and folders will be omitted from the current synchro-
nization: Click a pair of files or folders and then click the Skip 
Pair button on the toolbar. Repeat this procedure for any oth-
er pairs you do not want synchronized. Then—before clos-
ing Preview or quitting Xchange Agent—run the agent.

TIP You can omit file and folder pairs only from the current 
synchronization. To remove them from a future synchroni-
zation, you must use Preview again.

Use Xchange Agent to overwrite, not merge, files
Xchange Agent overwrites files. Unless you specify other-
wise, it copies the newer file to the other computer. It does 
not merge files. To merge databases and other shared files, 
use the program in which the files were created.
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Checklist for Remote Control

Improve performance from the guest
On the guest, you may be able to speed up Remote Control 
connections by changing settings in Remote Control Op-
tions (Options menu) on your computer. On the Perfor-
mance tab, click the Best Performance option. (To further 
customize settings, click the Settings button.) Your view of 
the host should be updated faster, though you will now be 
viewing the host screen in black and white, and larger bit-
maps will not be displayed.

Control the display properties of the host from the guest
By default, LapLink is configured to speed up Remote Con-
trol connections: any wallpaper or screen saver on the host 
is temporarily disabled, along with certain other visual en-
hancements. From the guest, you can restore these en-
hancements to the host screen through settings on your 
computer. On the Performance tab of Remote Control Op-
tions (Options menu), click Best Quality. (To further custom-
ize settings, click the Settings button.) Keep in mind that 
changing these settings may slow Remote Control connec-
tions.

Make Remote Control available to other computers
If you are denied the use of Remote Control or one of the 
other services while connected to another computer, check 
the security setup on that computer. You can gain access to 
services through Security (Options menu).

Use the keyboard to view the host screen
If the window in which you are viewing the host screen does 
not show all of the host screen, you can use your keyboard 
to view areas beyond the borders of the window: press 

CTRL+ALT+SHIFT and any of the arrow keys, PAGE UP, 
PAGE DOWN, HOME, or END.

Use the latest driver for your video adapter
Contact the manufacturer of your video adapter, on its Web 
site or elsewhere, to verify that you are using the latest driver.
New computers do not necessarily ship with the the most 
current drivers installed.

Avoid changing the color depth or display properties of 
a host
From the guest, avoid changing the number of colors dis-
played on the host while you're connected to it using Remote 
Control. Also avoid changing the Refresh Frequency and 
other settings in the host's Display Properties while connect-
ed. To safely change these properties, you should be seated 
at the host and fully informed of the capabilities of its monitor. 
Incorrect settings can damage a monitor.

Use a special key combination to log on to a Windows 
NT, Windows 2000, XP or 2003 host
When you restart a Windows NT host, you must press 
CTRL+ALT+DELETE to log on to Windows again. You can 
accomplish this from the guest by pressing a special key 
combination specified on the host. (Pressing 
CTRL+ALT+DELETE on the guest affects the guest, not the 
host.) To specify a key combination for use on the guest, 
start LapLink on the host and click Remote Control Options 
(Options menu). On the Host tab, type the key combination 
in this box: Send CTRL+ALT+DELETE to This Computer 
When a Guest Presses This Key Combination.
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TIP The easiest way to send a CTRL+ALT+DEL to the host 
machine is to:
1 Establish a Remote Control session with the host 

machine.
2 Click on the Session menu, and select “Send 

CTRL+ALT+DEL to Host”.

Do not install other remote control products and 
LapLink on the same computer
Because of possible incompatibilities, avoid installing 
LapLink Gold and another remote control product on the 
same computer.
Examples include PC Anywhere and Windows Terminal 
Services. 
CAUTIONInstalling LapLink Gold with another remote 
control application installed may result in a failure to reboot 
(except in Windows Safe Mode.) For more information on 
allowing these programs to coexist with LapLink, visit 
www.laplink.com/support. 

Avoid pressing CTRL+ALT+DELETE when viewing a 
Windows NT, Windows 2000, XP or 2003 host in full-
screen Remote Control
Pressing CTRL+ALT+DELETE on a Windows NT computer 
always displays the Windows Security dialog box on that 
computer. When you are working in a full-screen Remote 
Control session, pressing CTRL+ALT+DELETE not only 
displays the Security dialog box locally but also causes the 
CTRL and ALT keys to be pressed—but not released—on 
the host computer. To release these keys and resume nor-
mal keyboard operation press CTRL and ALT again.

TIP To have CTRL+ALT+DELETE take effect on a host 
computer, click Send CTRL+ALT+DELETE to Host on the 
guest's Session menu.

Keep LapLink running before the Windows NT, Win-
dows 2000, XP or 2003 logon prompt
If you have set up LapLink on the host computer to run be-
fore the Windows NT logon dialog box appears, avoid clos-
ing LapLink on that computer unless you have administrator 
rights. If you close LapLink, you will have to restart the com-
puter in order to reset LapLink so that other people can con-
nect. (Restarting LapLink is not sufficient.)

Avoid running a Windows NT, Windows 2000, XP or 
2003 host in VGA mode
When a Windows NT computer is running in VGA mode you 
can make LapLink connections from it to other computers 
using Remote Control and File Transfer, but the computer 
cannot serve as a Remote Control host. That is, it cannot be 
remotely controlled by other computers.

Run DOS in a window on a Windows NT, Windows 2000, 
XP or 2003 host
You cannot control full-screen DOS programs on a Windows 
NT host. When you attempt to do so, LapLink minimizes the 
program and displays a warning message. (To close the 
DOS program, right-click the icon, and click Close.)
Avoid this problem by setting up the Windows NT host to dis-
play DOS programs in a window. If you use a shortcut to a 
DOS program, for example, right-click the shortcut icon, click 
Properties, and then click the Options tab. Below Display 
Options, check Window.
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Checklist for Print Redirection

Use the same printer driver on both ends of a connec-
tion
For best print results in Print Redirection, both computers 
should be set up with the exact same printer driver. To add 
a printer driver, you may a disk from the printer manufactur-
er, or you may be able to download the latest driver from the-
manufacturer’s website.

Use the Windows Control Panel to get additional infor-
mation
If the document you printed is sent over LapLink correctly but 
does not print, examine the printer queue, accessed by click-
ing Start, Programs, Printers, to get additional information 
about why the document didn’t print. Make sure the printer is 
connected correctly and has enough paper, and the printer 
cartridge is not empty.

When several printers are available, you can set up 
LapLink to prompt you for the printer to use
Normally, LapLink automatically directs print jobs to the print-
er currently set up as the default printer at the other end of 
the connection. When there are several printers available, 

however, you may want to use a printer other than the de-
fault.
To set up LapLink to allow you to choose among the avail-
able printers, click Print Redirection Options (Options menu) 
on the computer the printers are attached to. Then click 
Prompt with a List of Available Printers.

When printing from 16-bit programs, use the default 
printer
Before printing from 16-bit Windows programs (programs 
written for versions of Windows prior to Windows 95, Win-
dows 98, and Windows NT 4.0), set up the destination print-
er as the default printer on the computer to which it is 
attached. When using Print Redirection from the 16-bit Win-
dows program, print to the default printer instead of selecting 
a printer from the list of available ones.

Some printer drivers do not support Print Redirection
To use Print Redirection you must set up a printer to direct 
print jobs to a special TSI port instead of the usual parallel 
port. You cannot use a printer driver that does not allow you 
to change the port in this way. You may want to contact the 
printer manufacturer to see if an updated driver is available.
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Checklist for Text Chat

Press ENTER to send your message
Type your message in the lower part of the Text Chat win-
dow. (In some cases, you may have to click in the lower part 
of the window before you can begin typing.) To send your 
message to the remote computer, press ENTER.
TIP To begin a new paragraph, press CTRL+ENTER.

Open a Text Chat window after connecting
If you are connected to more than one computer, be sure to 
specify which computer you want to use Text Chat with: 
Click the name of the computer on the Window menu. Then 
click the Open Text Chat button on the Shortcut bar or Open 
Text Chat on the Window menu.

Make Text Chat available to other computers
If you are denied the use of Text Chat or one of the other ser-
vices while connected to another computer, check the secu-
rity setup on that computer. You can gain access to services 
through Security (Options menu).

Save your Text Chat conversation from time to time
As a Text Chat conversation grows in length, the most recent 
messages begin to replace the earliest. This starts to hap-
pen when the conversation exceeds 32,000 characters. If 
you intend to save a lengthy conversation, begin saving be-

fore this limit is reached. To save a conversation, click in the 
upper part of the Text Chat window. Click Select All (Edit 
menu), and then click Copy (Edit menu). You can then 
switch to another Windows program such as Notepad, paste 
the text, and save it as a file.

Shorten connection time by preparing messages be-
forehand
Instead of typing text while connected, you can prepare it 
ahead of time in Notepad or a similar Windows program and 
send it to a remote computer through Text Chat. In the other 
application, select the text, and press CTRL+C to copy. In 
the lower part of the Text Chat window, press CTRL+V to 
paste. Then press ENTER to send.

Use File Transfer for long messages
Text Chat can send as many as 2,048 characters at once. 
When you attempt to send a message that exceeds that lim-
it, part of the message will not be transmitted to the other 
computer. Try sending the message in parts. Or save the 
message as a file, and send the file using File Transfer. You 
can still use the Text Chat window to let the remote user 
know what you’re sending and to pass along additional 
notes.
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Checklist for Voice Chat

Use full duplex sound card drivers on both ends of the 
connection
Voice Chat is easiest to use over a full duplex connection; 
you can hear and be heard at the same time, as on the tele-
phone.
For full duplex, both ends of the connection must have sound 
cards with drivers that support full duplex. Contact your 
sound card manufacturer to determine whether your sound 
card supports full duplex; and find out whether drivers are 
available.

When using half duplex, wait for the other person to fin-
ish talking
A common problem in half duplex conversations is knowing 
when to start talking. Use the stoplight icon in LapLink as a 
guideline for when you can talk and when you can’t. In some 
cases, a verbal signal that you are finished speaking (saying 
“over,” for instance) might be helpful, or it might help to sim-
ply pause a few seconds when you are done speaking.
If you’re using Manual mode, be sure to release the walkie-
talkie button; you might not be able to hear the other person 
otherwise.

Adjust your microphone to a comfortable level
Many microphones require adjustment in order to send clear 
speech. Make sure your microphone is placed at a good dis-
tance from your mouth—not too far and not too close—and 

then adjust the microphone level using the Levels tab (Voice 
Chat Options).

Adjust your speakers or headphones to a comfortable 
level
Most speakers, and some headphones, have a manual con-
trol that you can use to adjust volume. It is recommended 
that you leave the manual controls at a medium level, and 
adjust the volume of speakers and headphones in LapLink 
(or in Windows).

Minimize background noise, if possible
Try moving your microphone away from telephones, loud 
computer power supplies, radios, and so on. Move your 
speaker and microphones farther apart.
If the person you’re talking to hears a lot of noise in your 
background or doesn’t hear your voice, you might want to re-
set your environment level using the Levels tab (Voice Chat 
Options).

Tips for improving Voice Chat performance
Perform the tests on the Levels tab (Voice Chat Options) to 
get the best performance. Adjust transmission quality to 
match the conditions of the connection: On the Advanced 
tab of Voice Chat Options (Options menu) click Low if you 
are talking over a modem or other slow connection. Click 
High if you are talking over a network or other fast connec-
tion.
175


	1 Introducing LapLink Gold Corporate
	Why LapLink Gold?
	Staying in touch with the office
	Connecting at the office

	2 Connecting to other computers
	How can I connect to other computers?
	Connecting by cable
	Connecting over a home or office network
	Connecting over the Internet using an ILS
	Making a computer available for ILS connections
	Making an Internet connection to a computer behind a firewall

	Connecting Over the Internet Using Laplink Everywhere
	Connecting directly by modem
	Dialing in to a network through a network server: Dial-Up Networking

	Connecting by wireless
	Connecting over CAPI 2.0/ISDN
	Changing CAPI 2.0/ISDN performance in LapLink

	Connecting automatically

	3 Using the Address Book
	Using the Address Book
	View Options and Folders
	The Button Bar
	Adding an Address Book Entry- General Tab
	Connection tab
	Connection Types
	Services tab
	Other Toolbar Options


	4 Setting up security for incoming connections
	Allowing incoming connections
	Denying access to certain drives and folders
	Locking out password crackers
	Allowing or requiring callbacks

	Protecting your security settings with a password
	Encrypting information over incoming connections

	5 Using Remote Control
	Using Remote Control-Overview
	Hosting a Remote Control session
	Viewing the host
	Customizing keyboard control
	Disabling the host keyboard and mouse and blanking its screen
	Rebooting and logging on to the host
	Taking Screen Shots
	Viewing a Screen Shot
	Saving System Information

	Sharing clipboard information with remote computers
	Customizing Remote Control performance

	6 Using File Transfer
	Using File Transfer-Overview
	Navigating through drives and folders
	Selecting files and folders
	Copying or moving files and folders
	Setting File Transfer options for the results you want
	Synchronizing folders with SmartXchange
	Replacing one folder with another: Clone Folder
	Speeding file transfers with SpeedSync and compression
	Resuming an interrupted file transfer

	7 Automating file synchronization with Xchange Agent
	Using Xchange Agent-Overview
	Creating an Xchange Agent
	Previewing and running an Xchange Agent
	Dealing with conflicts

	Customizing an Xchange Agent
	Using filters to include or exclude files
	Scheduling an Xchange Agent to run automatically


	8 Using Print Redirection
	Using Print Redirection-Overview
	Printing over a LapLink connection
	Setting up printers for Print Redirection

	9 Using Text Chat and Voice Chat
	Exchanging typed messages using Text Chat
	Talking to someone using Voice Chat
	Improving Voice Chat performance
	Using Manual conversation mode

	Introduction to troubleshooting
	Checklist for modem connections
	For Best Results: Use a hardware (controller-based) modem, such as an external (serial) modem. LapLink Gold works best when all ...
	Run LapLink on both computers
	Ensure that the modem can answer a call or dial out
	Test the modem outside of LapLink Gold
	Check the settings for a Windows modem
	Disable error control and data compression on both computers
	Set a longer timeout value
	Lower the modem speed on the computer opening the connection
	Check the security setup on the remote computer
	Disable call waiting and answering machines
	Use Dialing Properties to simplify the dialing process.
	Disable other programs that use COM ports while running LapLink

	Checklist for Dial-Up Networking connections
	Ensure that Dial-Up Networking is installed
	Once connected using Dial-Up Networking, connect to your corporate network
	Ensure that your computer is set up for network connections
	Run LapLink on both computers
	Use Dialing Properties to simplify the dialing process.
	Disable other programs that use serial (COM) ports while running LapLink
	Disconnect a Dial-Up Networking connection manually

	Checklist for network connections
	Enable the network port for LapLink connections
	Run LapLink on both computers
	Refresh the list of connections
	Ensure that the network is installed
	Type the password carefully
	Type the TCP/IP name or address
	Check the security setup of the host computer
	If you receive a “not authorized” error message, be sure to change the security setting on the host from the default of “Private...
	IPX connections: change the type of frame on both computers

	Checklist for Internet connections
	The computer you want to connect to must have its Internet address published by an Internet directory, and you must know what the address is
	Both computers must be on the Internet and running LapLink
	Enable a TCP/IP port in LapLink
	Check the security setup on the host computer
	Internet connections between computers behind firewalls may require special configuration
	Other Tips
	Confirm that the host computer is currently published to the ILS Server:
	If the host computer is behind a firewall, there are 3 options to establish a connection.

	Checklist for cable connections
	Important: Different cable types are supported for different versions of Windows.
	Ensure that Autoconnect is turned on
	Run LapLink on both computers
	Check the cable
	Consult the Windows Device Manager when in doubt about USB or other kinds of ports
	Enable the port
	Serial cable connections: lower the speed of a serial port
	Restart the computer
	Improving parallel cable performance in Windows 95 and Windows 98

	Checklist for wireless connections
	Make sure you’re not trying to connect to a Windows NT, 2000, XP, or Windows 2003 computer
	Set up the Windows infrared driver
	Enable the wireless port
	Ensure that Autoconnect is turned on
	Run LapLink on both computers
	Check the cable, if any
	Lower the speed of the ports

	Checklist for CAPI 2.0/ISDN connections
	Run CAPI-compatible versions of LapLink on both computers
	Check the security setup on the remote computer
	Ensure that LapLink is set up to answer calls over CAPI 2.0/ISDN
	If you are using ISDN in North America, avoid using the LapLink CAPI 2.0/ISDN
	Close some LapLink services to allow connections over both channels

	Checklist for File Transfer
	Drop files directly on target folder
	Use the Copy or Move command
	Make File Transfer available to other computers
	Log on to Windows before trying to use File Transfer
	General tips for faster transfers
	Tips for transfers over a serial cable
	Tips for transfers over modems
	Tips for transfers over a network
	Tips for SmartXchange
	Ensure that you have read access rights to network files you want to copy

	Checklist for Xchange Agent
	Ensure that LapLink is running on the host computer
	Make sure that a scheduler program is running
	Change an Xchange Agent schedule in your scheduler program
	Close an Xchange Agent before it is scheduled to run
	Create an Address Book entry to meet the security requirements of the remote computer
	Turn off the LapLink callback feature
	Avoid moving or deleting agent files for which you have created shortcut icons
	Create a filter to synchronize a single file
	Use Preview to limit the files to be copied in the current synchronization
	Use Xchange Agent to overwrite, not merge, files

	Checklist for Remote Control
	Improve performance from the guest
	Control the display properties of the host from the guest
	Make Remote Control available to other computers
	Use the keyboard to view the host screen
	Use the latest driver for your video adapter
	Avoid changing the color depth or display properties of a host
	Use a special key combination to log on to a Windows NT, Windows 2000, XP or 2003 host
	Do not install other remote control products and LapLink on the same computer
	Avoid pressing CTRL+ALT+DELETE when viewing a Windows NT, Windows 2000, XP or 2003 host in full- screen Remote Control
	Keep LapLink running before the Windows NT, Windows 2000, XP or 2003 logon prompt
	Avoid running a Windows NT, Windows 2000, XP or 2003 host in VGA mode
	Run DOS in a window on a Windows NT, Windows 2000, XP or 2003 host

	Checklist for Print Redirection
	Use the same printer driver on both ends of a connection
	Use the Windows Control Panel to get additional information
	When several printers are available, you can set up LapLink to prompt you for the printer to use
	When printing from 16-bit programs, use the default printer
	Some printer drivers do not support Print Redirection

	Checklist for Text Chat
	Press ENTER to send your message
	Open a Text Chat window after connecting
	Make Text Chat available to other computers
	Save your Text Chat conversation from time to time
	Shorten connection time by preparing messages beforehand
	Use File Transfer for long messages

	Checklist for Voice Chat
	Use full duplex sound card drivers on both ends of the connection
	When using half duplex, wait for the other person to finish talking
	Adjust your microphone to a comfortable level
	Adjust your speakers or headphones to a comfortable level
	Minimize background noise, if possible
	Tips for improving Voice Chat performance






